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Chapter 1. Introduction to problem determination

This guide helps you to decide where to begin looking for causes when you have a
problem with IBM Tivoli Monitoring. Usually, you start with a symptom, or set of
symptoms, and trace them back to their cause. This process is called problem
determination. Problem determination is not the same as problem solving, although
during the process of problem determination, you can obtain enough information
to solve a problem. Examples of situations where this can happen include:

* End-user errors

e Application programming errors

¢ System programming errors, such as in resource definitions

However, you might not always be able to solve a problem yourself after
determining its cause. For example, a performance problem might be caused by a

limitation of your hardware. If you are unable to solve a problem on your own,
contact IBM® Software Support for a solution.

Sources of problem determination information

The primary troubleshooting feature is logging. Logging refers to the text messages
and trace data generated by the software. Messages and trace data are sent to an
output destination, such as a console screen or a file.

Typically, text messages relay information about the state and performance of a
system or application. Messages also alert the system administrator to exceptional
conditions when they occur. Consult the explanation and operator response
associated with the displayed messages to determine the cause of the failure. See
the document IBM Tivoli® Monitoring Messages for message information.

Trace data capture transient information about the current operating environment
when a component or application fails to operate as designed. IBM Software
Support personnel use the captured trace information to determine the source of
an error or unexpected condition. See the [Chapter 2, “Tools,” on page 5|for more
information about tracing.

Collecting data

If you have a problem that you are unable to solve using the information in this
guide, gather the following information that relates to the problem and contact
IBM Software Support for further assistance.

* Monitored application file as specified on the SOURCE FILE statement, if
applicable.

* Appropriate IBM Tivoli Monitoring RASI trace output.
* Description of the operation scenario that led to the problem.

* Incorrect output, such as Tivoli Enterprise Portal screen prints or a description of
what you observed, if applicable.

* Log files
Collect logs from failing systems. You can collect all logs or logs of a certain type
such as, RAS (reliability, availability, and serviceability) trace logs or message
logs.

* Application information:

© Copyright IBM Corp. 2005, 2007 1



Version number and patch level
Sample application data file (if monitoring a file)

* Operating system version number and patch level

* Messages and other information displayed on the screen

* Version number of the following members of the monitoring environment:

IBM Tivoli Monitoring. Also provide the patch level, if available.
Monitoring Agent version number

Tivoli Enterprise Portal. Select About Tivoli Enterprise Portal ... from the
Help menu.

Note: The version number of the Tivoli Enterprise Portal and the Tivoli
Enterprise Portal server must always be synchronized.

* Screen captures of incorrect output, if any.

« If the systems stops on Windows®, collect the drwtsn32.log and user.dmp files if
available. The drwtsn32.log and user.dmp files are located in

\Documents and Settings\Al1 Users\Documents\DriWatson

1.

ook~ w

Enter the following command at the command prompt to enable Dr. Watson
as default debugger:

drwtsn32 —i

Enter the following command at the command prompt to open the Dr.
Watson configuration dialog:

drwtsn32

Set the Crash dump Type to FULL.

Remove the check from the Dump Symbol Table box.
Place a check in the Dump all Thread Contexts box.
Place a check in the Create Crash Dump File box.

If the system stops on UNIX-based systems, collect the core dump file from
install_home/bin directory, where install_home is the directory path where you
installed the monitoring agent.

Problem classification

The first task in problem determination is to determine the origin of the problem,
or which component or function is experiencing a problem. To assist you in
determining the origin of the problem, collect documentation at the time of the
error. You might experience problems with IBM Tivoli Monitoring in the following
areas:

Installation

Upgrading

Configuration

Connectivity

Tivoli Enterprise” Portal

Tivoli Enterprise Portal Server

Tivoli Enterprise Monitoring Server

Tivoli Enterprise Monitoring Agent deployment

Databases

Tivoli Data Warehouse

Universal Agent

2 IBM Tivoli Monitoring: Problem Determination Guide



« IBM Tivoli Enterprise Console®

Finding release notes

You can find release note information online by viewing IBM Technotes. Technotes
replace the Release Notes manual for this product. Technotes are short documents
that cover a single topic. You can search the Technotes collection for common
problems and solutions, as well as known limitations and workarounds. Technotes
are continuously updated to provide current product information.

The following two procedures describe how to view Technotes and subscribe to
have future Technotes e-mailed to you. Alternatively, you can watch demos of
these procedures at the following Web site:

http:/ /www-306.ibm.com /software/support/sitetours.html

Viewing Technotes

Perform the following actions to access Technotes for this product:

1. Launch the IBM Software Support Web site: http://www.ibm.com/software/
support

2. In the Products A - Z field, select the product name to open the
product-specific support site.

For this product, select I > IBM Tivoli Monitoring..
3. In the Self help field, click Technotes.

4. Scroll through the Technotes, or you can optionally type a search term to refine
the displayed data.

For tips on refining your search, click Search tips.

Creating an e-mail subscription to Technotes

You can subscribe to e-mail notification about product tips and newly published
fixes through My support, a personalized portal that enables you to:

* Specify the products for which you want to receive notifications
e Choose from flashes, downloads, and Technotes
* Receive an e-mail update in your inbox

Perform the following actions to subscribe to My support e-mails:
1. Launch an IBM support Web site such as the following site:

http:/ /www.ibm.com /support/us/
2. Click My support in the upper-right corner of the page.

3. If you have not yet registered, click register in the upper-right corner of the
support page to create your user ID and password.

4. Sign in to My support.
5. On the My support page, click Edit profile.

6. Select a product family and continue setting your preferences to specify the
information you want in your e-mails.

7. Click Submit.
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Chapter 2. Tools

IBM Tivoli Monitoring provides several tools; some include functionality for
diagnosing problems. The primary diagnostic tool of IBM Tivoli Monitoring is
logging. Logging refers to the text messages and trace data generated by the
software. Messages and trace data are sent to an output destination, such as a
console screen or a file.

Trace logging

Trace logs capture information about the operating environment when component
software fails to operate as intended. The principal log type is the reliability,
availability, and serviceability (RAS) trace log. RAS logs are in the English
language only. The RAS trace log mechanism is available on the Tivoli Enterprise
Monitoring Server, the Tivoli Enterprise Portal Server, and the monitoring agent.
By default, the logs are stored in the installation path for IBM Tivoli Monitoring.
IBM Software Support uses the information captured by trace logs to trace a
problem to its source or to determine why an error occurred. The default
configuration for tracing, such as whether tracing is enabled or disabled and trace
level, depends on the source of the tracing. You can choose how many files to keep
when the log rolls. If you cannot find the log files you need, restart the system and
try again. This section includes instructions for configuring trace logging.

lists the location of the log files directories.

Table 1. Location of log files on the Tivoli Enterprise Monitoring Server

Component Windows UNIX-based systems

Portal Server

Tivoli Enterprise |install_dir\logs install_dir/logs/

hostname_PC_timestamp.log

where:

install_dir
Specifies the directory where Tivoli Enterprise
Portal Server was installed.

hostname
Specifies the name of the system hosting the
product.

pPC Specifies the product code. cq for the Tivoli
Enterprise Portal Server.

timestamp
A decimal representation of the time at which the
process was started.

log\pluginl42.trace

Tivoli Enterprise |C:\Documents and Settings\ None.
Portal browser Administrator\
client Application Data\

Java\Deployment\
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Table 1. Location of log files on the Tivoli Enterprise Monitoring Server (continued)

Component

Windows

UNIX-based systems

Tivoli Enterprise
Portal desktop
client

install _dir\CNP\kcjerror.log
install_dir\CNP\kcjrasl.log

When launched via Java™ Web
Start:

%USERPROFILE%\Application Data\
IBM\Java\Deployment\1og\
javawsnnnnn.trace

where 'nnnnn’ is a unique,
randomly generated numeric suffix
to support generational logs (i.e.,
the last generated log will not be
overlayed by the most current
execution of Tivoli Enterprise
Portal using Java Web Start. This is
in contrast to the Tivoli Enterprise
Portal Browser client, which has a
fixed name and is overlayed with
each execution cycle.

install _dir/logs/
hostname_PC_timestamp.10g

where:

install_dir
Specifies the directory where Tivoli Enterprise
Portal Server was installed.

hostname
Specifies the name of the system hosting the
product.

PC Specifies the product code. cq for the Tivoli

Enterprise Portal Server.

timestamp
A decimal representation of the time at which the
process was started.

When launched via Java Web Start:
${user.home}/.java/deployment/Tog/javawsnnnnn.trace

where 'nnnnn’ is a unique, randomly generated numeric
suffix to support generational logs (i.e., the last generated
log will not be overlayed by the most current execution of
Tivoli Enterprise Portal using Java Web Start. This is in
contrast to the Tivoli Enterprise Portal Browser client,
which has a fixed name and is overlayed with each
execution cycle.

Tivoli Enterprise
Monitoring
Server

install _dir\logs\hostname PC_
HEXtimestamp-nn.log

where:

install_dir
Specifies the directory
where Tivoli Enterprise
Monitoring Server was
installed.

PC Specifies the product code.
ms for Tivoli Enterprise

Monitoring Server

HEXtimestamp
A hexadecimal
representation of the time
at which the process was
started.

nn Represents the circular
sequence in which logs are
rotated. Ranges from 1-5,
by default, though the first
is always retained, since it
includes configuration

parameters.

install_dir/logs/hostname_PC_timestamp.1og

where:

install_dir
Specifies the directory where Tivoli Enterprise
Portal Server was installed.

hostname
Specifies the name of the system hosting the
product.

PC Specifies the product code. cq for the Tivoli

Enterprise Portal Server.

timestamp
A decimal representation of the time at which the
process was started.

6 IBM Tivoli Monitoring: Problem Determination Guide




Table 1. Location of log files on the Tivoli Enterprise Monitoring Server (continued)

Component Windows UNIX-based systems
Monitoring install _dir\tmaitmé\logs\ install _dir/logs/hostname PC_timestamp.1og
agents hostname_PC_HEXtimestamp-nn.log
where:
where: install_dir
install_dir Specifies the directory where Tivoli Enterprise
Specifies the directory Portal Server was installed.
where monitoring agent hostname
was installed. Specifies the name of the system hosting the
PC Specifies the product product.
COd.eS’ for example, um for PC Specifies the product code. cq for the Tivoli
Ur}wersal Agent or nt for Enterprise Portal Server.
Windows.
) timestamp
HEXtimestamp . A decimal representation of the time at which the
A hexadec1mal . process was started.
representation of the time
at which the process was
started.
nn Represents the circular
sequence in which logs are
rotated. Ranges from 1-5,
by default, though the first
is always retained, since it
includes configuration
parameters.
IBM Tivoli install_dir\logs\hostname PC_ Not supported.
Warehouse Proxy | timestamp.log
agent
where
pPC Specifies the product code.
hd is the product code for
the IBM Tivoli Warehouse
Proxy agent

IBM Tivoli
Summarization
and Pruning
agent

The Summarization and Pruning Agent uses C-based RAS] tracing, Java-based RAS1 tracing and
Java-based internal tracing. By default, Summarization and Pruning Agent trace data is written
to a file in the logs subdirectory.

install_dir\logs\hostname PC _ install_dir/1ogs/hostname PC _
HEXtimestamp-nn.log HEXtimestamp-nn.Tlog
install_dir\logs\hos tname_PC_ install_dir/logs/hostname_PC_rasljava_
rasljava_HEXtimestamp-nn.1log HEXtimestamp-nn.log
install_dir\logs\hostname_PC _ install_dir/logs/hostname_PC_java_
Java_HEXtimestamp-nn.log HEXtimestamp-nn.log

where:

install_dir
Specifies the directory where monitoring agent was installed.

PC Specifies the product codes, for example, sy for IBM Tivoli Summarization and Pruning
agent.
HEXtimestamp

A hexadecimal representation of the time at which the process was started.

nn Represents the circular sequence in which logs are rotated. Ranges from 1-5, by default,
though the first is always retained, since it includes configuration parameters.
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Table 1. Location of log files on the Tivoli Enterprise Monitoring Server (continued)

Component Windows UNIX-based systems
IBM Tivoli install dir\logs\hostname PC install_dir/logs/hostname PC timestamp.1og
Enterprise HEXtimestamp-nn.log install_dir/logs/hostname PC_HEXtimestamp-nn.Tlog
Console Event
Forwarder where: where:
install_dir install_dir
Specifies the directory Specifies the directory where Tivoli Enterprise
where Tivoli Enterprise Portal Server was installed.
Monitoring Server was hostname
installed. Specifies the name of the system hosting the
pPC Specifies the product code. product.
ms for Tivoli Enterprise PC Specifies the product code. cq for the Tivoli
Monitoring Server Enterprise Portal Server.
HEXtimestamp . timestamp
A hexadecgnal . A decimal representation of the time at which the
representation of the time process was started.
at which the process was
started.
nn Represents the circular
sequence in which logs are
rotated. Ranges from 1-5,
by default, though the first
is always retained, since it
includes configuration
parameters.
IBM Tivoli c:\tmp\itmsynch\Togs\ /tmp/itmsynch/Togs/synch_
Enterprise synch_trace.log trace.log
Console Situation | ¢:\tmp\itmsynch\logs\ tmp/itmsynch/logs/synch_
Update synch_msg.1og msg.1o0g
Forwarder

Note: IBM Tivoli Enterprise Console Situation Update Forwarder logs are created on the IBM

Tivoli Enterprise Console server.

The log files are managed as follows:

¢ On Windows, the log file name includes a time stamp in hexadecimal format. By
default, the logs are stored in the installation path for IBM Tivoli Monitoring.
The following is an example of a log file name that includes the time stamp in

hexadecimal format:

ibm-kpmn803v01 cq_472649ef-01.7o0g

* On UNIX-based systems, the log file name includes a time stamp. The
UNIX-based systems RASI log files are stored in the /logs directory. The
following is an example of a log files name that includes the time stamp:

f50pa2b_ux_1112097194.10g

Note: When you communicate with IBM Software Support, you must capture and
send the RASI log that matches any problem occurrence that you report.

Installation log files
The following table lists and describes the log files created during installations.
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Table 2. Installation log files

Windows

UNIX-based systems

» ITM_HOME\InstallITM\Abort<Product_name><date_timestamp>.10g

This log is created if an abort occurs for either a first time install or
a modification of previous installation of IBM Tivoli Monitoring.
e ITM_HOME\InstallITM\<Product_name>_<timestamp>.10g

This log is created during a normal clean installation.
e ITM_HOME\InstallITM\MOD_<Product_name>timestamp.10g

This log is created if you modify an existing product specified with
the PC, or when adding or deleting components.

where:

Product_name
Specifies the product name. IBM Tivoli Monitoring 20050923
1815.10g is the log file name for the IBM Tivoli Monitoring
installation CD.

timestamp
A decimal representation of the time at which the process was
started.

$CANDLEHOME/1ogs/candle_
installation.log

You can find a log for uninstallation on Windows in the root directory where the

product was installed:
Uninstall<PC><date_timestamp>.10g

UNIX installer and configuration logs

For tracing and logging java code (that is run on UNIX® systems), this mechanism
enables problem debugging. Two sets of information are created — logs and traces.
Logs (*.log) are globalized and traces (*.trc) are in English. They contain entry and
exit parameters of method and stack traces for exceptions. The amount of
information traced depends on the level of tracing set.

Level name What is logged or traced

LOG_ERR Only exceptions and errors are logged and
traced

LOG_INFO Also log messages are logged and traced -
DEFAULT

DEBUG_MIN Also most important method entries, exits
and trace messages are traced

DEBUG_MID Most of the method entries, exits and trace
messages are traced

DEBUG_MAX All of the method entries, exits and trace
messages are traced

The level can be set in configuration files or by exporting an environment variable
called TRACE_LEVEL with one of the values mentioned above. Configuration of
RAS settings is stored in the following files:

e CH/config/ITMInstallRAS.properties (for installation)
* CH/config/ITMConfigRAS.properties (for configuration)

Chapter 2. Tools
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Callpoints are the only component that is handled differently, their logs and traces
always go to the directory CH/InstalllTM/plugin/executionEvents. The default
location for installation is CH/logs/itm_install.log(.trc) and for configuration it is
CH/logs/itm_config.log(.trc).

To gather all the needed logs and environment information in case of an error, use
the pdcollect tool described in |”pdcollect tool” on page 25.|

Component Location File name

Install logs/traces CH/logs candle_installation.log
itm_install.log (.trc)

Config logs/traces CH/logs itm_config.log (.trc)

Logs for component startup | CH/logs pc.env (lists env variables

passed to the agent)
hostname_pc_ID.log

Callpoint logs/traces CH/InstalllTM/ plugin/ callpoint.trc (.log)
executionEvents * stderr
/logs/timestamp / *.stdout
install(config)/

plugin_type/pc

Upgrading from Tivoli Distributed Monitoring log file

All upgrade actions performed by the IBM Tivoli Monitoring Upgrade Toolkit are
recorded in a central log with an associated user ID and a time stamp. Upgrade
actions taken outside of the Upgrade Toolkit are not recorded in the log. The
detailed results from running the Upgrade Toolkit are recorded in a log file.

Table 3. Upgrading from Tivoli Distributed Monitoring log file

Windows UNIX-based systems
$DBDIR/AMX/10gs/Tog_tool _ $DBDIR/AMX/Togs/1og_tool _
timestamp.log timestamp.log

where:

$DBDIR

The Tivoli Management Environment® Framework environment variable
that specifies the directory where the Object Repository (odb.bdb) is
located.

tool  Specifies the IBM Tivoli Monitoring Upgrade Toolkit tool: witmscantmr,
witmassess, or witmupgrade.

timestamp
Specifies a time stamp that includes data and time of execution.

For example: log_witmscantmr_20050721_15_30_15.log

The log file name displays when the Upgrade Toolkit tool completes the upgrade
operation. Each time a Upgrade Toolkit tool runs, its generates a new log file that
is never reused by any tool. The contents of the log file conform to the Tivoli
Message Standard XML logging format. The following example is an excerpt from
an Upgrade Toolkit tool log file:

<Message Id="AMXUT2504I" Severity="INF0">

<Time Millis="1121977824199"> 2005.07.21 15:30:24.199 CST </Time>
<Server Format="IP">YFELDMAl.austin.ibm.com</Server>
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<ProductId>AMXAMX</ProductId>

<Component>ScanTMR</Component>

</Component>1</ProductInstance>

<LogText><![CDATA[AMXUT25041 The software is creating a new baseline file
C:\PROGRAVI\Tivoli\db\YFELDMAL.db\AMX\shared\analyze\scans\
1889259234 .xm1.]1];

</LogText>

<TranslationInfo Type="JAVA"
Catalog="com.ibm.opmt.utils.messages.MigrationManager_

msgs"

MsgKey="AMXUT25041"><Param>

<! [CDATA[C:\PROGRA~1\Tivoli\db\YFELDMA1.db\AMX\shared\analyze\scans\
1889259234.xm1]] ;

</Parm></TranslationInfo>

<Principal></Principal>

</Message>

Reading RAS1 logs

This section provides an example of the Universal Agent RASI trace logs. By
default, the Universal Agent RASI trace log lists the following details about the
health of an ODBC data provider application:

* Whether the ODBC tables come online during startup.
* Whether the ODBC table data is collected.

* Errors with the ODBC-related status messages, including informational messages
about when each ODBC connection completes.

¢ Errors that occur during ODBC data provider data retrieval, including errors in
the ODBC driver code.

* Independent Software Vendor (ISV) API errors. (The Universal Agent makes API
calls to the ISV ODBC driver to implement the connections and SQL select
statements.)

The following RAS1 log excerpt lists ODBC status messages using default tracing:

KUMP_ProcessStartUpConfig") Loading metafile
<f:\candle\cma\metafiles\TIVOLI DATA_ WAREHOUSE.md1>

from startup config file

f:\cand1e\CMA\WORK\KUMPCNFG_INST1

"DCHserver::dp_register") Application TIVOLI_DATA_WAREHOUSE
successfully registered"KUMP_ProcessStartUpConfig")

1 application metafile(s) processed from startup

config

file f:\cand1e\CMA\WORK\KUMPCNFG_INST1
"KUMP_StartDataProvider") Starting ODBC Data Provider...
"KUMP_WaitODBCsourceReadyForMonitor")

Reusing connection handle for ODBC source
TIVOLI DATA WAREHOUSE table <syscharsets>
"KUMP_ODBCserver") Successfully connected to ODBC source
TIVOLI_DATA_WAREHOUSE table <syscharsets>
"KUMP_WaitODBCsourceReadyForMonitor") Reusing connection handle
for ODBC source TIVOLI_DATA_WAREHOUSE table <syscomments>

The Reusing connection handle messages indicates the ODBC provider is reusing
resource to conserve memory. The ODBC data provider allocates a connection for
each metafile with multiple attribute groups that connect to the same data source
using the same user ID and password combination. Each SQL Select statement that
is run for the various attribute groups shares the same connection handle.

The following is an excerpt from later in the same log:

userDatalist::calculateChecksum") Initial creation of catalog/attribute tables for
appTName <Tivoli_Data_Warehouse>
"KUMP_ODBCserver") ODBC source <Tivoli_Data_Warehouse> table <syscharsets> is now
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online to the data provider

"KUMP_ODBCserver") ODBC source <Tivoli_Data_Warehouse> table <syscacheobjects>
is now online to the data provider

"KUMP_ODBCserver") ODBC source <Tivoli_Data_Warehouse> table <syscomments>

is now online to the data provider"

Setting traces

When you encounter an error with IBM Tivoli Monitoring that requires contacting
IBM Software Support, you might be asked to submit a copy of the error log. The
error log is part of the trace diagnostic tool in Tivoli Enterprise Portal. It is set to
log errors, and you can set other parameters for collecting specific details.

Setting the trace option for the Tivoli Enterprise Portal client
trace

A log file is created automatically the first time you start Tivoli Enterprise Portal,
and is named install_dir\cnp\logs\kcjrasl.log. This log file contains all of the
RASI tracing for the Tivoli Enterprise Portal client. Whenever you start a new
work session, the log file is purged and rewritten for the current work session. If
you want to preserve the log file from the last work session, you must rename it or
copy it to another directory before starting Tivoli Enterprise Portal again. The
kcj.log file contains errors generated by the Sun Java " libraries used in the Tivoli
Enterprise Portal client.

To set the trace options:
1. From the Tivoli Enterprise Portal menu, select File > Trace Options.

2. Select a trace class from the list or as instructed by IBM Software Support (such
as UNIT:Workspace ALL):
ALL provides data for all classes. Use the setting temporarily, because it
generates large amounts of data.

ERROR logs internal error conditions. This setting provides the minimum level
of tracing, with little resource overhead, and ensures that program failures will
be caught and detailed.

NONE turns off the error log so no data is collected.

3. Click OK to close the window and turn on logging.
To set the trace log on UNIX systems:

Setting the trace option for the Tivoli Enterprise Portal Server
trace

You must set the trace options for the Tivoli Enterprise Portal Server through
Manage Tivoli Enterprise Monitoring Services. Before you set the trace options for
the Tivoli Enterprise Portal Server, determine the trace string. The trace string
specifies the trace setting. Set trace options for the Tivoli Enterprise Portal Server
when you start the Tivoli Enterprise Portal Server. The log file continues to grow
until you either turn off the trace or recycle the Tivoli Enterprise Portal Server.

On Windows systems:

1. On the computer where the Tivoli Enterprise Portal Server is installed, click
Start > Programs > IBM Tivoli Monitoring > Manage Tivoli Enterprise
Monitoring Services.

Right-click the Tivoli Enterprise Portal Server service.

Select Advanced > Edit Trace Parms to display the Trace Parameters window.
Select the RASI filters. The default setting is ERROR

Accept the defaults for the rest of the fields.

o k0N

IBM Tivoli Monitoring: Problem Determination Guide



6.
7.

Click OK to set the new trace options.
Click Yes to recycle the service.

On UNIX systems:

1.

Set the following variable in the §CANDLEHOME/ config/cq.ini:
KBB_RAS1=ERROR (UNIT:filter trace_level)

where filter is the component you want to trace and trace_level is the level of
tracing you want.

Recycle the Tivoli Enterprise Portal Server by "restarting" or "stop" and then
"start".

Setting the trace option for the Tivoli Enterprise Monitoring
Server trace
On Windows systems:

1.

w

On the computer where the Tivoli Enterprise Monitoring Server is installed,
select Start > Programs > Tivoli Monitoring Services > Manage Tivoli
Enterprise Monitoring Services.

Right-click the Tivoli Enterprise Monitoring Server service.
Select Advanced > Edit Trace Parms to display the Trace Parameters window.

Select the RAS1 filters. RAS1 is the unit trace for the Tivoli Enterprise
Monitoring Server. The default setting is ERROR.

Note: There must be a space between each UNIT trace setting. For example,
ERROR (UNIT:kdy all) (UNIT:kfaprpst all).

Accept the defaults for the rest of the fields.
Click OK to set the new trace options.
Click Yes to recycle the service.

On UNIX systems:

1.

Set the following variable in $CANDLEHOME/ config/hostname_ms_TEMS
ID.config

KBB_RAS1='ERROR (UNIT:filter trace_level)'

where filter is the component you want to trace and trace_level is the level of
tracing you want. The following example traces everything in the Deploy
component:

KBB_RAS1="ERROR (UNIT:KDY ALL)'

Note: There must be a space between each UNIT trace setting. For example:
KBB_RAS1="ERROR (UNIT:KDY ALL) (UNIT:KFAPRPST ALL)'

Set the following variable in $CANDLEHOME /bin/tacmd to trace the
command line interface of the Tivoli Enterprise Monitoring Server:

KBB_RAS1='ERROR (UNIT:filter trace_level)'

Recycle the Tivoli Enterprise Monitoring Server by "restarting” or "stop” and
then "start”.

For information on how to set trace levels dynamically, see |”Dvnamically modify|

ltrace settings for an IBM Tivoli Monitoring component” on page 20

Setting the trace option for the Agent Deploy tool

On Windows systems:
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1. On the computer where the Tivoli Enterprise Monitoring Server is installed,
select Start > Programs > Tivoli Monitoring Services > Manage Tivoli
Enterprise Monitoring Services.

Right-click the Tivoli Enterprise Monitoring Server service.

Select Advanced > Edit Trace Parms to display the Trace Parameters window.
Type (UNIT:kdy all) in the Enter RAS1 Filters field.

Accept the defaults for the rest of the fields.

Click OK to set the new trace options.

No ok wDN

Click Yes to recycle the service.

On Linux® systems, set the following variable in SCANDLEHOME/ config/1z.ini:
KBB_RAS1=ERROR(UNIT:kdy ALL) (UNIT:kdd ALL)

On UNIX systems other than Linux:

1. Set the following variable in $CANDLEHOME/ config/ux.ini:
KBB_RAS1=ERROR (UNIT:kdy ALL) (UNIT:kdd ALL)

2. Recycle the OS Agent on that endpoint.

Setting the trace option for the IBM Tivoli Universal Agent

Use the IBM Tivoli Universal Agent trace facility to diagnose problems with the
Universal Agent. The Universal Agent uses RAS1 tracing. By default, Universal
Agent trace data is written to a file in the logs subdirectory. The default RAS]1 trace
level is ERROR for all Universal Agent components and modules. On Windows,
Tivoli Monitoring Services overwrites the kumrasl.log each time the Universal
Agent starts and there is no method for archiving previous RAS1 log files.
Therefore, you must obtain the RAS1 log that matches the problem occurrence
before contacting IBM Software Support. You can set tracing options for individual
Universal Agent components and modules in the KUMENYV file on Windows or
the um.ini file on UNIX-based systems.

RAS1 supports pattern matching. For example, (UNIT:kums options) traces all
SNMP data provider modules because they all begin with kums. Detailed RAS1
tracing can degrade Universal Agent performance due to high CPU usage and 1/O
overhead. Therefore, set the Universal Agent RAS] tracing to KBB_RAS1=ERROR after
problem diagnosis. If a module produces excessive error messages and fills the
RASI log, set (UNIT:modulename None) to suppress the module until you resolve the
errors. If you discover an old Windows RASI log file, the KBB_RAS1 environment
was erased or commented out in the KUMENYV file, add KBB_RAS1=ERROR to the
install_dir\logs\hostname_um_timestamp.log to reactivate Universal Agent RAS1
tracing.

Set the IBM Tivoli Universal Agent trace from Manage Tivoli Enterprise
Monitoring Services:

1. Right-click the Universal Agent.

Select Advanced > Edit Trace Parms.

Select the RASI filters. The default setting is ERROR
Accept the defaults for the rest of the fields.

Click OK to set the new trace options.

ook

Click Yes to recycle the service.
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Setting the trace option for the Warehouse Proxy agent

1. On the computer where the Tivoli Enterprise Monitoring Server is installed,
select Start > Programs > Tivoli Monitoring Services > Manage Tivoli
Enterprise Monitoring Services.

Right-click Warehouse Proxy.

Select Advanced > Edit Trace Parms.

Select the RASI filters. The default setting is ERROR.
Accept the defaults for the rest of the fields.

Click OK to set the new trace options.

2 A

7. Click Yes to recycle the service.

Setting the trace option for the IBM Tivoli Summarization and
Pruning Agent

Use the IBM Tivoli Universal Agent trace facility to diagnose problems with the
Summarization and Pruning Agent. See [“Setting the trace option for the IBM Tivolil
[Universal Agent” on page 14 The Summarization and Pruning Agent uses C-based
RAS1 tracing, Java-based RAS1 tracing and Java-based internal tracing. By default,
Summarization and Pruning Agent trace data is written to a file in the logs
subdirectory. The default RAS1 trace level is ERROR for all Summarization and
Pruning Agent components and modules.

The following trace options are available for the IBM Tivoli Summarization and
Pruning Agent:

KBB_RAS1=ERROR
Trace general errors. KBB_RAS1=ERROR Affects the content of the C-based
RASI tracing (hostname_sy_HEXtimestamp-nn.log).

KBB_RAS1=ERROR (UNIT:ksz ALL)
Trace agent startup. Affects the content of the C-based RAS] tracing
(hostname_sy_HEXtimestamp-nn.log).

KBB_RAS1=ERROR (COMP:com.tivoli.twh.ksy ALL)
Minimum level trace for summarization. Affects the content of the
Java-based RASI1 tracing (hostname_sy_rasljava_timestamp-nn.log).

KBB_RAS1=ERROR (UNIT:ksy1l ALL)
Medium level trace for summarization. Affects the content of the
Java-based internal tracing (hostname_sy_java_timestamp-n.log)

KBB_RAS1=ERROR (UNIT:ksy2 ALL)
Connection level trace for summarization. Affects the content of the
Java-based internal tracing (hostname_sy_java_timestamp-n.log)

KBB_RAS1=ERROR (UNIT:ksy3 ALL)
Statement level trace for summarization. Affects the content of the
Java-based internal tracing (hostname_sy_java_timestamp-n.log).

KBB_RAS1=ERROR (UNIT:ksy4 ALL)
ResultSet level trace for summarization. Affects the content of the
Java-based internal tracing (hostname_sy_java_timestamp-n.log).

KBB_RAS1=ERROR (UNIT:ksy5 ALL)
Column value level trace for summarization. Affects the content of the
Java-based internal tracing (hostname_sy_java_timestamp-n.log).

KBB_RAS1=ERROR (UNIT:ksysql ALL)
Traces top 10 SQL statements for summarization. Affects the content of the
Java-based internal tracing (hostname_sy_java_timestamp-n.log).
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Notes:

1. The following settings: (UNIT:ksy3 ALL) or (UNIT:ksy4 ALL) or (UNIT:ksy5
ALL) produce a high volume of trace output.

2. By default, the Java-based internal trace (hostname_sy_java_timestamp-n.log)
wraps at 5 files, and each file contains 300000 lines. To change the defaults, use
the following settings in the KSYENV (Windows) or sy.ini (UNIX) files:

KSZ_JAVA_ARGS=-Dibm.tdw.maxNumberDetailTraceFiles=<A>
-Dibm.tdw.maxLinesForDetailTraceFile=<B>

where:

<A>  Specifies the maximum number of Java-based internal trace files that
can exist at any one time for a single launch

<B>  Specifies the maximum number of lines per Java-based internal trace
file.

Setting the trace option for the IBM Tivoli Monitoring upgrade
toolkit

Table 4. Setting the trace option for the IBM Tivoli Monitoring upgrade toolkit

Trace option

Instructions

Endpoint tracing

Run the following command to setting log_threshold=3 or higher on an endpoint and enable
endpoint tracing:

wep ep set_config Tog_threshold=3

Traces are written to lcfd.log on the endpoint in $LCF_DATDIR.

Tracing in a test
environment.

A Boolean value of TRUE or FALSE default. The default is FALSE.

Run the following command from a Tivoli Management Environment command prompt to
enable tracing:idlcall oid _set_debug TRUE

where:

oid Specifies the object ID of the Upgrade Manager object.
Run the wlookup Framework command to locate the Upgrade Manager object ID in the Tivoli
Management Environment:

wlookup -a | grep Upgrade

Note: Setting the trace value to TRUE sets all Upgrade Toolkit tools to TRUE, affecting all
users running Upgrade Toolkit tools.

A trace file named trace_tool_timestamp.log is created in the $DBDIR/AMX/trace/ directory in
XML format, with tool being ‘witmscantmr’, ‘witmassess’, and ‘'witmupgrade’, and timestamp
a time stamp that includes data and time of execution. Each record in this log contains a time
stamp and message. Additionally, these tools inherit Framework FFTC mechanisms such as
wtrace and odstat for transaction and method stack traces. See the Tivoli management
Framework documentation for more information about the commands.

OS Agent tracing

OS Agent tracing is enabled at a minimum level by default. Agent tracing levels can be
adjusted with agent specific settings. Logs are stored in install_dir\instal1ITM\ on
Windows agents or install_dir/logs/ on UNIX-based systems agents. These logs follow the
RAS1 log format.

Setting the trace option for the IBM Tivoli Monitoring event
forwarding

If your monitoring environment is configured for the IBM Tivoli Monitoring event
forwarding, you can forward situation events to the IBM Tivoli Enterprise Console,
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and view events on the event server through the Tivoli Enterprise Portal. If you
want to forward situation events to and view updates from IBM Tivoli Enterprise
Console in the Tivoli Enterprise Portal, you can set the trace for the event
forwarder on the Tivoli Enterprise Monitoring Server.

Use the IBM Tivoli Monitoring event forwarding trace facility to diagnose
problems with the IBM Tivoli Monitoring event forwarding. The IBM Tivoli
Monitoring event forwarding trace facility uses RAS1 tracing. The IBM Tivoli
Monitoring event forwarding is set during installation. The acceptable values
include:

* STATE
* DETAIL
« ALL

The default trace value is STATE. If you change the trace level, you must restart
the Tivoli Enterprise Monitoring Server for the change to take effect.

Use the following instructions to set the trace levels:

On Windows:

1. From Manage Tivoli Enterprise Monitoring Services, right-click the Tivoli
Enterprise Monitoring Server.

2. Click Advanced > Edit trace parms.

3. Under Enter RAS1 Filter add UNIT:kfaot trc_class
where:
trc_class

Specifies STATE, DETAIL or ALL which produces increasingly more
trace information.

4. The default log file location is C:\IBM\ITM\CMS\10gs\KMSRASL.LO0G, change if
necessary.

5. Click OK to set the trace.
6. Recycle the Tivoli Enterprise Monitoring Server for the trace to take effect.

On UNIX-based systems:
1. Edit install _dir/config/hostname_ms_hostname.config
where:

install_dir
Specifies the install directory of Tivoli Enterprise Monitoring Server.

hostname

Specifies the host name value supplied during install.

2. Add (UNIT:kfaot trc_class) to the line KBB_RAS1="'ERROR'

where:
trc_class

Specifies one of the following levels of trace detail:

¢ STATE - minimum detail.

e DETAIL - medium detail.

* ALL - maximum detail.

For example, 'KBB_RAS1='ERROR (UNIT:kfaot STATE)'
3. Save the file.
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4. Recycle Tivoli Enterprise Monitoring Server for the trace to take effect.

5. The Tivoli Enterprise Monitoring Server log can be found in
install_dir/logs/hostname_ms_nnnnnnn.log where is a time stamp. There
might be multiple files with different time stamps in the logs directory.

Setting the trace option for the IBM Tivoli Enterprise Console
Situation Update Forwarder

If your monitoring environment is configured for the IBM Tivoli Enterprise
Console, you can forward situation events to the Tivoli Enterprise Console event
server. You can also view events on the event server through the Tivoli Enterprise
Portal. If you want to forward situation events to and view updates from IBM
Tivoli Enterprise Console in the Tivoli Enterprise Portal, you can set the trace for
the Situation Update Forwarder on the IBM Tivoli Enterprise Console event server.
The default trace setting is low. You can edit the trace setting using the sitconfig
command.

$BINDIR/TME/TEC/OM_TEC/bin/sitconfig.sh update
fileName=configuration_file_name loglLevel=trace_level

where:

configuration_file_name
The filename of the actively loaded configuration file as indicated by the
situpdate.properties file.

trace_level
Specifies the level of trace as low, med, or verbose.

Use the IBM Tivoli Enterprise Console Situation Update Forwarder trace facility to
diagnose problems with the IBM Tivoli Enterprise Console Situation Update
Forwarder. The trace for the IBM Tivoli Enterprise Console Situation Update
Forwarder is set during installation. The acceptable values include:

* low

e med

e verbose

The default trace value is low. If you change the trace level after the Situation
Update Forwarder is started, you must restart the Situation Update Forwarder for
the change to take effect. There are two trace files:

synch_trace.log
is always created.

synch_msg.log
is created if an error occurs while running the Situation Update Forwarder.

Run the following command to set the trace levels:

$BINDIR/TME/TEC/OM_TEC/bin/sitconfig.sh update
fileName=configuration file_name loglLevel=trace level

where:

configuration_file_name
The filename of the actively loaded configuration file as indicated by the
situpdate.properties file.

trace_level
Specifies the level of trace as low, med, or verbose.
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Setting up RAS1 tracing on z/OS systems

This syntax is used to specify a RAS1 trace in the KppENV file (where pp is the
product code: HL for the OMEGAMON® z/0S® Management Console or DS for
the Tivoli Enterprise Monitoring Server). After you add this command to the
KppENV file, you must stop and restart the address space for the command to
take effect. After that, it remains in effect for the life of the address space. To end
the trace, you must edit the KppENYV file again to reset the trace level, and stop
and restart the address space.

The basic syntax of the RAS1 trace command is:

KBB_RAS1= global_class (COMP: component_type)
(ENTRY: entry point) (UNIT: unit_name, class)

where:

global_class
Indicates the level of tracing that you want. This is a global setting that
applies to all RASI filters in the process. If you set this global class by
itself, it is global in scope and the trace cannot filter on any of the other
keywords. Separate combined classes with a space. The following values
are possible. Valid abbreviations are in parentheses.

ERROR (ER):
returns severe error messages only (this is the default for most
applications).

STATE (ST):
records the condition or current setting of flags and variables in the
process. If state tracing is enabled, you can see the current state of
particular variables or flags as the process is running.

FLOW (FL):
causes a message to be generated at an entry or exit point of a
function.

DETAIL (DE):
produces a detailed level of tracing.

INPUT (IN):
records data created by a particular API, function, or process.

ALL: causes all available messages to be recorded. This setting combines
all the other forms of tracing.

COMP
Indicates that the trace includes a component type. The COMP keyword is
used to trace groups of routines related by function (or component). Use
this keyword only at the explicit request of an IBM Software Support
representative.

component_type
Identifies a component type. An IBM Software Support representative can
tell you what value to specify.

ENTRY
Narrows a filtering routine to specify a specific ENTRY POINT. Since
multiple entry points for a single routine are rare, use this keyword only at
the explicit request of an IBM Software Support representative.
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entry_point
Represents the name of the entry point. An IBM Software Support
representative can tell you what value to specify.

UNIT Indicates that the trace is to look for a match between the compilation unit
dispatched and the fully or partially qualified compilation unit specified on
the RASI statement. A match results in a trace entry.

unit_name
Represents the name of the compilation unit. In most instances, this name
defines the component that is being traced. The value is likely to be the
three-character component identifier for the monitoring agent (KHL for
OMEGAMON z/0S Management Console).

class  One of the same values specified for global_class but, because of its position
inside the parentheses, narrowed in scope to apply only to the unit_name
specified.

Note: The default setting for monitoring agents on z/OS is KBB_RAS1=ERROR,
meaning that only error tracing is enabled. You can specify any combination
of UNIT, COMP, and ENTRY keywords. No keyword is required. However,
the RAS1 value you set with the global class applies to all components.

For more information on setting RAS1 tracing on z/OS system, see your individual

monitoring agent's user's guide.

Dynamically modify trace settings for an IBM Tivoli Monitoring

component

You can access the Tivoli Enterprise Monitoring Server, Tivoli Enterprise Portal
Server, almost all of the agents, and other IBM Tivoli Monitoring components from
this utility.

This method of modifying trace settings on an IBM Tivoli Monitoring component
is the most efficient method since it allows you to do so without restarting the
component. Settings take effect immediately. Modifications made this way are not
persistent.

Note: When the component is restarted the trace settings are read again from the
.env file. Dynamically modifying these settings does not change the settings
in the .env files. In order to modify these trace settings permanently, modify
them in the .env files.

How to turn tracing on:

In order to use this utility you need to know a local log-on credential for the
machine.

This method uses the IBM Tivoli Monitoring Service Console. The Service Console
is accessed using a web browser. Access the utility by using the following link:

http://hostname:1920

where hostname is the hostname or IP address of the system where the IBM Tivoli
Monitoring component is running. The utility then appears with information about
the components that are currently running on this machine.
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For example, the component Tivoli Enterprise Portal Server shows as cnp, the
Monitoring Agent for Windows OS shows as nt, and the Tivoli Enterprise
Monitoring Server shows as ms.

Select the link below the component for which you want to modify the trace
settings. In the previous view if you want to modify tracing for the Tivoli
Enterprise Monitoring Server, you select the "IBM Tivoli Monitoring Service
Console” link under the Service Point: system. balayne_ms.

When you select one of the links, you will be prompted for a user ID and
password to access the system. This is any valid user that has access to the system.

Typing ? displays a list of the supported commands.
The command for modifying the trace settings is rasl.

If you type rasl in the field at the bottom of the screen, you will then see the help
for this command.

The set option (rasl set) turns on the tracing, but does not affect existing tracing.
An example would be rasl set (UNIT:xxx ALL) (UNIT:yyy Detail). This command
will enable full tracing for the xxx class of the component and low-level detailed

tracing on the yyy class of the component.

The ras1 list command lists what tracing is set as default. It is best to do an initial
list in order to track what changes you have made to the tracing settings.

The following list describes the options of tracing available:
ALL - Provides all trace levels. Shown as ALL when using the ras1 list command.

Flow - Provides control flow data describing function entry and exit. Shown as Fl
when using the ras1 list command.

ERROR - Logs internal error conditions. Shown as ER when using the ras1 list
command. The output also shows as EVERYE+EVERYU+ER.

Other settings which provide component specific information are:

Detail - Shown as Det when using the ras1 list command.

INPUT - Shown as IN when using the ras1 list command.

Metrics - Shown as ME when using the ras1 list command.

OUTPUT - Shown as OUT when using the ras1 list command.

State - Shown as ST when using the ras1 list command.

Setting trace to ALL includes every trace point defined for the component. This
might result in a large amount of trace. If you have been given a more specific

setting, use it. ALL can sometimes be necessary when isolating a problem. It is the
equivalent of setting "Error Detail Flow State Input Output Metrics”.
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The ras1 units command is used to determine the list of UNITs and COMPs
available in an IBM Tivoli Monitoring component. The first column is the list of
available UNIT values, the last column lists the corresponding COMP values.

Turning on (COMP:KDH ALL) will turn ALL level tracing on for all of the files
where KDH is listed in the right hand column (highlighted below).

The following is a subset of the results for the Monitoring for Windows agent:

kbbcrel.c, 400, May 29 2007, 12:54:43, 1.1, =*

kbbcrnl.c, 400, May 29 2007, 12:54:42, 1.1, =*

kdhblde.c, 400, May 29 2007, 12:59:34, 1.1, KDH
kdhOmed.c, 400, May 29 2007, 12:59:24, 1.1, KDH
kdhsrej.c, 400, May 29 2007, 13:00:06, 1.5, KDH
kdhblfh.c, 460, May 29 2007, 12:59:33, 1.1, KDH
kdhbloe.c, 400, May 29 2007, 12:59:38, 1.2, KDH
kdhslns.c, 400, May 29 2007, 13:00:08, 1.3, KDH
kbbacdl.c, 400, May 29 2007, 12:54:27, 1.2, ACFl
kbbaclc.c, 400, May 29 2007, 12:54:27, 1.4, ACF1
kbbacli.c, 400, May 29 2007, 12:54:28, 1.11, ACF1
kdhsfcn.c, 400, May 29 2007, 13:00:11, 1.1, KDH

kdhserq.c, 400, May 29 2007, 12:59:53, 1
kdhblpr.c, 400, May 29 2007, 12:59:39, 1
kdhsgnh.c, 400, May 29 2007, 12:59:49, 1
kdhOuts.c, 400, May 29 2007, 12:59:23, 1
kdhsrsp.c, 400, May 29 2007, 13:00:13, 1
kdhslrp.c, 400, May 29 2007, 13:00:12, 1
kdhscsv.c, 400, May 29 2007, 12:59:58, 1
kdebbac.c, 400, May 29 2007, 12:56:50, 1.

.1, KDH
.1, KDH
.1, KDH
.1, KDH
.2, KDH
.1, KDH
.9, KDH
10, KDE

The UNIT value matches any unit that starts with the specified value. For example,
(UNIT:kra FLOW) prints the FLOW traces for all files which match kra*.

How to turn tracing back off:

The option for turning the tracing off is ANY. For example you would use the
following command to turn off tracing for the kbbcrcd class of the Windows OS
agent:

rasl set (UNIT:kbbcrcd ANY)

Using the IBM Tivoli Monitoring Service Console

The IBM Tivoli Monitoring Service Console enables you to read logs and turn on
traces for remote product diagnostics and configuration. The IBM Tivoli
Monitoring Service Console is uniquely identified by its service point name. All
IBM Tivoli Monitoring Service Consoles for a host are linked and presented on the
IBM Tivoli Monitoring Service Index for that host. Point a browser to the HTTP
port 1920 on a specific host (for example, http://goby:1920) to launch the IBM
Tivoli Monitoring Service Index. You can also launch the Service console can also
be launched with the https protocol by connecting via the https protocol and port
3661. You can perform operations on a specific IBM Tivoli Monitoring process by
selecting the IBM Tivoli Monitoring Service Console associated with a service point
name.

Starting the IBM Tivoli Monitoring Service Console
Use the following procedure to start the IBM Tivoli Monitoring Service Console.
1. Start Internet Explorer V5 or higher.

2. In the Address field, type the URL for the Tivoli Enterprise Portal browser
client installed on your Web server.
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The URL for the Tivoli Monitoring Services Web server is
http://hostname:1920

hostname
Specifies the computer where the Tivoli Enterprise Portal Server was

installed. If the IBM Tivoli Monitoring Service Console is not displayed,
a system administrator might have blocked access to it. See
access to the IBM Tivoli Monitoring Service Console” on page 23

3. Click the IBM Tivoli Monitoring Service Console link associated with the
desired process (service point name).

4. When the log in window opens, click OK.

In secure environments, you need a valid user ID and password to proceed.
Upon successful login, the IBM Tivoli Monitoring Service Console opens with
three areas:

* Header
* Command Results
¢ Command Field

You can now issue IBM Tivoli Monitoring Service Console commands in the
command input area. For a list available commands, type a question mark (?)
and click Submit.

The IBM Tivoli Monitoring Service Console performs user authentication using the
native OS security facility. If you use the IBM Tivoli Monitoring Service Console on
z/0S systems, your user ID and password are checked by the z/OS security
facility (RACF/SAF). If you use the IBM Tivoli Monitoring Service Console on
Windows systems, then you must pass the Windows workstation user ID and
password prompt. This is the rule except for instances of a NULL or blank

password. The IBM Tivoli Monitoring Service Console never accepts a NULL or
BLANK password.

A password is always required to access the service console. Blank passwords,
even if correct, cannot access to the service console. Even if a user ID is allowed to
login to the operating system without a password, access to the service console is
denied. Create a password for the user ID that is being used to login to the service
console.

Blocking access to the IBM Tivoli Monitoring Service Console

The Tivoli Monitoring Services integral Web server is installed automatically with
the Tivoli Enterprise Portal Server and enables users to access the IBM Tivoli
Monitoring Technology Service Console. You can prevent users from accessing the
IBM Tivoli Monitoring Technology Service Console that is available through the
integral Web server (http:/ /computer_name:1920). To block access to the IBM Tivoli
Monitoring Technology Service Console, disable the integral Web server. However,
if you disable the integral Web server, you must install a third party Web server on
the Tivoli Enterprise Portal Server computer to access the images and style sheets
for the graphic view and edit the application parameters at every desktop client.

1. From the Windows desktop select Start > Run >
2. Type regedit.
3. Open the Tivoli Enterprise Portal Server Environment folder:

HKEY_LOCAL_computer\SOFTWARE\Tivoli Monitoring Services\KFW\Tivoli
Enterprise Portal Server\KFWSRV\Environment

4. Locate the KDC_FAMILIES in the right frame and add a space and type the
following at the end of the line: http_server:n
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Example:
IP PORT:1918 SNA use:n IP.PIPE use:n http_server:n

Install a third party Web server on each computer where you installed the
Tivoli Enterprise Portal desktop client:

a. From the Windows desktop select Start > Programs > Tivoli Monitoring
Services > Manage Tivoli Enterprise Monitoring Services.

b. Right-click Tivoli Enterprise Portal desktop and select Reconfigure from
the menu.

C. In the list of parameters that opens, double-click cnp.http.url.DataBus to
open the Edit Tivoli Enterprise Portal Parm window.

d. Type the URL to the external Web server and to the cnps.ior file in the
candle\cnb directory.

For example, if the Web server name is myWeb.hostname.com and its
document root was configured to be \candle\cnb, the value to type is:

http://myWeb.hostname.com/cnps.ior
e. Check In Use and click OK.

Displaying tasks in the command prompt

The Tivoli Enterprise Portal Server has an option to display the tasks at the
command prompt. This is used primarily with IBM Software Support for gathering
diagnostic information.

1.

3.

From your Windows desktop, select Start > Programs > Tivoli Monitoring
Services > Manage Tivoli Enterprise Monitoring Services.

Right-click Tivoli Enterprise Monitoring Server, then select Change Startup
from the menu.

Check Allow Service to Interact with Desktop.

Clearing the JAR cache

24

If you encounter problems, IBM Software Support might instruct you to uninstall
and to clear the JAR cache.

1.
2.

If Tivoli Enterprise Portal is running, exit by closing the browser window.
Start the Java Plug-in.

Additional Information: You can find the Java Plug-in in Start > Settings >
Control Panel. To start it, double-click the Java Plug-in icon. Your Windows
desktop might have a shortcut to the Java Plug-in (1.4.2).

In the Java Plug-in Control Panel window, select the Cache tab and click Clear
JAR Cache.

When a message indicates the JAR cache is cleared, click OK.

If you want to start Tivoli Enterprise Portal browser mode again, restart
Internet Explorer and type the URL for Tivoli Enterprise Portal. The Java
Extension Installation progress bar shows as each Java archive file is
downloaded. Upon completion, the logon window opens and prompt you to
enter a user ID.
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Using the UAGENT application

The UAGENT application is a diagnostic tool to help solve problems you might
experience with the IBM Tivoli Universal Agent. Every Universal Agent data
provider automatically activates an application called UAGENT, which includes
the DPLOG and ACTION workspaces.

DPLOG

The DPLOG is a pure event table in that it maintains only the most recent 100
rows, unless overridden by the KUMA_MAX_EVENT_ENTRIES environment
variable. The DPLOG contains informational and error messages about the status
of a data provider that indicate:

* If a metafile was validated successfully.

* If a metafile failed validation (which means the application will not come
online).

 If a data source was available at startup

* Which console ports and socket listening ports were used or unavailable.

* When monitoring started and stopped for a data source.

* When monitoring switched from one file to another.

* When an API or socket client program connected and disconnected.

The DPLOG also records other actions including metafile refreshes. The two most
common Universal Agent problem symptoms are:

* One or more managed systems do not come online.

¢ The managed systems are online but the workspaces are empty.

Use the UAGENT application workspaces as one of the first tools to diagnose a
Universal Agent problem. You might find the solutions for both problems in the
appropriate DPLOG. The ODBC data provider also includes a DPLOG message

indicating when monitoring started for every attribute group listed in every ODBC
metafile.

ACTION workspace

Whenever a Take Action command is issued or a Reflex Action fires, an entry is
added to the ACTION workspace. The Action table is keyed and ActionID is the
Key attribute. The Action table rows have a time-to-live value of 30 minutes.
Unlike the DPLOG which is data provider-specific, the ACTION table is shared by
all data providers. If you run multiple data providers, the ACTION workspace
under every UAGENT application contains the same rows.

The Action_Result can indicate what happened to a particular Take Action
command. For example, if Universal Agent reflex actions fire faster than one per
second, the ACTION workspace temporarily stops recording the results. Recording
resumes after several minutes if the action rate slows down.

pdcollect tool

This tool allows you to collect the most commonly-used information from a system
to allow for IBM service to investigate a problem. It gathers log files, configuration
information, version information, etc.

This tool is available for Windows, UNIX, Linux, and z/OS systems. It is located in
the ITM_Install /bin directory on Windows, UNIX, and Linux systems. It is
supplied as the KMSPDCOL member of the RKANSAM dataset on z/OS systems.
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This tool is included in the basic image install for IBM Tivoli Monitoring v6.2.
Invocation is simple and is documented in the command.

There are a number of options for pdcollect that control the data collection process.
You should request assistance from IBM Service to determine which, if any, of the
options should be specified for the particular problem which you have
encountered.

You must execute pdcollect while running under the same user ID that you use to
run IBM Tivoli Monitoring to avoid problems with file access authorization.

On Windows, UNIX and Linux systems, you are prompted to examine the data
that has been collected. You can add additional files pertaining to the problem by
copying them into the same directory. You can also edit or remove data which you
do not want to expose to IBM for confidentiality reasons, but doing so may impact
diagnosing the problem. Again, consult with IBM Service if you have questions.
The output produced by pdcollect is a single compressed file that should be
transmitted in binary form to IBM for analysis. The name of the output file is
displayed in a message at the end of pdcollect processing.

Running the following command on Windows systems results in the output that
follows:

pdcollect /?
This program is intended to collect diagnostic information from the
computer on which it is executed. Collected data includes:

-system configuration

-environment

-disk space information

-network state

-errors and warnings from the event log
-configuration and Tog files

Command 1line syntax is:
pdcollect.cmd [options] [work-directory]
where:
"work-directory" is the directory to be used to collect the data.

Do not specify the root directory of a disk partition as the work-directory.
If not specified, %TEMP% is used.

"options" are any of the following, in any order or case:
"/noapp" specifies that application event log data is NOT to be collected
"/nosec" specifies that security event Tog data is NOT to be collected

"/nosys" specifies that system event log data is NOT to be collected
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"/noevent" specifies that NO event log data is to be collected
(equivalent to specifying /noapp, /nosec and /nosys)

"/nohist" specifies that history files are NOT to be collected
"/nologs" specifies that ITM Tog/trace files are NOT to be collected
"/noprompt" specifies that all interaction with the user is suppressed

options may also be prefixed with "-" instead of "/"

Note: On UNIX platforms, the combined filename and path name cannot be larger
than a total of 255 characters. On AIX® systems, the filename must be less
than 100 characters and path names must be less than 155 characters.

The z/0OS version of pdcollect is a TSO clist that is installed in
RKANSAM(KMSPDCOL). You can copy this clist into a clist library of your choice,
renaming it if you desire. Once the clist resides in a dataset accessible through
SYSPROC in a TSO logon procedure, then it can be invoked by name. In the
following example, the "KMSPDCOL" name was retained:

%kmspdcol help
FUNCTION -

THIS PROGRAM IS INTENDED TO COLLECT DIAGNOSTIC INFORMATION FROM
THE COMPUTER ON WHICH IT IS EXECUTED. COLLECTED DATA INCLUDES:

- SYSTEM CONFIGURATION
- NETWORK INFORMATION
- OUTPUT FROM THE SPECIFIED JOB

SYNTAX -
>>-= KMSPDCOL -.- HELP ====mmmmmmmmmooommmmooeee S

!- JOBOUT (DSN) =====mmmmmmm e mmmo !

.= JOBNAME (JNAME) = .===-mmmmmmmome- !

.- JOBNO(JNUM) -.
S >>

.- RHILEV(X) -. .- RVHILEV(X) -. .- SYS(X) -.

OPERANDS -

HELP REQUESTS DISPLAY OF THIS HELP INFORMATION

JOBOUT (DSN) IS THE NAME OF THE DATASET CONTAINING THE
COMPLETE OUTPUT FROM THE ITM JOB

JOBNAME (JNAME) IS THE NAME OF THE ITM JOB IN THE JES SPOOL

JOBNO (JNUM) IS THE JES JOB NUMBER OF THE ITM JOB (REQUIRED
IF THERE ARE MULTIPLE JOBS WITH THE SAME NAME)

NOTE THAT SDSF IS REQUIRED TO SUPPORT THE USE
OF JOBNAME/JOBNO. IF YOU DO NOT HAVE SDSF, YOU
MUST USE JOBOUT.

RHILEV SPECIFIES THE HLQS OF THE NON-VSAM DATASETS
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IN THE ITM RTE

RVHILEV SPECIFIES THE HLQS OF THE VSAM DATASETS
IN THE ITM RTE

SYS SPECIFIES THE NAME OF THE ITM RTE

RHILEV, RVHILEV AND SYS WILL NORMALLY BE EXTRACTED FROM THE
JOB OUTPUT BUT MAY BE SPECIFIED IF THE PROGRAM IS UNABLE TO
FIND THEM OR IF YOU WISH TO OVERRIDE THE EXTRACTED VALUES.

Note: The output data is placed in the dataset PDCOLLCT.DAT under the
high-level qualifier designated by the PREFIX option of the TSO PROFILE
command. See the PROFILE command description in the TSO/E Command
Reference for details.

ras1log tool

This is a tool that converts the time stamps contained in trace logs into readable
values. This tool can be found in the itm_install/bin directory on both Windows
and UNIX systems. The following lists how the help appears:

usage: rasllog [-1|u] logfile ...
-1 for Tocal time
-u for UTC time

logfile can be either a filename or ’-” for stdin (default).

You can either pass the tool a file name or you can filter a file through it to obtain
a readable log. You do not need to specify any arguments.

The following examples work on Windows systems:
rasllog <balayne_ms_46c071a6-01.10g

rasllog <balayne ms 46c071a6-01.1og | grep GetEnv
rasllog <balayne ms_46c071a6-01.10g > tems_Tog

The first example sends the result to the screen, the second sends the result to grep
to find all of the lines with the text ‘GetEnv’ in them, which are then printed on
the screen, and the third sends the result to a file named "tems_log’.

By default this tool converts the timestamps to UTC time. When using the -1
option, it writes local time instead.

Log and Trace Analyzer Tool

The Log and Trace Analyzer tool helps you view, analyze and correlate log files.
You can evaluate multiple event and error logs with time synchronization.

You can find more information about the Log and Trace Analyzer at the following
website:

http://www-128.1ibm.com/developerworks/autonomic/probdet.html

To obtain this tool, you must follow the link to the IBM OPAL - Best Practices and
Tools for IT Service Management website, download and install the tool to
cnb\LTA.

Note: The jar file must be found in the system where the Tivoli Enterprise Portal
client is invoking it.
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Once it is installed, launch the Log and Trace Analyzer tool from the Tivoli
Enterprise Portal Event Tools view. You can then use the tool to view logs from the
Tivoli Enterprise Portal Server or Tivoli Enterprise Monitoring Server on a
distributed system, or the RKLVLOG from a monitoring agent or monitoring server
on z/0S system.

In addition to the Log and Trace Analyzer, specialized OMEGAMON adapters are
provided to aid in problem determination for some of the more common problems
that you might experience when using Tivoli Management Services (Tivoli
Enterprise Portal, Tivoli Enterprise Portal Server, and Tivoli Enterprise Monitoring
Server). The OMEGAMON adapters process application log files and transform
their contents into a common format for logging, management, and problem
determination.

OMEGAMON adapters and associated documentation are available for download
as they are developed from the following website:

http://www.ibm.com/software/tivoli/opal?NavCode=1TW10TM2U

Backspace Check utility

On UNIX systems, if you have incorrectly configured the backspace key, you will
see the following:

* When you press the backspace key, characters such as "A?" and ""H" are
displayed on the screen.

* The backspace key seems to be working correctly when entering text, but you
later find characters such as "A?" and ""H" in configuration files and your
software malfunctions.

Configure your terminal and "stty erase" to use the same key code for backspace.
Consider using "A?" as the key code. Verify your configuration with the IBM Tivoli
Monitoring distributed utility, Install: BackspaceCheckUtility.

Build TEPS Database utility

You can use this utility to build a blank database. Prior to the IBM Tivoli
Monitoring v6.1 release, this utility would also populate the database with tables.
Now, it is necessary to also run the BuildPresentation utility to build the tables in
the database.

To build and populate a database, complete the following steps:

1. From the Manage Tivoli Enterprise Monitoring Services window, right-click
TEPS.

2. Select Advanced -> Utilities -> Build TEPS Database.
3. Run the BuildPresentation.bat file found in install_dir\CNPS.
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Chapter 3. Installation and configuration troubleshooting

This chapter contains the following sections, which provide information about
problems that might occur during installation, upgrading from previous versions,
and uninstallation of the product and product components:

* [“Frequently asked questions” on page 31|

* |“General installation problems and resolutions” on page 33

» [“Windows installation problems and resolutions” on page 40|

* [“UNIX-based system installation problems and resolutions” on page 42|

* [“Troubleshooting z/OS-based installations” on page 44

* [“Uninstallation problems and workarounds” on page 57

Frequently asked questions

General installation frequently asked questions
The following table lists general installation frequently asked questions.

Table 5. General frequently asked questions

Question

Answer

Are fixpacks required if a user
migrates Candle® monitoring
agent to IBM Tivoli Monitoring.

Fixpacks for CNP196 are delivered as each monitoring agent is migrated to IBM
Tivoli Monitoring.

Note: The IBM Tivoli Monitoring download image or CD provides application
fixpacks for the monitoring agents that are installed from that CD (for example,
the agents for operating systems such as Windows, Linux, UNIX, and i5/0S®).
The migration software for other agents is located on the download image or
CDs for that specific monitoring agent, such as the agents for database
applications.If you do not migrate the monitoring agent to IBM Tivoli
Monitoring, the agent continues to work. However, you must migrate to have all
the functionality that IBM Tivoli Monitoring offers.

Do presentation files and
customized OMEGAMON DE
screens for Candle monitoring
agents need to be migrated to a
new zLinux system.

The migration from version 350 to IBM Tivoli Monitoring handles export of the
presentation files and the customized OMEGAMON DE screens.

Does the warehouse migration
tool have a rollback function?

No. You must back up the old warehouse database and the new warehouse
database before running the warehouse migration tool to prevent loss of data.
For more information about running the warehouse migration tool, see the IBM
Tivoli Monitoring Installation and Setup Guide.

What if the migration tool fails?

Because you backed up the source database, you can refer to the
WAREHOUSEMIGLOG table to determine which tables migrated successfully. If
you want to restart without re-migrating the successfully migrated tables, you
delete the tables that were completely migrated in the source database. Also,
delete all the data that was incompletely exported in the last tables: use the
writetime column to distinguish old data from new data.
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Windows installation frequently asked questions

Table 6. Windows installation frequently asked questions

Question

Answer

How can I determine if Windows
Security logging is on?

If the sysadmin account that you use to log on to Tivoli Enterprise Portal is not
a Windows Administrator, you do not see the security log.

Windows security logging is not turned on by default. Normally, data is not
collected in the security log unless the Windows administrator turns it on. The
Record Count = 0 in the Windows monitored logs report confirm that security
logging is not turned on.

How can I diagnose problems
with product browse settings?

1. Click on Start > Programs > Tivoli Monitoring > Manage Tivoli Enterprise
Monitoring Services to display the Manage Tivoli Enterprise Monitoring
Services window.

2. Right-click the Windows agent and select Browse Settings. A text window
displays.

3. Click Save As and save the information in the text file. If requested, you can
forward this file to IBM Software Support for analysis.

UNIX-based systems installation frequently asked questions

Table 7. Frequently asked questions for UNIX-based systems installation

Problem

Solution

The product was installed as root.
Without re-installing the product,
how can I change from root to
another ID?

If you installed and started the agent as root, the files do not have correct
permissions, so the result is unpredictable. For this reason, do not use root ID
either to install or start the UNIX-based systems agents. Create a user ID with
all the authority and permissions to install, run or use any other ID other than
root.

As root, run the command UnSetRoot , which is located under
install_dir/bin/ directory. This script resets all the files under the install_dir
directory, owned by root.

UnSetRoot [ -h CANDLEHOME ] userID

After executing the above script, run "SetPerm” command, which is located
under install_dir/bin/ directory. This command sets root permission for
certain UNIX-based systems agent files.

How can I set the trace option to
capture any abends (core files)?

Add the following in the agent .ini file. For an example if it is KUX agent, add
the following line in install_dir/config/ux.ini file

KBB_SIGl=trace —dumpoff

In an environment of 50 servers
with at least one agent per server,
a new agent (vt) was installed
outside the firewall. The new
agent must be configured on
Tivoli Enterprise Monitoring

Is it necessary to change all the
other UNIX-based systems agents
for IP:PIPE?

Server for IPPIPE communication.

Is it not necessary to change all the other UNIX-based systems agents for
IP:PIPE. You have to configure only the agent, which connects to the Tivoli
Enterprise Monitoring Server through a firewall. However, you must configure
the Tivoli Enterprise Monitoring Server for IPPIPE communication.

While configuring the agent, which communicate through the firewall, you get
the following options:

* Does the agent connect through a firewall? [YES or NO] (Default is: NO)
e IPPIPE Port Number (Default is: 1918)
* Enter name of KDC_PARTITION (Default is: null)
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Table 7. Frequently asked questions for UNIX-based systems installation (continued)

Problem

Solution

Does SNMP need to be turned on
to monitor UNIX-based systems
host? The monitoring server is
running WINNT4.0 and
monitoring agent is running on
HPUX?

If you are communicating only through Tivoli Enterprise Monitoring Server you
do not need SNMP. However, if you are sending traps to the emitter through the
Tivoli CA uni-center or HP Open-view, SNMP is required.

Pressing the backspace key,
characters such as "A?" and ""H"
appear on the screen.

The backspace key appears to be
working correctly when entering
text, but you later find characters
such as "7?" and "A"H" in
configuration files and your
software malfunctions.

If you receive one of these symptoms when using the backspace on UNIX
computers, you have incorrectly configured the backspace key.

Configure your terminal and "stty erase" to use the same key code for
backspace. Consider using "?" as the key code. Verify your configuration with
the IBM Tivoli Monitoring distributed utility, Install: BackspaceCheckUtility.

When running the install.sh script
on a Linux system, I get a
Memory fault (core dump) at
different, random stages of the
install, regardless of what
selections I make.

When I run the command "getconf GNU_LIBPTHREAD_VERSION" on my
system, the response I receive is "linuxthreads-0.10" or something similar. This is
caused by the /etc/profile entry of "LD_ASSUME_KERNEL=2.4". If I unset this
variable or change the value of /etc/profile to "2.6", the getconf command
returns "NPTL 2.3.4" or something like it. This enables me to run the install.sh
script without causing the memory fault.

OR

Changing the JAVA_COMPILER variable to NONE before upgrading allows me
to continue without hitting the core dump.

General installation problems and resolutions

This section describes general installation problems and resolutions.

Incorrect behavior after an uninstallation and re-installation

You might experience incorrect behavior if you uninstall then reinstall the product
without rebooting. For example, you might experience the following problems:

* Inability to create trace logs.

* Agents do not start.

* Agents data is corrupt.

Reboot the system to resolve the problems.

Receive an install.sh error when installing two components or
agents in the same installation directory

Installing two components or agents in the same CANDLEHOME or installation
directory is supported as long as the User ID used to run the installation is always

the same.

Installing two components or agents in the same CANDLEHOME or installation
directory using different User IDs is not supported.
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During a remote Tivoli Enterprise Monitoring Server upgrade,
you receive a "The Backup procedure for TEMS database files
has failed." pop-up

During a remote Tivoli Enterprise Monitoring Server upgrade, you receive the
following pop-up message:

"The Backup procedure for TEMS database files has failed. If you continue with the
installation your customized tables could be Tost.
Would you 1ike to abort the installation?"

If you click YES, there is a risk of losing your customized tables. To ensure that
you do not lose data, complete the following steps:

1. Click NO and exit the upgrade installation.
2. Restart the remote Tivoli Enterprise Monitoring Server system.

3. Stop all the IBM Tivoli Monitoring components from the "Manage Tivoli
Enterprise Monitoring Services” window.

4. Rerun the upgrade installation now with the remote Tivoli Enterprise
Monitoring Server in the stopped state.

The upgrade installation is complete.

Upgrade from IBM Tivoli Monitoring v6.1 and LAQ7 to v6.2
fails on Hub Tivoli Enterprise Monitoring Server

After completing the installation, errors are shown such as "No such file or
directory" and "Exceptions.ITMException KCIINO301E TEMS User Authentication
requirements have failed."

Check to see if there are multiple .config files for the same Tivoli Enterprise
Monitoring Server name. Also, files with a long hostname (fully qualified) might
include references to downlevel architecture. In IBM Tivoli Monitoring v6.2, the
aix513 architecture has been deprecated, so references to aix513 cause the SetPerm
script to fail.

Agents register with a blank product code and expected log
files are not created

On Windows systems, you have already installed IBM Tivoli Monitoring v6.2 and
you are installing any IBM Tivoli Monitoring v6.1 component into this
infrastructure. In this case, the component’s ENV configuration files can be
corrupted by the replacement of key name K*_JAVA_HOME with JAVA_HOME,
where * indicates the product code. This can occur after installation or an agent
upgrade.

You must manually restore this KEY name with the proper value, as listed below
by product:

* Warehouse Proxy Agent - KHD_JAVA_HOME
* Summarization and Pruning Agent - KSZ_JAVA_HOME

* IBM Tivoli Composite Application Manager File Transfer Enablement -
KT1_JAVA_HOME

* IBM Tivoli Composite Application Manager for Response Time Tracking -
KT2_JAVA_HOME

* IBM Tivoli Composite Application Manager for End User Response Time
Dashboard Agent - KT3_JAVA_HOME
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* IBM Tivoli Composite Application Manager for Client Response Time Agent -
KT4_JAVA_HOME

* IBM Tivoli Composite Application Manager for Web Response Time Agent -
KT5_JAVA_HOME

 IBM Tivoli Composite Application Manager for Robotic Response Time Agent -
KT6_JAVA_HOME

* IBM Tivoli Composite Application Manager for Web Servers -
KWJ_JAVA_HOME

* Monitoring Agent for J2EE - KW]_JAVA_HOME
* Monitoring Agent for WebSphere® - KWJ_JAVA_HOME

Various IBM Tivoli Monitoring components and tacmd
commands fail with “Symbol resolution failed” message

After installing the IBM Tivoli Monitoring v6.2 Tivoli Enterprise Monitoring Server
on AIX and loading support, various components such as the Tivoli Enterprise
Monitoring Server, and Tivoli Enterprise Portal Server, and the tacmd commands
fail with “Symbol resolution failed” message.

Confirm that version 8 for the C++ runtime environment is the version in use.
Look at the “Symbol resolution failed” errors which indicate a problem with the C
libraries.

To verify which version of C++ runtime environment is installed use:
Lslpp -1| grep x1C.rte

Download IBM C++ Runtime Environment Components for AIX V8 from the Web
site:
http://www-1.ibm.com/support/docview.wss?uid=swg24012187

Install the version 8 C++ RTE and reboot.

On Solaris systems, GSKit installation fails to install

If you have previously installed GSKit, and then manually removed it, the
installation might fail. Perform the following actions to remove the two gskit
installations, and then continue the installation as normal:

pkgrm gsk7bas
pkgrm gsk7bas64

Cannot update agent with IBM Tivoli Monitoring 6.1 fixpack or
patch to an already installed IBM Tivoli Monitoring 6.2 agent

The error message returned from the tacmd updateAgent command is:

The agent bundle {product code} is missing the prerequisite UI which is
not in the agent bundle depot on {node name}.
The prerequisite agent bundle is not present in the agent bundle depot.

The workaround for this problem is to modify the template.dsc file in the fixpack
or patch bundle so that the UI prerequisite is removed. Complete the following
steps:

1. In the fixpack or patch directory that was created when you untarred or
unzipped the binary, locate the template.dsc file.

2. Create a backup of the template.dsc file.
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3. Edit the template.dsc file with a text editor and remove the following lines. X
in the xml below is a number based on the modification level for this fixpack
or patch.
<Prereg>

<PrereqProdCode>UI</PrereqProdCode>

<PrereqVersion>
<Version>06</Version>
<Release>10</Release>
<Mod>0X</Mod>
<Level>000</Level>

</PreregVersion>

</Prereg>

The agent installation log on the endpoint indicates that error
AMXUT7502E occurred

The error AMXUT7512E might occur when running the Distributed Monitoring
Upgrade Toolkit. The agent was not installed for one of the following reasons:

* There is another installation in progress that cannot complete until the computer
is restarted.

—OR-
* You are attempting to install a component that is already installed.

Refer to the Tcfd.log on the endpoint and the agent installation log as listed in
to determine the exact cause of the problem.

Table 8. Icfd log file
Windows UNIX-based systems

install_dir/Install/Abort IBM Tivoli Monitoring install_dir/logs/candle_installation.log
timeStamp.log

Contact IBM Software Support if you cannot install the agent.

Failure occurs when sharing directories for the agent deploy
depot

Although it is more efficient to use a network shared directory for the agent
deploy depot directory, there are weaknesses that might negatively impact
deployment in large enterprises:

 If an NFS is used to contain the depot and there is a problem with the NFS, then
the deployment activity is suspended for all deployments in progress.

e For UNIX environments, the directories that are mentioned on the shared
directory must have the names of each of the Tivoli Enterprise Monitoring
Server servers.

* Administrator privileges need to be assigned based on a domain User ID. This is
impractical and is contrary to the desired effect of sharing.

Difficulty with default port numbers

You can use Telnet to test if the port is open in the firewall. Use the following
command for this test:

telnet hostname 15001

where 15001 is the port number in question.
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Selecting Security Validation User displays a blank popup

While configuring the Tivoli Enterprise Monitoring Server you have an option to
select the Security Validation User. When selecting this option a blank popup is
displayed. The Security Validation is working despite a blank popup with this
label that has a yellow triangle and exclamation point:

TEMS User Authentication actions are needed!

OS Agent does not install and a message indicates it was
already installed

The file status.properties, located in $DBDIR/AMX/data/ is not deleted when you
uninstall the Upgrade Toolkit. The Upgrade Toolkit refers to the old
status.properties file that contains information indicating there the OS Agent was
installed. You might experience this problem if you do the following in the order
listed:

1. Upgrade an endpoint.

Uninstall the Upgrade Toolkit.

Clean the endpoint manually.

Reinstall the Upgrade Toolkit.

. Attempt to upgrade the endpoint you previously upgrade in

o s~ DN

use the following steps to verify that information in the status.properties file is
causing this problem:

1. Open the status.properties,

2. Look for an entry like the following example:

#Copyright IBM Corporation 2005 #Wed Sep 14 15:54:43 CDT 2005 @Endpoint\:
\:east@EndpointClass\:TMF_Endpoint\:\:Endpoint=COMPLETE @Monitor\:Coast\
:120401@Threshold\:critical=COMPLETE

In this example, the status of the endpoint "east” is COMPLETE, which
indicates that it was upgraded successfully. The witmupgrade command does
not upgrade any item with the COMPLETE status and reports that it was
already upgraded.

To upgrade the endpoint, the status for the endpoint "east” must be the
INCOMPLETE, such as in the following example:

BEndpoint\:\:east@EndpointClass\:TMF_Endpoint\:\:Endpoint=INCOMPLETE

The only way to change the endpoint status in the status.properties file to
INCOMPLETE is to perform a rollback on the upgrade of the item. See the IBM
Tivoli Monitoring: Upgrading from Tivoli Distributed Monitoring.

Rolling back the upgrade

You can use the rollback option (-r option) of the witmupgrade command to
remove the new IBM Tivoli Monitoring resources that you created. This is a
necessary step if you want to repeat the test scenario. Rolling back the upgrade for
the test scenario removes the Windows OS monitoring agent from the Windows
endpoint and also removes the new situations and managed system list.

Follow these steps to roll back the upgrade:

1. Change to the $DBDIR/AMX/shared /analyze directory:
cd $DBDIR/AMX/shared/analyze

2. Type the following command to roll back the upgrade:
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witmupgrade -x profilemanagers/DM_TEST PM.xml -r -f scans/baseline.xml

where:

-x profilemanagers/DM_TEST_PM.xml
Specifies the name and location of the output file that resulted from the
assessment of the DM_TEST_PM profile manager.

T Indicates that the purpose of this command is to perform a rollback.

-f scans/baseline.xml
Specifies the name and location of the baseline file to use as input for
this command.

3. Restart the Windows endpoint.

The rollback option can also be used to roll back an endpoint upgrade or a profile
upgrade independently. By rolling back the profile manager upgrade, you roll back
all upgrades (profile manager, profile, and endpoint) in one step.

"SQL1_OpenRequest status = 79" return code occurs during
when upgrading an agent

The return code SQL1_OpenRequest status = 79 occurs in the agent log when the
application support is added during an upgrade. This return code results from an
attempt to delete a table entry that does not exist in the table. When you add
application support for a V6.1 agent, the return code is expected behavior because
the agent application support data does not exist in the table.

An IBM Tivoli Monitoring 6.1 upgraded agent is not configured
to point to the same Tivoli Enterprise Monitoring Server as it
was before upgrading the agent

During upgrade of agents from OMEGAMON 350 to IBM Tivoli Monitoring 6.1,
the OMEGAMON 350 agent specific Tivoli Enterprise Monitoring Server
configuration data does not persist to the upgraded IBM Tivoli Monitoring 6.1
agent. The upgraded agents are configured to use the agent default settings. Do
the following to change the default settings configured for OMEGAMON 350:

1. Right-click an agent in the Manage Tivoli Enterprise Monitoring

2. Select Set defaults for all agents ...

Installation of OS agent on a Microsoft Windows Server 2003
fails with this error: "Unable to establish BSS1 environment,
can’t continue..”

This error is caused by the deletion of the gskit directory, whether intentionally or
by accident, without clearing the registry information. If gskit was previously
installed by another product and has a dependency on it, for example DB2® 9.1,
then let that product reinstall it, or if there are no other products that depend on
the version of that gskit, then you can clear the GSK7 entry in the registry that can
be found under "My Computer \HKEY_LOCAL_MACHINE\SOFTWARE\IBM\
GSK7". Then rerun the IBM Tivoli Monitoring installation to allow the gskit to be
reinstalled.

Note: Create a backup of the registry before editing it.
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After upgrading to IBM Tivoli Monitoring V6.1, the link to the
Queue Statistics workspace in the navigation tree is incorrect

The link to the Queue Statistics workspace in the navigation tree opens the Open
Queue Handles workspace instead of the Queue Statistics workspace. Use the
following steps to correct the link:

1. Open the Queue Statistics workspace from the navigation tree.

2. Ensure that Queue Statistics workspace opened instead of the Open Queue
Handles workspace.

3. From the Tivoli Enterprise Portal select Edit > Properties.
4. Place a check in the Assign as default for this Navigator Item box.

Some rows do not display in an upgraded table

You might not see all tables after upgrading the Warehouse Proxy to IBM Tivoli
Monitoring V6.1 because some tables might be corrupted. Do the following to find
the errors that occurred during the upgrade:

1. Edit the KHDRAS1 Mig Detail.log file.
2. Search for the word EXCEPTION.

The KHD_MAX_ROWS_SKIPPED_PER_TABLE environment variable allows you
to skip bad data. KHD_MAX_ROWS_SKIPPED_PER_TABLE indicates the number
of rows per table to skip to migrate if the data that needs to be inserted is
incorrect. When this number is reached, migration of the table is aborted.

Tivoli Enterprise Monitoring Server and Tivoli Enterprise
Portal Server automatically start after running Application
Support Installer

After running the Application Support Installer the Tivoli Enterprise Monitoring
Server and Tivoli Enterprise Portal automatically start, even if they were not
running before the install. The behavior is harmless and there is no workaround
currently.

Errors occur during installation of Event IBM Tivoli Monitoring
Event Forwarding tool

The product functions normally in spite of the error. Check the installation log for
more details.

One or more errors occured during the replacement of files (tecSyncAll1Filel)
with files (tecSyncAl1Filel).

Refer to install log for more details.

One or more errors occured during the replacement of files (tecSyncAll1File2)
with files (tecSyncAl1File)l.

Refer to install log for more details.

One or more errors occured during the replacement of files (tecSyncAll1File3)
with files (tecSyncAl1Filel).

Refer to install log for more details.
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Windows installation problems and resolutions

Problems that are cleared by rebooting the Windows system

There are a set of problems that are cleared by rebooting the Windows system that
has been installed or upgraded:

* Situations do not fire after upgrade

* Remote update of a Windows box fails because of a pending rename that
requires a reboot

Note: In this case, a 'RC_INFO: Pending rename operations found, must reboot
before install can continue' message is found in the Abort IBM Tivoli
Monitoring for Databases.log file.

After upgrading IBM Tivoli Monitoring for Databases v6.1: DB2
Agent to IBM Tivoli Monitoring v6.2, the agent can no longer
be started

The log file reported problems with the libkra.a file, saying that an aix513 version
could not be loaded because it has an incorrect number.

If you configured the IBM Tivoli Monitoring for Databases v6.1: DB2 Agent with
the -o instance option then you need to reconfigure the agent after upgrading to
IBM Tivoli Monitoring v6.2. You can check the $CANDLEHOME/ config/
.ConfigData/kudenv file for entries that start with the instance name, such as:

db2inst1|ARCHITECTURE |tmaitm6/aix513

After an upgrade, the Tivoli Enterprise Portal Server is in the
‘stop pending’ state and cannot be manually started

After the upgrade, the Tivoli Enterprise Portal Server was in the ‘stop pending’
state. Attempts to manually start the Tivoli Enterprise Portal Server failed. End the
kfwservices process from the Windows task manager and then attempt the manual
start. Your Tivoli Enterprise Portal Server can then be started and stopped.

This behavior can happen if a program that locks files is running in the
background, such as Norton Antivirus.

When running the setup.exe, an unknown publisher error
message displays
If you run the setup.exe from a network drive on Windows, a window displays
with the following message:

File Download - Security Warning
The Publisher could not be verified.
Are you sure you want to run this software?

Selecting Cancel closes the window and the installation cannot complete. To install
the software without this problem, map the network drive and run the setup.exe
file from a DOS prompt.

The error "Could not open DNS registry key” occurs

This message is informational an no action is required. The Windows agent reports
the fact that it could not find a registry entry for the DNS Server Event Log,
indicating that the DNS Server Event Log is not installed. You can stop all
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situations and recycle the Tivoli Enterprise Monitoring Server with no situations in
ACTIVATE AT STARTUP to prevent this message being written to the trace log.

Agent not connecting to Tivoli Enterprise Monitoring Server

If you find a message similar to "Unable to find running TEMS on CT_CMSLIST”
in the Log file, the Agent is not connecting to the Tivoli Enterprise Monitoring
Server. Confirm the following to ensure connectivity:

* Multiple network interface cards (NICs) exist on the system.
* If multiple NICs exist on the system, determine which one is configured for the

monitoring server. Ensure that you specify the correct hostname and port for
communication in the IBM Tivoli Monitoring environment.

InstallShield displays the error "1607: Unable to install
InstallShield Scripting Runtime” during installation on
Windows from a network-mounted drive

When running setup.exe on Windows from a network mounted drive, the
following error occurs:

InstallShield: 1607: Unable to install InstallShield Scripting Runtime.

This is an InstallShield limitation. You cannot install the product from the specified
network drive. Try installing from another network drive. Install the product from
a local drive if you continue to receive the error.

Installation on a Windows 2003 server fails with Error Number:
0x80040707

The following error can occur while installing IBM Tivoli Monitoring V6.1 on a
Windows 2003 Server:

This error can occur for the following reasons:
1. Windows Service Pack 1 (or higher) is not installed.
2. Windows Installer 3.1 (KB893803) is not installed.

KB893803 is included in SP1. You must install Windows Service Pack 1 or higher
or the KB893803 individual update. You can download the update from
www.windowsupdate.com.

Unzipping nils_replace script causes remote deploy to fail

The tool used to unzip the file might have an option to automatically convert
CRLF for text files. If users unzip the UNIX or Linux installation media tar files on
Windows and this option is enabled, the files are modified and become
incompatible on some platforms. The CR/LF conversion must be disabled or
another tool used to extract the files that does not convert the text files.

Upgrade tool deploys agent to the wrong directory

The baseline XML file used for Tivoli Distributed Monitoring upgrade contains
attributes that specify an installation directory for OS monitoring agents on Tivoli
endpoints. When an endpoint is upgraded, the Upgrade tool normally deploys the
OS monitoring agent to the specified directory on the endpoint. However, if the
CANDLE_HOME environment variable is already set on a Windows endpoint, the
Upgrade tool deploys the monitoring agent to the directory specified by the
environment variable, even if a different directory is specified in the baseline file.
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The CANDLE_HOME environment variable is already set if any IBM Tivoli
Monitoring V6.1 component is already installed on the endpoint.

Deploying an agent instance without providing any
configuration properties causes KUICARO20E error

The problem occurs after you have already successfully deployed a multi-instance
agent (such as a database agent) to a node, and then tried to deploy another
instance without providing any configuration properties (which is an error). You
see this error message:

KUICARO20E: The addSystem command did not complete because a deployment error
occurred.

Refer to the following error returned from the server:

The monitoring server encountered an error while deploying the managed system.
The kuirasl.log file may provide more information about this error.

If you require further assistance resolving the error, contact IBM Software
Support.

The agent received incorrect SQL.

The CONTEXT column was not specified and is a required parameter.

A correct message would tell you that required configuration properties were not
provided when using the -p | --property | --properties command line option. When
you have provided the required configuration properties using the

-p | --property | --properties command line option, the agent instance is properly
deployed.

Problems installing directly from the .zip file

Instead of installing directly from the .zip file, extract the files from the .zip, and
then install from the setup.exe file.

Installation hangs or loops after presenting initial splash

When installing IBM Tivoli Monitoring or IBM Tivoli Monitoring agents on
Windows systems, IBM Tivoli Monitoring installation should present a pop-up
requesting reboot if files are locked. However, there are times when the IBM Tivoli
Monitoring installation does not inform you of locked files. This can cause the IBM
Tivoli Monitoring installation to loop or hang. If you experience a delay longer
than fifteen minutes during an IBM Tivoli Monitoring Windows installation, cancel
the IBM Tivoli Monitoring install processes and reboot the system.

UNIX-based system installation problems and resolutions
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This chapter describes known problems related to installation and uninstallation
that might occur with IBM Tivoli Monitoring.

Failed to attach to the DB2 instance db2inst1 ERROR: Unable
to create TEPS, return code = 3

While installing a Tivoli Enterprise Portal Server on a UNIX based system and
using a DB2 database, the following error message is displayed (where db2inst1 is
the supplied name of the DB2 instance):

Failed to attach to the DB2 instance db2instl
ERROR: Unable to create TEPS, return code = 3

Ensure that the DB2 instance is started by running the db2start command as the
instance user:
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$ su - db2instl
$ db2start

Installation on SLES9 terminates with install.sh
failure:KCI1008E terminating... license declined

On systems when LAP cannot run and Java does not function, a bad return code is
returned to install.sh. The problem can be manually recreated by running the JAVA
command used to launch LAP or simply by running Java —version from the jre
under CANDLEHOME. Indications show that the system might be missing an OS
patch required for the level of Java or possibly an incorrect version of Java has
been packaged and installed on the system.

Command line interface program of the Application Support
Installer is not currently available

The command line interface program of the Application Support Installer is not
currently available, thus you cannot run the install in command line mode.
However, you can run the install in silent mode instead. If your UNIX® or Linux
computer does not have X-Windows set up, you must use the silent installation
method.

®

Uninstallation is not available for Application Support on
Windows systems

Currently, there is not a workaround.

Silent install on UNIX-based systems of Tivoli Enterprise
Monitoring Server returns an encryption key setting error

The following errors occurs if you attempt a silent install on UNIX-based systems
or UNIX-based systems and the encryption key is not exactly 32 characters.

Exception in thread "main" candle.kjr.util.CryptoFailedException:
CRYERR_INVALID_KEY_LENGTH

at candle.kjr.util.CRYPTO.validateKeyLength(CRYPTO.java:911)

at candle.kjr.util.CRYPTO.setKey(CRYPTO.java:452)

at ITMinstall.gskSetkey.<init>(gskSetkey.java:179)

at ITMinstall.gskSetkey.main(gskSetkey.java:26)

Set the encryption key parameter in the silent install file to exactly 32 characters as
in the following example:

INSTALL_ENCRYPTION_KEY=IBMTivoliOMEGAMONEncrytionKey61

The error "Unexpected Signal: 4 occurred at PC=0xFEC3FDE4"
occurs during installation

A Java VM heap dump occurs during installation, which uses the JRE. Use the
following steps to resolve the problem:

1. In a terminal window, run the following command to display the Java
command:

java -version

2. Determine where the Java executable is located by running:
which java

3. Rename or uninstall the Java executable.

Note: This effects any other applications which depend on Java. Be sure that it
is safe to do so. If unsure just rename the Java executable.
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4. Run the following command again to ensure that the java executable is not
found in the path:

which java
5. Install the product.

Installing IBM Tivoli Monitoring on Red Hat 5 and see the
following error: "KCI1235E terminating ... problem with
starting Java Virtual Machine”

If you try to install IBM Tivoli Monitoring on Red Hat 5 with SELinux set to
"permissive” or "disabled” mode ("enforced” mode is not supported by IBM Tivoli
Monitoring) directly after rebooting the system, and you see the following error:
"KCI1235E terminating ... problem with starting Java Virtual Machine" at the
beginning of the installation before the license is displayed, try executing the
prelink -a command to resolve the issue.

Installation of the IBM Tivoli Monitoring on the Linux S390
R2.6 64-bit operating system fails with the message "LINUX
MONITORING AGENT V610Rnnn unable to install agent” where
nnn is the release number
Perform the following steps to resolve this problem before running the installation
again:
1. Run the following command before running any installation or configuration
command for the agent:
export JAVA_COMPILER=NONE

2. Install the s390x.rpm RPM (Red Hat Package Manager) files, in addition to the
s90.rpm files, located in the CD ISO images for Red Hat As 4.0 s390x:

* compat-libstdc++-295-2......s390x.rpm
¢ compat-libstdc++-33-3.......s390x.rpm

It requires the two s390x.rpm files, in addition to the s390.rpm files. You can
obtain the required RPM files from the CD for Red Hat As 4.0 s390x.

The UNIX OS agent (ux) version 350 does not start on AIX 5.3
after upgrading other agents to version 6.1.0
Do one of the following to enable UNIX OS agent (ux) version 350:
* Upgrade the UNIX OS agent to version 6.1.0.
—OR-
* Add the following line to the uxaix513.ver file in the 5CANDLEHOME//registry:
runArch = aix533

Note: Create a backup of the registry before editing it.

Troubleshooting z/0S-based installations

This section describes some problems you might experience with z/OS-based
installations, including problems you can resolve with the Installation and
Configuration Assistance Tool (ICAT). It includes the following sections:

“IBM Tivoli Monitoring z/OS initialization checklist” on page 45|

« |“z/0S-based installations problems and resolutions” on page 52|
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IBM Tivoli Monitoring z/OS initialization checklist

Use the IBM Tivoli Monitoring z/OS initialization checklist to troubleshoot
problems with your IBM Tivoli Monitoring installation on z/OS. The IBM Tivoli
Monitoring z/OS initialization checklist includes the following sections:

« |[“Tivoli Monitoring Services Engine initialization” on page 45|

* |“RASI service initialization” on page 45|

« [“TCP/IP service initialization” on page 46|

+ [“SNA service initialization” on page 48|

* |“The Server list” on page 49|

* [“Local Location Broker service initialization” on page 50|

» |“Global Location Broker service initialization” on page 51|

» |“Tivoli Enterprise Monitoring Server hub availability” on page 52|

Tivoli Monitoring Services Engine initialization

Tivoli Monitoring Services Engine is a collection of basic Operating System and
Communication service routines built specifically for the OS/390® and z/0OS
Operating environments. All IBM Tivoli Monitoring address spaces load and
employ the services of Tivoli Monitoring Services Engine.

Initializing the Tivoli Monitoring Services Engine service: Tivoli Monitoring
Services Engine successful initialization is noted by message KLVIN408 IBM
OMEGAMON PLATFORM ENGINE VERSION 400 READY. There are two classes
of Tivoli Monitoring Services Engine initialization failures:

* Failures that result from unsupported Tivoli Monitoring Services Engine startup
parameters. For example: User abend U0012

* Failures that result from protocol initialization failures. For example: User abend
U6200

Repairing Tivoli Monitoring Services Engine initialization failures: For U0012
Abends, incorrect Engine STARTUP parameters, examine and correct the
parameters pointed to by the RKLVIN DD statement of the started task JCL. Most
often, U0012 Abend failures can be resolved by backing out the last change made
to the Tivoli Monitoring Services Engine startup parameters. For U0200 Abends,
the root cause of the protocol failures must be remedied. These failures are covered
in ["'TCP/IP service initialization” on page 46{and|SNA service initialization” on|

|Eage 4§l

RAS1 service initialization
The Reliability, Availability and Servicability (RAS1) service refers to the RAS1
building block (Basic Services component) used for diagnostic tracing. Nearly all
diagnostic information for IBM Tivoli Monitoring is delivered via the RAS1 (trace)
component. This component is configured in member KBBENV of RKANPAR
using the KBB_RASI environment variable. Often, customers redirect the
initialization member via CT/Engine INITLIST processing. INITLIST processing is
always echoed to the RKLVLOG with the KLVIN411 message. The following shows
an example of a typical KBBENV override to KDSENV
KLVIN4A1O INITLIST MEMBER KDSINIT BEING PROCESSED

KLVIN411 KLVINNAM=KDSINNAM

KLVIN411 KLVINTB=KDSINTB

KLVIN411 KLVINVLG=KDSINVLG
KLVIN411 KLVINNAF=KDSINNAF
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KLVIN411 KLVINVPO=KDSINVPO
KLVIN411 KLVINSTG=KDSINSTG
KLVIN411 KLVINVAM=KDSINVAM
KLVIN411 KBBENV=KDSENV

In this instance, configuration of KBB_RAS1 must display in member KDSENV of
RKANPAR.

TCP/IP service initialization

TCP/IP service is Transmission Control Protocol. TCP/IP provides end-to-end
connectivity for application-layer codes such as telnet, FTP, and the IBM Tivoli
Monitoring Server, Tivoli Enterprise Portal Server, and the Tivoli Enterprise
Monitoring agents.

Initializing the TCP/IP service: TCP/IP services for this address space are
available if any of the following messages are present:
"KDE1I OpenTransportProvider") Transport opened: socket/ip.tcp

"KDEL1I_OpenTransportProvider") Transport opened: socket/ip.pipe
"KDE1I_OpenTransportProvider") Transport opened: socket/ip.udp

These messages are only displayed when KDC_DEBUG=Y is active in the
environment; KDC_DEBUG=Y must be added to member KDSENV of RKANPAR
(or the appropriate initialization member) to obtain the level of tracing required to
have these messages echoed to the RASI log. IF KDC_DEBUGS=Y is set and if none
of these messages are in the log, then initialization of the TCP/IP service failed.

Repairing TCP/IP service initialization failures: Use the following steps to
ensure the TCP/IP transport service is available:

Note: Failure at any of the following prevents the TCP/IP service from initializing
in the address space.

1. Ensure the INITAPI service is successful. See[“The INITAPI call” on page 46|
2. Ensure the Name Resolution is successful. See ["Name Resolution” on page 47|
3. Ensure the first SEND ran without error. See [“The First SEND” on page 48|

The INITAPI call

IBM’s implementation of TCP/IP requires that an address space perform an
INITAPI before issuing an TCP/IP service request. The INITAPI establishes a
communication pipe between the TCP/IP and the OMEGAMON Platform address
space. The INITAPI identifies the TCP/IP stack to be used by name. The TCP/IP
stack name used in the INITAPI is configured in the KLXINTCP member of
RKANPAR. This step must complete successfully. An INITAPI failure is fatal: no
TCP/IP services are available to the address space.

Confirming that the INITAPI call was successful: The following messages
indicate a successful INITAPI:

KLXINOOL1 HPNS INTERFACE AVAILABLE
KLXINOO1 SOCKET INTERFACE TO TCPIPL AVAILABLE

Repairing the INITAPI call failures: Most of INITAPI failures are the result of
the wrong name specified in KLXINTCP. The following is a classic example of an
INITAPI failure:

KLVIN4O5 STARTUP MODULE: KLXINTCP, SEQUENCE(1), USING RKANPAR MEMBER KLXINTCP
KLXINOOL TCP/IP CONFIGURATION: TCP/IP_USERID=TCPIPG

KLXINOO3 TCP/IP INTERFACE INITIALIZED

KLXINOO9 SOCKET INTERFACE TO TCPIPG UNAVAILABLE: RC(FFFFFFFF) ERRNO(000003F3)
KLXINOO4 TCP/IP INTERFACE NOT OPENED: RC(4)
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Notice that the INITAPI failure is characterized by a return code of (-1) and an
ERRNO value, in this case X’3F3” or decimal 1011. ERRNO-s have names. These
names are found in TCPERRNO.H and decimal 1011 is EIBMBADTCPNAME. The
most common INTIAPI ERRNOs are EMVSINITIAL (156),
EIBMBADTCPNAME(1011), and no-name(10218).

Reasons for INITAPI failures include:

* The name specified in KLXINTCP is wrong. TCP/IP_USERID is selected based
on the specification for TCPIPJOBNAME found in the file pointed to by
SYSTCPD in the TCP/IP started task JCL. The default (if no TCPIPJOBNAME
exists) is TCPIP. There exists field documentation on the RACF® procedure.
These two items should be checked first.

* The started task name does not have RACF authority for the OMVS segment.
All address spaces must be given RACF (or ACF2) permission for the OMVS
segment to use TCP/IP services. Failure to grant this permission (which is
granted to the started task name) can result in INITAPI failures.

* MAXPROCUSER has been exceeded. For MAXPROCUSER problems, you can
use console operator command SETOMVS MAXPROCUSER=xxx to increase the
current MAXPROCUSER value (as seen by D OMVS,0).

Name Resolution

IBM Tivoli Monitoring V6.1 depends on IBM’s HPNS EZASMI getaddrinfo and
EZASMI getnameinfo calls for resolver services. These calls are used to find the
symbolic name and dotted-decimal IP address of the default network interface for
the z/OS image. A failure in either EZASMI call results in failure to initialize the
TCP/IP service for the z/OS address space.

Confirming that the Name Resolution calls are successful: The following
message indicates Name Resolution was successful:

kdebprc.c,661,"interface_discovery") IPV4 interface list: 'SYSL'
9.42.46.26: source=hostname:0, seq=0, flags=0441

In this example, the interface ‘SYSL’ is found and source=hostname indicates that
the hostname SYSL was successfully resolved to an IP address.

Repairing the Name Resolution failures: The following messages illustrate a
Name Resolution failure:
kdebprc.c,661,"interface_discovery") IPV4 interface Tist: 'WINMVS2C'

9.20.138.199: source=GEl, seq=0, flags=0441
kdebprc.c,214,"register_string") Unable to resolve interface address: WINMVS2C

In the messages above, the absence of source=hostname indicates an interface was
discovered but the name is not resolvable to an address. Typically, this error results
when the z/OS image does not contain a TCP/IP resolver setup file that provides
either GLOBAL or DEFAULT configuration data. Consequently, native z/OS
address spaces are not enabled for name resolution by default. By adding a DD
statement for SYSTCPD to the started task JCL of the IBM Tivoli Monitoring task
(pointing to a usable file in USER.PARMLIB(TCPDATA)), resolver support can be
enabled.

The following messages illustrate a variant of name resolution failure:

kdebprc.c,661,"interface_discovery") IPV6 interface list: 'NULL'
"KDE1I OpenTransportProvider") Status 1DEQO048=KDE1 STC NOINTERFACESREGISTERED
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The messages above indicate that no (IPV6) interface is registered. This can also
result in TCP/IP service initialization failure for the IBM Tivoli Monitoring address
space. The absence of an interface can only be fixed by the z/OS TCP/IP
administrator.

The First SEND

This section provides information about confirming whether or not First SEND
was successful as well as how to repair failures in the First SEND.

Confirming that he First SEND was successful: The sequence of the following
communication messages indicate the first SEND operation (an Ib__lookup RPC
request) and the first RECEIVE operation:

"KDCRO_Send") request FFFF/0.0 (200): ip.pipe:#9.42.46.26[1918]

"KDCRO_InboundPacket") response FFFE/0.0 (320): ip.pipe:#9.42.46.26[1918]
"KDCL_GetBinding") Using LLB at ip.pipe:#9.42.46.26[1918]

When the first network 1/0O is successful, the response indicates link and transport
connectivity with the hub computer.

Repairing the failures in the First SEND: There are two consideration specific to
0S/390 and z/0OS platforms:

* RACF permission to the started task for the OMVS segment
* Presence of the well known port on the TCP/IP Port List.

The RACF permission problem might not be detected until the failure of the first
network I/0O. The "KDCRO_Send” request fails with Errno 2: EACCESS. This
failure can occur with the first use of the started task name.

A similar problem results in EACCESS: the well-known port is defined on the
TCP/IP port list. ISPF Option 6, "netstat portlist” confirms the presence of the
well-known port in the TCP/IP reserved port list. The well-known port should not
be on this list.

SNA service initialization

IBM Tivoli Monitoring Address Spaces can configure be configured to use SNA
exclusively, or in conjunction with TCP/IP, as a transport service. This
configuration is done in the environment member (xxxENV) of RKANPAR. If SNA
services are viewed as optional, then removal of KDCFC_ALIAS, KDCFC_MODE,
and KDCFC_TPNAME from the xxxENV member of RKANPAR will effectively
disable use of SNA.

Initializing the SNA: The following messages are printed in the RAS1/
RKLVLOG when the local SNA configuration is processed from the XXXENV
member of RKANPAR:
kbbssge.c,52,"BSS1_GetEnv") KDCFP_ALIAS=KDCFC_ALIAS=KLXBS_ALIAS="ASIAGLB"
kbbssge.c,52,"BSS1_GetEnv") KDCFP_TPNAME=KDCFC_TPNAME=KLXBS_TPNAME="SNASOCKETS"
kbbssge.c,52,"BSS1_GetEnv") KDCFP_MODE=KDCFC_MODE=KLXBS_MODE="CANCTDCS"
kdeslrp.c,140,"getEnv") AF_SNA configuration: Alias(ASIAGLB) Mode(CANCTDCS)
TpName (SNASOCKETS)

KDCFC_ALIAS identifies the APPL definition of the Independent Logical Unit to
be used in this process. KDCFC_MODE identifies the LOGMODE name, the same
name found in the LOGMODE specification of the KDCFC_Alias APPL definition.
KDCFC_TPNAME is the Transaction Processing Name. The message which
indicates the LOCALLU is operational (the configuration is good) is the "transport
opened” message:

kdelotp.c,118,"KDE1I OpenTransportProvider") Transport opened: coml/sna.pipe
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Repairing SNA initialization failures: There following lists the reasons for SNA
initialization failures:

¢ The ILU configured for use is not available to the application. The ACBNAME
(or APPLNAME) is properly defined in SYS1.VTAMLST but not in the
connectable state (CONCT). The ACB must be varied ACTIVE to NET prior to
Omegamon Platform Address Space startup. The MVS™ command to verify the
state of the ACB is "D NET, ID=acbname,E" .

e The ILU is available but not a valid LU6.2 definition. In this case, the is a
KBBCMO001 message with an SNA sense code found in the RAS1/RKLVLOG.
Diagnose the 8-byte SNA sense code (typically, 087Dnnnn) using the "SNA
Formats and Protocol” manual.

e The LOGMODE is not a valid LU6.2 LOGMODE, or the LOGMODE and
MODETAB specification associated with the ILU definition are not the same, by
name, on both systems hosting the endpoints. This is most likely the case for
SNA session establishment hangs. The message in the RKLVLOG is "Receive
XID pending: NULL", and it is followed by another RPC timeout message.

The Server list

IBM Tivoli Monitoring processes build and query a list of possible Tivoli Enterprise
Monitoring Server hub addresses, called the Server list. This server list contains
local (LLB) and global (GLB) entries. The LLB entries of the Server list are derived.
The GLB entries of the Server list are built from the content of the KDCSSITE
member of RKANPAR. Shown below are two server lists. The first Server List is
for a Tivoli Enterprise Monitoring Server hub, the second Server List is for a
remote Tivoli Enterprise Monitoring Server. See the following example:

(Server list for a HUB CMS)

LLB entry 1 is ip:#10.248.16.1.1918.

LLB entry 2 is sna:#ATOOENO1.K10DSLB.CANCTDCS.SNASOCKETS.135.

GLB entry 1 is ip:#10.248.16.1.1918.

GLB entry 2 is sna:#ATOOENO1.K10DSLB.CANCTDCS.SNASOCKETS.135.

GLB entry 3 is ip:#10.248.16.1.1918.

GLB entry 4 is sna:#ATOOENO1.K10DSLB.CANCTDCS.SNASOCKETS.135.

(Server Tist for a REMOTE CMS)
LLB entry 1 is ip:#10.248.17.2.1918.

LLB entry 2 is sna:#ATOOENO1.K20DSLB.CANCTDCS.SNASOCKETS.135.
GLB entry 1 is ip:#10.248.16.1.1918.
GLB entry 2 is sna:#ATOOENO1.K10DSDS.CANCTDCS.SNASOCKETS.135.
GLB entry 3 is ip:#10.248.17.2.1918.
GLB entry 4 is sna:#ATOOENO1.K20DSLB.CANCTDCS.SNASOCKETS.135.

Confirming the Server list is correct: In general, the first half of the GLB server
list always points to the Tivoli Enterprise Monitoring Server hub. The first half of
the GLB entries in the Server list are taken from member KDCSSITE of RKANPAR.
If the LLB entries are derived (implicitly) and the GLB entries are explicitly
configured in the KDCSSITE member, you can diagnose and repair the errors in
KDCSSITE.

e The number of LLB entries must be half the number of GLB entries. If this is not
the case, then there might be a mismatch between the number of transports
services configured to this Tivoli Enterprise Monitoring Server (the
KDC_FAMILIES environment variable) versus the number of transports
configured for the hub Tivoli Enterprise Monitoring Server (KDCSSITE).

* For a hub Tivoli Enterprise Monitoring Server, each LLB entry must be identical
to the corresponding GLB entry in the Server list. As in the Server list for a hub
Tivoli Enterprise Monitoring Server example, LLB entry 1 is the same as GLB
entry 1 and LLB entry 2 is the same as GLB entry 2.
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* For a remote Tivoli Enterprise Monitoring Server, the opposite is true: each LLB
entry must be different than the corresponding GLB entry in the Server list. As
in the example (Server list for a REMOTE Tivoli Enterprise Monitoring Server),
LLB entry 1 is different than GLB entry 1, LLB entry 2 is different than GLB
entry 2.

Repairing errors in the Server list: Errors in SNA initialization might be name
mismatches. Examine the LLB entries and the GLB entries for the Omegamon
Platform address space for typographical errors. The VTAM® network ID is victim
of frequent error. Typically the VTAM network ID (the first component of the SNA
socket address, ATOOENO1 in the example above) is the same for ALL entries.
While it CAN differ, typically, it does not. A difference between the LLB VTAM net
ID and the GLB VTAM net ID is often an error in member KDCSSITE of
RKANPAR.

Local Location Broker service initialization

An intrinsic part of Remote Procedure Call architecture is the location broker. RPC
servers (callers of rpc__listen) publish their service and the address of this service
in a location broker. RPC clients (callers of rpc__sar) use the location broker to
obtain the address of a server prior to making a call to that server. Use of the
location broker is well-defined by the 1b__lookup() Remote Procedure Call. It is
also appropriate to mention that there are two types of location brokers: the local
location broker (LLB) and the global location broker (GLB). There is one local
location broker for every RPC server (The Tivoli Enterprise Monitoring Server has
it's own LLB. The monitoring agent, the Warehouse Proxy agent, and the Tivoli
Enterprise Portal Server all have their own instance of a LLB.) RPC servers, by
definition, publish the service offered and address of this service in their local
location broker.

Confirming the Local Location Broker service initialized: The bind messages in
the RKLVLOG indicate the success or failure of the LLB service initialization. One
of two message IDs prefix the LLB status messages, depending on how the LLB
service was started. KDSNCO007 is the message prefix issued on successful LLB
process initialization when the LLB is started internally by the Tivoli Enterprise
Monitoring Server.

KDSNCO04 Bind of local location broker complete= ip.pipe:#9.42.46.26.21343.

KDSNC004 Bind of Tocal location broker complete= ip:#9.42.46.26.21343.

KDSNCO04 Bind of local location broker complete= sna:

(USCAC001.VWCTHLB.CANCTDCS.SNASOCKETS) .135.
KDSNCOO7 Local Location Broker is active

Repairing errors in Local Location Broker service initialization: Bind failures
due to insufficient authorization are reported with Errno. 2 (EACCESS)o the Local
Location Broker (as the name LOCAL implies) is done with a local socket address.
The bind fails for the following reasons:

e Insufficient authorization
¢ The address is unavailable

(32645848-E8E45647 : kdebnws.c, 64, "KDEB_NewSocket")
Status 1DE0OOOO=KDE1_STC CANTBIND.
(3265B3F0-EBE45647 : kdebnws .c,84,"KDEB_NewSocket")
<0x176A97D4,0x10> BSD bind details:
Family 2, Socket 0, Status 1DEQ000O, Errno 2.
00000000 00022EE1 00000000 00000000 00000000  ....ovvvveeennenn.
(326B1EA8-EBE45647 :kdcsuse.c,98,"KDCS_UseFamily") status=1c010005,
"cant bind socket",
ncs/KDC1_STC_CANT_BIND
2001.252 04:42:41 KDCOOOO8 Unable to create Tocation server, status 1C010005
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Bind failures due to address-in-use:

(3ACDB600-DEB3B73F:kdebnws.c,62,"KDEB_NewSocket") Status 1DE00030=KDE1 STC
ENDPOINTINUSE

(3ACF5028-DEB3B73F:kdcsuse.c,99,"KDCS_UseFamily") status=1c010005, "cant bind
socket", ncs/KDC1_STC_CANT_BIND

Bind failure due to address-in-use but not fatal:

(1CF7B1F8-E6D9ID743:kdcsuse.c,99,"KDCS_UseFamily") status=1c010005, "cant bind
socket", ncs/KDC1_STC_CANT_BIND
KDSNC0O7  Local Location Broker is active

If the bind failure is due to EADDRINUSE but the Broker service is started, the
error might not be fatal. Determine whether or not the bind of this IBM Tivoli
Monitoring address space was to the LLB in that address space. In some instances,
an address space can bind to the LLB of another address space. This can only
occur in the same system image. If the bind failure is fatal, then another process on
this system image has the ‘well-known’ port. Bind failures due to insufficient
authorization are fixed by granting RACF permission for the OMVS segment to the
Omegamon Platform started task name.

Global Location Broker service initialization

The Global Location Broker (GLB) differs from the Local Location Brokers in one
important respect other than the name: there is only one GLB for the domain or
enterprise. By definition, there will be only one Local Location Broker which points
to the Global Location Broker for the domain. The RPC server LLB which points to
the GLB (and there will be only one of these in an enterprise) is, by definition, the
hub. The important thing to remember from all this discussion of local and global
brokers is this: For a process to locate the Tivoli Enterprise Monitoring Server hub,
the process must query (issue Ib__lookup() RPC requests to) the list of candidate
Global Location Brokers in order as specified in the global site text file (glb_site.txt
on distributed platforms and the KDCSSITE member of RKANPAR for OS/390 and
z/0OS platforms). Below are the product communication messages which
enumerate the candidate GLB list (GLB entry 1, GLB entry 2, etc):

GLB entry 1 is ip.pipe:#9.42.46.26.21343.

GLB entry 2 is ip:#9.42.46.26.21343.

GLB entry 3 is sna:(USCACOO1.VWCTHLB.CANCTDCS.SNASOCKETS).135.
GLB entry 4 is ip.pipe:#9.42.46.26.21343.

GLB entry 5 is ip:#9.42.46.26.21343.

GLB entry 6 is sna:(USCACOO1.VWCTHLB.CANCTDCS.SNASOCKETS).135.

Connectivity between the Omegamon/XE and Tivoli Enterprise Monitoring Server
address space fails if this list is incorrect. The GLB entries display in the order in
which they are configured in the global site text file. Additionally, the address of
the local platform is appended to this list. This is an RPC architecture requirement.
It allows the local platform to be queried when the GLB list has been exhausted
and no hub is found.

Confirming the Global Location Broker service initialized: The bind messages in
the RKLVLOG indicate the success or failure of the GLB service initialization. A
message ID prefixes the GLB status messages and indicates how the GLB service
was started. KDSNCO008 is the message prefix issued on successful GLB process
initialization when the LLB is started internally by the Tivoli Enterprise Monitoring
Server.

Bind of global location broker complete= ip.pipe:#9.42.46.26.21343.

Bind of global Tocation broker complete= ip:#9.42.46.26.21343.

Bind of global location broker complete= sna:

(USCAC001.VWCTHLB.CANCTDCS.SNASOCKETS) .135.
Global Location Broker is active
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Repairing errors in Global Location Broker service initialization: GLB service
failures occur because there are errors in member KDCSSITE of RKANPAR. Each
socket address in KDCSSITE is assumed to be the socket address of the Tivoli
Enterprise Monitoring Server hub. If none of the entries in the KDCSSITE file are
the correct socket address of the Tivoli Enterprise Monitoring Server hub, this
process initialization fails.

Tivoli Enterprise Monitoring Server hub availability

The following message indicates the Tivoli Enterprise Monitoring Server hub is
available:

ko4lochr.cpp,731,"Mgr::1ocateEverbody") TbLookupHub returned error <0>,

ip<ip:#9.42.46.26.21343>
sna<> pipe <ip.pipe:#9.42.46.26.21343.>

Do the following if the Tivoli Enterprise Monitoring Server hub is not available:

* Review the RASI1 log for the Tivoli Enterprise Monitoring Server to ensure it is
connected.

* Review network topology to ensure Firewall policy does not prohibit connection
initiation from the Tivoli Enterprise Monitoring Server hub.

* Review "Transport opened” on the Tivoli Enterprise Monitoring Server to ensure
at least one transport service is common between it and this Tivoli Enterprise
Monitoring address space.

z/OS-based installations problems and resolutions

This section describes problems that might occur with a z/OS-based installation.

How do you customize the following Tivoli Enterprise Monitoring
Server configuration values using the Configuration tool?

You can increase the following storage-related parameters if IBM Software Support
personnel instructs you to do so:

* Web Services SOAP Server

* startup console messages

* communications trace

* storage detail logging and associated intervals

* minimum extended storage

* primary and extended maximum storage request size
* language locale

* persistent datastore parameters

Use the following steps to increase the storage-related parameters:

1. From the Configure the Tivoli Enterprise Monitoring Server main menu,
select the Specify configuration values option.

2. On the next panel, press F5=Advanced to open the Specify Advanced
Configuration Values panel. The next panel includes the following options:

* Enable OMEGAMON SOAP Server (applicable to a Hub Tivoli Enterprise
Monitoring Server only)

* Enable startup console messages

* Enable communications trace

* Enable storage detail logging and associated intervals
* Specify the Virtual IP Address (VIPA) type

* Specify the minimum extended storage
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* Specify the primary and extended maximum storage request size
* Specify the language locale for globalization
* Specify the persistent datastore parameters

3. Customize the fields with the preferred values in the Specify Advanced
Configuration Values.

4. Select the Create runtime members option to regenerate the "DS#3xxxx Create
runtime members” job from the Configure the Tivoli Enterprise Monitoring
Server main menu.

5. Submit the job and check for good condition codes.
6. Recycle the Tivoli Enterprise Monitoring Server.

’DATA SET NOT FOUND’ JCL error occurs when submitting the
DS#3xxxx Tivoli Enterprise Monitoring Server ’Create runtime
members’ job.

Ensure the following:

* The pp#lxxxx RTE Build job successfully ran for this RTE. To perform the RTE
Build job,
1. Place the B option next to the RTE on the KCIPRTE RTE main menu to
instruct Configuration tool generates the pp#1xxxx mRTE Build job.

2. Ensure that the RTE Build job contains allocations for the
&rvhilev.&rte. RKDS* and &rvhilev.&rte. RK* runtime libraries.

3. Submit the RTE Build job.

* The Tivoli Enterprise Monitoring Server in this RTE field is set to Y on the
RTE Update panel if the RTE Build job does not contain &rvhilev.&rte. RKDS*
libraries. If you must edit the field, regenerate the RTE Build job.

Refer to the IBM Tivoli Monitoring Installation and Setup Guide manual for more
information about configuring a z/OS Tivoli Enterprise Monitoring Server and the
RTE Build job.

The error ’CMSLIST NOT ALLOWED’ occurs on the ’Specify
Advanced Configuration Values’ panel when Tivoli Enterprise
Monitoring Server type equals hub.

The F10=CMSLIST key from the Specify Advanced Configuration Values panel is
only applicable to a remote Tivoli Enterprise Monitoring Server. This PF Key
allows the remote Tivoli Enterprise Monitoring Server to select a hub Tivoli
Enterprise Monitoring Server to which it can connect. The F10=CMSLIST function
key is unavailable to a hub Tivoli Enterprise Monitoring Server. Go to the previous
Specify Configuration Values panel to verify what type of Tivoli Enterprise
Monitoring Server you are configuring

The ’Enter required field’ error occurs for the ’Global location
broker applid of Hub’ or the 'Network ID of Hub’ VTAM-related
fields

On the Specify Configuration - Hub Values for Remote Tivoli Enterprise
Monitoring Server panel, the message "Enter required field” occurs although the
remote z/OS Tivoli Enterprise Monitoring Server connects to the Hub Tivoli
Enterprise Monitoring Server through IP protocols. If you are configuring a remote
z/0S-based Tivoli Enterprise Monitoring Server that connects to a non-z/OS Hub
Tivoli Enterprise Monitoring Server via the IP or IPPIPE communication protocol,
use the following steps as a resolution:

1. On the Specify Configuration - Hub Values for Remote Tivoli Enterprise
Monitoring Server panel, enter any value in the following fields:
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* Global location broker applid of Hub. For example, enter default
"CTDDSLB" if this VTAM APPLID is not used.

¢ Network ID of Hub. For example, enter the NETID value from
SYS1.VTAMLST(ATCSTRnn)).

Note: Neither of these values adversely affect the connection for the remote
Tivoli Enterprise Monitoring Server.

2. From the Configure the Tivoli Enterprise Monitoring Server main menu,
select the Specify communication protocols option.

3. On the Specify communication protocols panel, specify the IP protocols of
choice and ensure. Specify SNA.PIPE as one of the protocols that the remote
Tivoli Enterprise Monitoring Server uses for connection.

4. Navigate forward to specify the communication protocols values for the
selected protocols.

5. From the Configure the Tivoli Enterprise Monitoring Server main menu,
select the Create runtime members option to generate the DS#3xxxx Create
runtime members job.

6. Submit the job and check for good condition codes.

7. From the Configure the Tivoli Enterprise Monitoring Server main menu,
select the Complete the configuration option.

8. Review the remaining tasks to finish the configuration of the product before
starting the Tivoli Enterprise Monitoring Server.

The pp#Mxxxx Tivoli Enterprise Monitoring Server migration job
generated by the Configuration tool ended with a condition
code=08.

The JCL used to upgrade an existing RTE to IBM Tivoli Monitoring v6.1 level must
perform several steps to ensure the existing data is not lost nor corrupted. The
batch job stops processing data in the event of an error, such as insufficient DASD.
The batch job is not submitted a second time but three batch job are created that
can be used to restore the data to its original state. Therefore, the upgrade JCL can
be submitted to run and start from the beginning to allow for conditions that
initially caused the problem to be corrected. Based on what step was running
when the failure occurred, you might need to run one or more of the following
jobs in RKANSAM:

¢ KDSRSTRO

» KDSRSTRN

* KDSRSTRV

Use the following VSAM migration steps:

1. Run RNMEVSAM/ALLCVSAM step to:
* Rename the previous version’s VSAM file to a backup VSAM name.
 Allocate the new V610 VSAM file based on the new format.

Note: This step applies to VSAM files containing data that do not need to be
converted.

—-OR-Edit and submit KDSRSTRN to restore to files to the original state.
2. Run KDSRCONYV step to:

* Allocate the new V610 VSAM libraries using temporary XKDS* VSAM
names.

¢ REPRO the previous version VSAM file data (RKDS*) to flat file.
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* Convert the fields to ASCII and resize columns accordingly. REPRO the
converted flat file to the new XKDS* VSAM libraries.

* Write out the output from the conversion.
—OR-Edit and submit KDSRSTRV to restore a file to original state.

3. Run RNMEEIBO step to rename the previous version’s VSAM files (RKDS*) to
backup VSAM names (BKDS*) if the KDSRCONV step is successful.

—-OR-Edit and submit KDSRSTRO to restore file to original state.

4. Run RNMEEIBN step to rename the new V610 XKDS* VSAM libraries to the
runtime RKDS* VSAM names if the RNMEEIBO step is successful.

-OR-Edit and submit KDSRSTRN to restore to original state.

Note: By default the restore jobs runs against all of the processed datasets. The
comments section of these jobs detail that some of the datasets can be
commented out depending on the time and nature of the failure
experienced. For instance, only 4 of 7 datasets were renamed during
RNEVSAM, so only those 4 must be restored to their original names. If
you are not certain which job to run or what datasets to comment out in
these jobs, contact IBM Software Support.

The Tivoli Enterprise Monitoring Server starts normally in a
system without the Integrated Cryptographic Service Facility but
does not connect to the Tivoli Enterprise Portal Server

Although Integrated Cryptographic Service Facility (ICSF) provides robust
password encryption, you are not required to use it as it can affect compatibility
with the z/OS OMEGAMON monitoring products. Perform the following steps so
that the Tivoli Enterprise Portal Server can connect to the Tivoli Enterprise
Monitoring Server:

* During configuration:

1. Select Configure the Tivoli Enterprise Monitoring Server > Specify
configuration values > Integrated Cryptographic Service Facility (ICSF)
installed?

2. Specify N in the on the Integrated Cryptographic Service Facility (ICSF)
installed? panel.

 After the Tivoli Enterprise Monitoring Server configuration is complete and it is
running:

1. The Tivoli Enterprise Portal Server configuration must be modified to use an
older, less robust encoding algorithm. Edit the kfwenf file in
install_dir\CNPS, where install_dir is C:\IBM\ITM by default in a text editor.

2. In a line by itself, type the text USE_EGG1_FLAG=1

3. Save the document and exit.

4. Stop the Tivoli Enterprise Portal Server, if it is running, then start it.

On a system with one or more existing OMEGAMON monitoring
environments, the global CSl is corrupt and cannot be used for
installing a new version

Use the following steps manually merge existing datasets with IBM Tivoli
Monitoring V6.1 datasets only after IBM Software Support instructs you to do so:

1. Backup the following datasets:
* Runtime
¢ Target
+ INSTDATA
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* INSTDATW
» INSTJOBS
« INSTLIB

e INSTLIBW
* INSTQLCK
e INSTSTAT

Note: You must backup the specified datasets.

2. After installing the product on a new CSI, refer to the Program Directory
document to verify that the datasets contain enough allocated space for the
new libraries.

3. From the ISPF panel 3.3 or a JCL batch job, copy the contents of the new
modified Target libraries in to their counterparts in the old Target

libraries, ensuring that like-named members are replaced.

Table 9. Modified target libraries

TKANCMD

TKANCUS

TKANDATV

TKANHENU

TKANMAC

TKANMOD

TKANMODL

TKANPAR

TKANPENU

TKANSAM

TKCIINST

TKNSLOCL

4. Manually delete obsolete datasets listed in from TKANMODL that
interfere with operation of new version of Tivoli Enterprise Monitoring Server
on z/0S.

Table 10. TKANMODL obsolete members

KLXABIND

KLXACLOS

KLXAHBAD

KLXAHBNM

KLXAINIT

KLXAINTE

KLXAOPEN

KLXAPEER

KLXARECV

KLXASELF

KLXASEND

KLXASLIH
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Table 10. TKANMODL obsolete members (continued)

KLXAWAIT

KLXAXDAT

KLXAXTPL

KLXIQINT

KLXIQIUC

KLXIDESP

Uninstallation problems and workarounds

This section provides information about how to troubleshoot an uninstallation.

Uninstallation is blocked by another process that is using the
IBM Tivoli Monitoring eclipse help server

Kill the javaw tasks associated with the IBM Tivoli Monitoring eclipse help server
on the system so that the uninstall can continue.

Removing a failed installation on Windows

The following sections describe the process for removing a release that is partially
installed and cannot be removed by using the Add and Remove Programs tool.
The following topics are discussed:

Table 11. Removing a failed installation on Windows

Goal Where to find information

Remove a failed installation from computer |/“Removing a failed first time installation”]
that has never had IBM Tivoli Monitoring or
Candle OMEGAMON installed.

Remove a failed installation from a |“Removing a failed upgrade” on page 58|

computer that you were trying to upgrade
from Candle OMEGAMON.

Removing a failed first time installation
Use the following steps to remove a partially installed IBM Tivoli Monitoring
installation:

1.

Ensure that there is no entry in the Add and Remove Programs tool for the
component that you attempted to install. If there is an entry, use that entry to
uninstall the product. If there is no entry, proceed to the next step.

Open the Windows Explorer and navigate to the IBM Tivoli Monitoring
installation directory (C:\IBM\ITM by default).

Launch the Manage Tivoli Enterprise Monitoring Services utility by
double-clicking the KinConfg.exe file located in either the Install or InstalllTM
subdirectory.

If any agents, the portal server, or the monitoring server are listed in the
Manage Tivoli Enterprise Monitoring Services window, right-click each and
click Advanced > Unconfigure. Repeat this step for all components that are
listed. Close the Manage Tivoli Enterprise Monitoring Services utility.

Open the Windows Control Panel.

Double-click Administrative Tools and then double-click Services.
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7. Verify that all related IBM Tivoli Monitoring services have been removed.
These services match those listed in the Manage Tivoli Enterprise Monitoring
Services window.

8. Open the Registry Editor by clicking Start * Run and typing regedt32. Click
OK.

Note: Create a backup of the registry before editing it.
9. Expand the key HKEY_LOCAL_MACHINE registry key.
10. Expand the SOFTWARE registry key.

11. Expand the Candle registry key and record any sub-keys that are present. If
the Candle key does not exist, proceed to step

12. Expand the OMEGAMON registry key under the Candle key and record the
content of the OMEGAMON key values.

13. Delete the Candle registry key and all sub-keys.
On Windows XP, you can right-click the Candle registry key and click Delete.
14. Close the Registry Editor.

15. Open the Windows Explorer and find the IBM Tivoli Monitoring installation
location on your system. The default value is C:\IBM\ITM.

16. Delete this directory and all subdirectories.
17. Remove the IBM Tivoli Monitoring bookmark from the Start menu:
a. Click Start from the Windows desktop to display the Start menu items.
b. Click Programs.
c¢. Right-click IBM Tivoli Monitoring to display the bookmark menu options.
d. Click Delete to remove the IBM Tivoli Monitoring bookmark from the
Windows desktop start menu.

You can now install IBM Tivoli Monitoring.

Removing a failed upgrade

To remove a failed upgrade, first ensure that there is no entry in the Add and
Remove Programs tool for the new component you are attempting to install. If
there is an entry, use that entry to uninstall the product. If there is no entry, use the
following steps to remove the failed upgrade.

The first step to removing a failed upgrade is to determine where the install failed:
either before the files were copied or after the files were copied. For GUI
installations, the files are copied after you click Next on the Start Copying Files
window. If you performed a silent installation, look for a pair of entries separated
by a blank line:

FirstUIBefore exiting to file copy
FirstUIAfter entry after file copy

If neither exist, then the installation failed before the files were copied. See
[“Installation failed before files were copied.”|

If both entries exist, the installation failed after the files were copied. See
[“Installation failed after files were copied” on page 59

Installation failed before files were copied: Check to see if the entry for your
previous installation exists in the Add and Remove Programs tool. If it does not
exist, follow the instructions in [“Removing a failed first time installation” on page|
Your previous installation is too corrupt to use and must be completely
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removed. You must either completely reinstall the previous release and then
upgrade to IBM Tivoli Monitoring or just install IBM Tivoli Monitoringwithout
attempting to upgrade.

If the entry exists in the Add and Remove Programs tool, you can still use your
existing Candle OMEGAMON installation. Launch Manage Candle Services to start
all components.

Installation failed after files were copied: If your installation failed after the files
were copied, your current installation has been corrupted by the partial installation
of IBM Tivoli Monitoring. You must either completely reinstall the previous release
and then upgrade to IBM Tivoli Monitoring or just install IBM Tivoli Monitoring
without attempting to upgrade.

Check the Add and Remove Programs tool to see if either your previously
installed Candle OMEGAMON or IBM Tivoli Monitoring is available.

If neither are available, see [“Neither products are available in the Add and Removd
[Programs tool.”]

If one is available see[“One product is available in the Add and Remove Programs|
ftool” on page 60

If both are available, [“Both products are available in the Add and Remove]
[Programs tool” on page 60,

Neither products are available in the Add and Remove Programs tool: Use the following
steps if neither Candle OMEGAMON or IBM Tivoli Monitoring exists in the Add
and Remove Programs tool:

1. Open the Windows Explorer and navigate to the IBM Tivoli Monitoring
installation directory. By default, the installation location is
CAIBM\ITMN\Install, C:\IBM\ITM\InstallITM, C:\Candle\Install, or
C:\Candle\InstallITM.

2. Launch the Manage Tivoli Enterprise Monitoring Services utility by
double-clicking the KinConfg.exe file located in either the Install or InstalllTM
subdirectory. Launch the KinConfg.exe from the InstalllTM directory if
possible.

3. If any agents, the portal server, or the monitoring server are listed in the
Manage Tivoli Enterprise Monitoring Services window, right-click each and
click Advanced > Unconfigure. Repeat this step for all components that are
listed. Close the Manage Tivoli Enterprise Monitoring Services utility.

4. Open the Windows Control Panel.
5. Double-click Administrative Tools and then double-click Services.

6. Verify that all related Candle OMEGAMON and IBM Tivoli Monitoring
services have been removed. These services match those listed in the Manage
Tivoli Enterprise Monitoring Services window.

7. Open the Registry Editor by clicking Start * Run and typing regedt32. Click
OK.

Note: Create a backup of the registry before editing it.
8. Expand the key HKEY_LOCAL_MACHINE registry key.
9. Expand the SOFTWARE registry key.

10. Expand the Candle registry key and record any sub-keys that are present. If
the Candle key does not exist, proceed to step [14}
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11. Expand the OMEGAMON registry key under the Candle key and record the
content of the OMEGAMON key values.

12. Delete the Candle registry key and all sub-keys.
On Windows XP, you can right-click the Candle registry key and click Delete.
13. Close the Registry Editor.

14. Open the Windows Explorer and find the Candle OMEGAMON and IBM
Tivoli Monitoring installation directories. The default value for Candle
OMEGAMON is C:\Candle; the default value for IBM Tivoli Monitoring is
CA\IBM\ITM.

15. Delete this directory and all subdirectories.

16. Use the steps in [“Verifying the uninstallation”|to verify that you successfully
removed the failed upgrade.

17. Remove the IBM Tivoli Monitoring bookmark from the Start menu:
a. Click Start from the Windows desktop to display the Start menu items.
b. Click Programs.
c. Right-click IBM Tivoli Monitoring to display the bookmark menu options.
d

. Click Delete to remove the IBM Tivoli Monitoring bookmark from the
Windows desktop start menu.

One product is available in the Add and Remove Programs tool: Use the following
steps if an entry for either Candle OMEGAMON or IBM Tivoli Monitoring exists
in the Add and Remove Programs tool:

1. Attempt to uninstall both releases from the Add and Remove Programs entry.

2. If this is successful, proceed to|“Verifying the uninstallation.”]

3. If this is not successful and the entry has been removed from the Add and
Remove Programs tool, see [“Neither products are available in the Add and]
[Remove Programs tool” on page 59

4. If the entry is still present in the Add and Remove Programs tool, copy the
KINWIINS.VER file (from the \WINDOWS\VERFILES\KINWIINS.VER
directory on the installation CD) to the <itm_installdir>\Install\ Ver directory,
where <itm_installdir> is the IBM Tivoli Monitoring installation directory.

Delete the KINWIINSMSTR.VER file from this directory if it exists.

Note: You might need to create the Install\ Ver subdirectory if it is does not
exist.

5. Attempt to uninstall the release again. If it fails again, contact IBM Software
Support for assistance.

Both products are available in the Add and Remove Programs tool: Use the following
steps if both the Candle OMEGAMON or IBM Tivoli Monitoring entries exist in
the Add and Remove Programs tool:

1. Uninstall IBM Tivoli Monitoring through the Add and Remove Programs tool.
2. Uninstall Candle OMEGAMON through the Add and Remove Programs tool.
3. Proceed to |[“Verifying the uninstallation.”]

Verifying the uninstallation: Use the following steps to verify that you successfully
removed the failed installation:

1. Verify that the installation home directory and all contents have been removed.

2. Open the Registry Editor by clicking Start * Run and typing regedt32. Click
OK.

60 IBM Tivoli Monitoring: Problem Determination Guide



3. Expand the key HKEY_LOCAL_MACHINE registry key.
4. Expand the SOFTWARE registry key.

5. Verify that the Candle registry key and all sub-keys have been removed from
HKEY_LOCAL_MACHINE\SOFTWARE.

You are now ready to install IBM Tivoli Monitoring.

Incorrect behavior after an uninstallation and reinstallation

You might experience incorrect behavior if you uninstall then reinstall the product
without restarting the system. For example, you might experience the following
problems:

¢ Inability to create trace logs.
* Agents do not start.
e Agents data is corrupt.

Restart the system to resolve the problems.

Tivoli Data Warehouse database does not uninstall

When you uninstall IBM Tivoli Monitoring, the Tivoli Data Warehouse database is
not removed and the ODBC data source exists. You must remove the Tivoli Data
Warehouse database and the ODBC manually.

The agent installation log on the endpoint indicates that error

AMXUT7512E occurred

The error AMXUT7512E might occur when running the Distributed Monitoring
Upgrade Toolkit. The agent was not uninstalled for one of the following reasons:

* There is another uninstallation in progress that cannot complete until the
computer is restarted.
—OR-

* The uninstallation requires stopping a process that is currently in use by a
another component.

Refer to the Tcfd.log on the endpoint and agent installation log as listed in
to determine the exact cause of the problem.

Table 12. Installation logs

Windows

UNIX-based systems

install_Dir/Install/Abort IBM Tivoli install_Dir/logs/candle_installation.log

Monitoring timeStamp.log

You can manually uninstall the operating system agent by running the command
for your platform as listed in [Table 13

Table 13. Uninstall OS command

Windows UNIX-based systems
LCF_BINDIR\\..\\TME\\ITMUpgrade LCF_BINDIR/../TME/ITMUpgrade/
\\ITMUpgradeManager\\setup. ITMUpgradeManager/uninstall.sh

Contact IBM Software Support if you cannot uninstall the agent.
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Prompted to uninstall a database that was not running during
uninstallation

During uninstallation, when prompted for the DB2 username and password in
order to remove the Tivoli Enterprise Portal Server from the DB2 database, you
were prompted with the following question:

would you like to delete the Tivoli Enetrprise Portal MSSQL/MSDE Database

The Microsoft® MS SQL Server database was not running. My Tivoli Enterprise
Portal Server is installed and configured with a DB2 database and not a Microsoft
MS SQL Server database.

It is likely that the system you are using at one time had a Microsoft MS SQL
Server database installed that was not properly uninstalled. It does not matter
whether the database is running or not; if the data source exists you will be asked
the question, and if you answer yes there will be an attempt to remove the
database.
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Chapter 4. Connectivity troubleshooting

This section provides descriptions of and resolutions for problems you might
experience with connectivity, including logging in, passwords, and communication
among IBM Tivoli Monitoring components. Tivoli Enterprise Portal monitors the
connections between server and client and server and host data sources
continuously. When Tivoli Enterprise Portal detects a connection error it can repair
the error and your client session can resume unaffected. Use the information in
this section to diagnose and recover from connectivity problems.

If you are running the Tivoli Enterprise Monitoring Server on z/0S, see
[“Troubleshooting z/0S-based installations” on page 44| for information about
configuration problems affect connectivity.

The Tivoli Enterprise Portal Server does not start after installation

Check the following log files for messages that indicate why the Tivoli Enterprise
Portal Server did not start:

Table 14. The Tivoli Enterprise Portal Server does not start after installation

Log file For messages that indicate . . .

kfwrasl.log A failure during upgrade.

The Tivoli Enterprise Monitoring Server hub did not connect.

install_dir\cnps\sqllib\migrate.log Any error.

Cannot log in to the Tivoli Enterprise Portal

The following table provides resolutions for problems logging in to the Tivoli
Enterprise Portal.

Table 15. Cannot log in to the Tivoli Enterprise Portal

Problem Resolution

User authorization failed ¢ The user ID and password are correct.

-OR- * The Tivoli Enterprise Monitoring Server started.
KFWITM215E: Unable to process * The user is defined in the Tivoli Enterprise Portal Server.
Togon request * The Tivoli Enterprise Portal Server database is running.

e The TEPS or TEPS2 data sources are configured.
* Security validation is active on the Hub Tivoli Enterprise Monitoring
Server.

If you still cannot log in, refer to c:\ibm\itm\cnps\logs\kfwrasl.log. If you
are still unable to log in, contact IBM Software Support.

An error message displays in the Recycle the Tivoli Enterprise Portal Server.
status bar of the Logon window.

If the status bar displays the Start the Tivoli Enterprise Monitoring Server.
Validating User Credentials message
continuously, the Tivoli Enterprise
Monitoring Server stopped.
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Table 15. Cannot log in to the Tivoli Enterprise Portal (continued)

Problem

Resolution

If you select Security: Validate User
for the Tivoli Enterprise Monitoring
Server configuration during
installation you cannot login to the
Tivoli Enterprise Portal.

Use the following steps to configure the monitoring server security setting:

1. In the Manage Tivoli Enterprise Monitoring Services window, right-click
the monitoring server.

2. Click Reconfigure (on Windows) or Configure (on UNIX).
3. Click OK on the first configuration window.
4. Clear Security: Validate User and click OK.

Cannot connect to Tivoli Enterprise Portal Server

Before performing any of the following problem determination steps, verify that
the connection problems are not the result of firewall settings. The following table
provides resolutions for problems logging in to the Tivoli Enterprise Portal Server.

Table 16. Cannot connect to Tivoli Enterprise Portal Server

Problem Resolution

KFWITMOO1W Unable to 1
connect to Tivoli
Enterprise Portal Server

KFWITM215E Unable to
process logon request

. Check the kfwlras.log for details if an attempt to log in fails with message

KFWITMO001W. The kfw1lras.log can list any of the following messages that
indicate a reason for the failure:

* SQL1224N A database agent could not be started to service a request,
or was terminated as a result of a database system shutdown or a
force command.

* SQL1226N The maximum number of client connections are already
started. SQLSTATE=57030

Both messages SQL1224N and SQL1226N occur when the Tivoli Enterprise
Portal Server attempts to validate the user ID entered in the browser.

Restart the database.
Attempt the login again.
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Table 16. Cannot connect to Tivoli Enterprise Portal Server (continued)

Problem

Resolution

A remote Tivoli Enterprise
Portal client does not connect to
a UNIX-based system Tivoli
Enterprise Portal Server with
the error message:

KFWITMOO1W Unable to connect
to Tivoli Enterprise Portal
Server

A remote Tivoli Enterprise Portal client login dialog does not connect to a Tivoli
Enterprise Portal Server hosted on a UNIX-based system, but the following are
true:

* Alocal Tivoli Enterprise Portal client connects to the Tivoli Enterprise Portal
Server.

* You can ping the Tivoli Enterprise Portal Server computer from the remote
computer.

* A Web browser can remotely connect to http://host_name:1920 to get to the
service links, assuming the default service port of 1920 was used during
installation.

The hostname might not resolve to the correct IP address on the local Tivoli
Enterprise Portal Server host. To confirm that the hostname resolves to the correct
IP address, run the following command from the host on which the Tivoli
Enterprise Portal Server was installed:

ping hostname

—OR-
ping -s hostname

The ping command displays the IP address of the computer it pings. Ensure that
the IP address is the same as the one to which the remote Tivoli Enterprise Portal
client is attempting to connect. For example, if your Tivoli Enterprise Portal Server
is located on a host with the hostname tepshost, and the host's /etc/hosts file
includes an entry similar to the following:
127.0.0.1 localhost.localdomain  localhost  tepshost

Running ping tepshost displays an IP address of 127.0.0.1, which is the address
of the local loopback network interface and the reason a remote computer cannot
connect to it. In this case, you must update the /etc/hosts file to give tepshost its
own entry, as in the following example:

127.0.0.1
192.168.0.9

localhost.localdomain  localhost

tepshost

Tivoli Enterprise Portal client
cannot find Tivoli Enterprise
Portal Server

1. Select Start > Programs > Tivoli Monitoring Services > Manage Tivoli
Enterprise Monitoring Services.

2. Check that the Tivoli Enterprise Portal Server service is running and, if not,
restart it.

3. If the Tivoli Enterprise Portal Server is started, see the KFWRAS1.LOG for any
errors reported by the Tivoli Enterprise Portal Server application.

When the server starts, an “event ID 1: KFW0001 - Tivoli Enterprise Portal
Server (Tivoli Enterprise Portal Server) startup complete” information entry is
logged.

If you see an error entry, double-click the item to see the description.
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Table 16. Cannot connect to Tivoli Enterprise Portal Server (continued)

Problem

Resolution

Cannot connect to the Tivoli
Enterprise Portal Server because
it stopped.

Do the following to determine if the Tivoli Enterprise Portal Server stopped and
restart it:

1. On the computer where the Tivoli Enterprise Portal Server is installed, select
Start > Programs > IBM Tivoli Monitoring Services > Manage IBM Services.

2. Optional: Right-click the Tivoli Enterprise Portal Server entry and select
Change Startup from the menu.

3. In the window that opens, select System Account and place a check in the
Allow Service to Interact with Desktop box.

4. Click OK to open a command prompt window when the Tivoli Enterprise
Portal Server is started. Internal Tivoli Enterprise Portal Server commands
display in the command prompt window.

5. Verify that the Tivoli Enterprise Portal Server service is started. The Tivoli
Enterprise Portal Server is started when the following messages display:

KfwServices: <timestamp> KFW1002I Starting Service:
"Configuration v1.0'

KfwServices: <timestamp> KFW1003I Started Service:
"Configuration v1.0'

KfwServices: <timestamp> KFW1002I Starting Service:
'Situation v1.0'

KfwServices: <timestamp> KFW1003I Started Service:
'Situation v1.0'

KfwServices: <timestamp> KFW1002I Starting Service:
"Automation v1.0'

KfwServices: <timestamp> KFW1003I Started Service:
"Automation v1.0'

KfwServices: <timestamp> KFW1002I Starting Service:
'CEV v1.0'

KfwServices: <timestamp> KFW1003I Started Service:
'CEV v1.0'

KfwServices: <timestamp> KFW1002I Starting Service:
'Startup Complete v1.0'

KfwServices: <timestamp> KFW1003I Started Service:
'Startup Complete v1.0'

KfwServices: <timestamp> KFW1020I **xx***x* Waiting for requests.
Startup complete xxkxskxx*

6. Do one of the following;:
* If it is stopped, start the Tivoli Enterprise Portal Server.

« If it is started, recycle the Tivoli Enterprise Portal Server.

If you are running the Tivoli
Enterprise Portal in browser
mode and reaching the Tivoli
Enterprise Portal Server across
network, the network system
might not be able to resolve the
host name.

Do the following on the computer where the Tivoli Enterprise Portal Server is
installed:

1. In Manage Tivoli Enterprise Monitoring Services, right-click the Tivoli
Enterprise Portal — Browser service and select Reconfigure from the menu.

2. In the Launch URL field, change host name in http://hostname:1920///cnp/
client to the IP address of the Tivoli Enterprise Portal Server to specify the
numerical address, for example: http://10.21.2.166:1920/ / /cnp/client.

3. Click OK.

4. Start Tivoli Enterprise Portal browser mode using the IP address instead of the
host name.

5. If you are still unable to connect, contact IBM Software Support.
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Cannot launch the Tivoli Enterprise Portal on an XP computer after
installation with the message KFWITM215E

The message KFWITM215E: Unable to process logon request occurs. A firewall
setting on the client computer prevents the Tivoli Enterprise Portal client from
connecting to the Tivoli Enterprise Monitoring Server. Set the IBM JVM (Java
launcher) as a trusted program to allow the Tivoli Enterprise Portal client to
connect to the Tivoli Enterprise Monitoring Server. You might need to include the
IBM Java program in the programs section of your firewall software and include
the IP addresses of other Tivoli Monitoring Services components in the access
control for the firewall.

Tivoli Enterprise Portal Server is initializing and is not ready for
communications

If you attempt to start Tivoli Enterprise Portal just after starting the Tivoli
Enterprise Portal Server, the Tivoli Enterprise Portal Server is not ready for
requests from the client until initialization and kfwservices.exe, is fully started. The
Tivoli Enterprise Portal Server is not ready for requests from the client until its
process, kfwservices.exe is fully started. Keep the Logon window open and click
OK after waiting a moment or two.

Tivoli Enterprise Portal Server lost contact with the Tivoli Enterprise
Monitoring Server and is attempting to reconnect

This message displays when the Tivoli Enterprise Portal Server lost its connection
to the Tivoli Enterprise Monitoring Server, usually because the Tivoli Enterprise
Monitoring Server stopped or is recycling. See also
KFW_CMW_RECYCLE_DELAY.

Heartbeat issues when running IBM Tivoli Monitoring v6.x on a Linux
guest using VMWare

When the Linux operating system is run as a guest using VMWare, it is possible
for the clock of the Linux guest to run either faster or slower than real world time.
If any IBM Tivoli Monitoring v6.x products are installed on Linux guests whose
clocks are not running correctly, the result can be erratic system behavior. For
example, if the Monitoring Agent for Linux OS is installed on a Linux operating
system guest whose clock is running too slow, heartbeats from the agent are not
produced on time. This results in the agent continuously going OFFLINE and
ONLINE at the Tivoli Enterprise Monitoring Server, as the heartbeats arrive after
the time interval has expired.

VMWare is aware of this issue, and has written several articles that address this
problem. The following articles were current at the time this guide was published:

* "Clock in a Linux Guest Runs More Slowly or Quickly Than Real Time,"
http:/ /kb.vmware.com/selfservice/microsites/search.do?language=en_US
&cmd=displayKC&externallD=1420

* VMWARE WHITE PAPER - "Timekeeping in VMware Virtual Machines,”
http:/ /www.vmware.com/pdf/vmware_timekeeping.pdf

For the most up-to-date information on this issue, please consult the VMWare
website (www.vmware.com).
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How To Tell If You Have This Problem:

A simple way for determining whether or not your Linux guest has a clock
problem is to benchmark it against a real world clock. Here is an example of a
procedure that you can use:

1. From a Linux shell prompt, type "date” to get the current system date and
time. While you are pressing Enter, look at a "real” clock (wall clock, watch,
etc...) to get the real world time in minutes and seconds. Record the time from
both your Linux guest and the "real” clock.

Example: Real Clock = 10:30:00, Linux Clock = 10:20:35

2. After 10 real time minutes have expired, type the "date” command again (you
should type the "date” command ahead of time, so you only have to press
Enter when 10 minutes have elapsed). Record the new times from both your
Linux guest and "real” clock.

Example: Real Clock = 10:40:00, Linux Clock = 10:26:35

3. Compute the elapsed time for both your Linux guest and "real” clock. If the
elapsed times are not the same, your Linux guest has a clock problem.

Since we waited exactly 10 minutes using the "real” clock, we would expect
that the elapsed time for the Linux clock would also be 10 minutes. Using the
above figures, we can see that the elapsed time for the Linux guest is 6 minutes
(10:26:35 - 10:20:35). Since this is less than the real world time, this means that
the Linux guest clock is running slow. This causes the IBM Tivoli Monitoring
product to behave erratically if the clock is not fixed.

Tivoli Enterprise Portal Server is unavailable

When a message indicates the server is unavailable, suspend further interactions
until a message indicates the server is available unless you decide to end the
current Tivoli Enterprise Portal session. When the Tivoli Enterprise Portal Server is
available again, your client session is automatically reconnected and you can
resume normal interactions. If the server is available and the client has not
reconnected after three to five minutes, exit the browser, restart the browser, and
restart a Tivoli Enterprise Portal client session.

Tivoli Enterprise Portal Server is not reconnecting

If the Tivoli Enterprise Portal Server does not reconnect, recycle the Tivoli
Enterprise Monitoring Server and restart the Tivoli Enterprise Portal Server.

Cannot reconnect to the Tivoli Enterprise Monitoring Server
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This message displays after the Tivoli Enterprise Monitoring Server goes down and
attempts to reconnect. The Tivoli Enterprise Portal client attempts to log on once
again to the Tivoli Enterprise Portal Server session. After a successful logon, the
Tivoli Enterprise Portal client compares the Tivoli Enterprise Portal user authorities
that were in effect when the original logon occurred with the current Tivoli
Enterprise Portal user authorities. If any permission is different, you must restart
the client session to ensure all components are synchronized with your user
permissions. Changes to user permissions include navigator view assignment
differences since the last logon.

If you want to apply new permissions for other users immediately, make all
necessary changes and recycle the Tivoli Enterprise Monitoring Server. When the
Tivoli Enterprise Monitoring Server recycle is complete, each user is reconnected
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and their user ID validated. If there were changes to their profiles, users must
restart the Tivoli Enterprise Portal client session. The Tivoli Enterprise Portal client
session doe snot to be restarted if no changes were made to their profiles.

Tivoli Enterprise Portal Server cannot connect to the Tivoli Enterprise
Monitoring Server private interface

If the Tivoli Enterprise Monitoring Server is installed on an AIX server with a
public and a private interface, the Tivoli Enterprise Portal Server cannot connect to
the Tivoli Enterprise Monitoring Server. There are two environment variables you
can set to control which interfaces to publish. For IPV4 use
KDEB_INTERFACELIST, for IPV6 use KDEB_INTERFACELIST_IPV6. In either
address family, you can set those variables to set, restrict, or add to the interfaces
in use.

Table 17. Control interface publishing

Interface control Environment variable

To set specific interfaces KDEB_INTERFACELIST=ip4addr-1 ... ip4addr-n

for consideration: KDEB_INTERFACELIST IPV6=ip6addr-1 ... ip6addr-n
To remove interfaces from |KDEB_INTERFACELIST...=-ip4addr-1 ... -ipdaddr-n
consideration: KDEB_INTERFACELIST_IPV6=ip6addr-1 ... ipbaddr-n
To add interfaces for KDEB_INTERFACELIST=+ ipdaddr-1 ... ip4addr-n
consideration: KDEB_INTERFACELIST_IPV6=+ ip6addr-1 ...ipbaddr-n
where:

ip4addr

Specifies either a symbolic network name, or a raw form dotted decimal network address.

ip6addr
Specifies either a symbolic network name, or a raw form colon-separated hex digit network address.
Note: The plus sign must stand alone.
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Chapter 5. Tivoli Enterprise Portal troubleshooting

This chapter describes problem you might experience with the Tivoli Enterprise
Portal.

Cannot launch the Tivoli Enterprise Portal help

The Tivoli Enterprise Portal help might not display for the following reasons:

Popup blocker
If the browser toolbar has a popup blocker running, the help does not
open whether you select Contents > Index from the Tivoli Enterprise
Portal Help menu or click Help in a window. Turn off the popup blocker.

Internet Explorer shortcut keys the same for Tivoli Enterprise Portal
Some Tivoli Enterprise Portal shortcut keys are also used by Internet
Explorer. If you are using the browser client and press F1 to open the
Tivoli Enterprise Portal help, help for Internet Explorer displays instead.
Select Contents and Index from the Tivoli Enterprise Portal Help menu.

JavaScript " not enabled in Microsoft Internet Explorer
JavaScript might not be enabled in Microsoft Internet Explorer. See the
Microsoft Knowledge Base Article 236846 for troubleshooting information.

http:/ /support.microsoft.com/default.aspx?scid=kb;en-us;236846

Help index and search text entry fields are disabled

For some reason, your browser is unable to load the Java applets necessary to
enable the Index and Search fields, and is rendering the help in Pure HTML. If you
view Tivoli Enterprise Portal help with Internet Explorer use the following steps to
resolve this problem:

1. From the Internet Explorer browser toolbar go to Tools > Internet Options >
Advanced > Java (IBM).

2. Clear the Use Java version 1.4.2 for <applet> (requires restart) check box.

If the help index and search text entry fields are still disabled after clearing the
Use Java version 1.4.2 for <applet> (requires restart) check box, see[*On Linux|]
[BM Tivoli Enterprise Monitoring Agent topics do not display in the Help Contents|
or Index tabs” on page 72|

Java exception logging onto the Tivoli Enterprise Portal from a
browser

If you encounter an exception that has the following text:

"java.lang.UnsatisfiedLinkError: com/webrenderer/server/
NativeMozillalLibrary.setMozPath"

delete the WebRenderer directory under the home path. For Linux systems, this

path is $HOME/.webrendererswing, and for Windows systems, this path is
%HOMEPATH %/ .webrendererswing.
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On Linux, IBM Tivoli Enterprise Monitoring Agent topics do not display
in the Help Contents or Index tabs

You can see the Tivoli Enterprise Portal help topics in the Contents tab, but none
for your installed monitoring agents. Change your default browser to Internet
Explorer or complete the following steps:

1. If the help is open, close the browser window.
2. On the computer where the Tivoli Enterprise Portal Server is installed, locate
the contents.htm file:

Windows:
<install_dir>\cnb\classes\candle\fw\resources\help

UNIX-based systems:
Linux: <install_dir>/cnb/classes/candle/fw/resources/help
3. Rename contents.htm to contents.bak.

4. Rename contents_dhtml.htm to contents.htm.

Translated files not updated with installation

When installing applications based on a IBM Tivoli Monitoring v6.1 installation
program on top of a IBM Tivoli Monitoring v6.2 installation, some translated files
might be overwritten. In these cases, the Language pack might have to be
reinstalled in order to update the translated files.

Tivoli Enterprise Portal Navigator items are listed in an unexpected

order

When expanding items in the Tivoli Enterprise Portal Navigator, parent items
might list child items in an unexpected order. Navigator items are ordered
internally on the Tivoli Enterprise Portal Server and therefore might not reflect a
logical ordering in any particular language. Use the More... indicator at the end of
the branch of child items to append them until you locate a the item you need.

HEAPDUMPs and JAVACore files are placed on the desktops when
running Tivoli Enterprise Portal in browser mode

The Tivoli Enterprise Portal client uses the IBM Java Plug-in, which is
automatically installed on your computer with the Tivoli Enterprise Portal. Adjust
the IBM Java Plug-in properties if performance is slow or your workstation
receives HEAPDUMPs and JAVACore files, an out-of-memory condition, when you
are logged on. Make the following adjustments to correct this problem:

* Increase the Java heap size settings. Set the minimum heap size to 128 MB. Set
the maximum heap size to 256 MB. If you continue to experience problems,
increase the maximum setting in increments of 64 MB until the symptoms
disappear.

* When memory requests by the Tivoli Enterprise Portal cannot be satisfied from
Java heap storage, the JVM performs garbage collection to reclaim free memory.
If the Java heap size settings are too small, the amount of time it takes to
perform garbage collection becomes excessive, resulting in high CPU utilization
and poor response time. In some cases, Java HEAPDUMPS and JAVACore files
are placed on user desktops, indicating an out-of-memory condition. Increasing
the Java heap size parameters over the default values helps you avoid these
problems.
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If you observe symptoms of heap memory exhaustion after changing the heap
size settings to the suggested values, increase the maximum setting in
increments of 64 MB until the symptoms disappear.

Make sure the client workstation has enough memory to handle the maximum
heap size. To determine if the client workstation has sufficient memory, observe
the available physical memory (as shown on the Windows Task Manager
Performance tab) when the workstation is not running the Tivoli Enterprise
Portal client, but is running any other applications that need to run concurrently
with the portal client. Verify that the client workstation has enough available
physical memory to hold the entire maximum Java heap size for the Tivoli
Enterprise Portal plus another 150 MB. The additional 150 MB provides an
allowance for non-Java heap storage for the Tivoli Enterprise Portal and extra
available memory for use by the operating system.

Set the Java Plug-in cache to an unlimited size to avoid performance problems
due to insufficient cache space for Tivoli Enterprise Portal JAR files.

If you have just upgraded to a new release or fix pack, clear the plug-in cache to
remove old versions of the Tivoli Enterprise Portal JAR files.

Complete the following steps to adjust the Java Plug-in settings:

1.
2.

Open the Windows Control Panel.

Double-click IBM Control Panel for Java(TM) to display the Java(TM) Control
Panel.

From the Java(TM) tab:
a. Click View.

b. Double-click on the Java Runtime Parameters field and enter: -Xms 128m
-Xmx256m .

Click OK.

From the General tab complete the following steps to clear the browser cache:
a. Click Delete Files...

b. Check the box labeled Downloaded Applets.

c. Click OK.

Click OK in the Java(TM) Control Panel.

Java errors occur with the IBM v1.4.2 JRE

If you experience any problems using the IBM 1.4.2 JRE use the version shipped
with IBM Tivoli Monitoring v6.1.

IBM Tivoli Monitoring v6.2 ships with IBM 1.5.0 JRE. Use this version if you have
installed IBM Tivoli Monitoring v6.2.

Tivoli Enterprise Portal has high memory usage and poor response

time

The amount of Java memory used by the Tivoli Enterprise Portal increases with the
size of the monitored environment. If the maximum Java heap size setting is too
low, the amount of time spent by the JVM performing garbage collection can
become excessive, resulting in high CPU utilization and poor response time.
Verbose garbage collection (GC) data can be used to determine if excessive garbage
collection occurs. If the percentage of time spent performing garbage collection is
greater than 5%, increase the maximum Java heap size (the -Xmx parameter) to
provide more memory and reduce garbage collection activity. For more information
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about collecting verbose GC data and Java heap tuning parameter changes, refer to
the IBM Developer Kit and Runtime Environment, Java 2 Technology Edition,
Version 1.4.2 Diagnostics Guide (SC34-6358-01), which is available from
http://www.ibm.com/developerworks /java/jdk/diagnosis/| Use the following
steps to increase the maximum Java heap size.

Tivoli Enterprise Portal browser client
Edit the Java heap parameters using the Java Plug-in Control Panel. Before
you change the values for the Java Plug-in, consider that any changes
affect all Java applications that use the Java Plug-in. See "Preparing your
Tivoli Enterprise Portal environment” in the IBM Tivoli Monitoring
Administrator’s Guide for more information.

1. Open the Windows Control Panel.

2. Double-click Java Plug-in for IBM Java V1.4.2 (or right-click and select
Open). If you have multiple Java Plug-ins, check that you have the
properties for the right plug-in opened: The About tab shows V1.4.2,
and the Cache or Certificates tab shows IBM in the path or in the
signed certificate.

3. In the Advanced tab, select the IBM JRE 1.4.2 from the Java Runtime
Environment list.

4. In the Java Runtime Parameters field, enter -Xms128m -Xmx256m.
5. Click Apply.
Tivoli Enterprise Portal desktop client

Edit the cnp.bat file in install_dir\CNP to change the Java heap
parameters in the set command to -Xms128m -Xmx256m..

Tivoli Enterprise Portal has high memory usage
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The amount of Java memory used by the Tivoli Enterprise Portal depends on the
size of the monitored environment. The largest component of the memory usage is
for the Java heap, which contains both short-term and long-term data. When a
memory request cannot be satisfied from free Java heap storage, "garbage
collection” is performed to reclaim free memory. There are many Java heap tuning
parameters for IBM Java run-time environments that can be used to influence
garbage collection and memory management. Notable among these are the
minimum free percentage (-Xminf) and maximum free percentage (-Xmaxf)
parameters. IBM Java documentation provides the following descriptions:

-Xminf<number>
A floating point number, 0 through 1, that specifies the minimum free heap
size percentage. The heap grows if the free space is below the specified
amount. The default is .3 (that is 30%).

-Xmaxf<number>
A floating point number between 0 and 1, which specifies the maximum
percentage of free space in the heap. The default is 0.6, or 60%. When this
value is set to 0, heap contraction is a constant activity. With a value of 1,
the heap never contracts.

You can lower the amount of free space maintained in the Java heap at the expense
of higher CPU utilization and longer response time by setting the minimum free
and maximum free percentages to lower values.

Default values:
-Xminf0.30 —Xmaxf0.60
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Consider the following values:
-Xminf0.15 -Xmaxf0.30

The IBM Java documentation warns that setting these values too low can cause
poor Java performance. For more information on Java heap tuning parameters,
refer to the IBM Developer Kit and Runtime Environment, Java 2 Technology
Edition, Version 1.4.2 Diagnostics Guide (SC34-6358-01), which is available from
lhttp:/ /www.ibm.com/developerworks /java/jdk/diagnosis /|

Data is not returned to the Tivoli Enterprise Portal client

Do the following to ensure that data can return to the Tivoli Enterprise Portal
client:

* Ensure that the monitoring agent is online.

* Verify that all the application-related files were installed with the Tivoli
Enterprise Portal Server.

* Check the kfwrasl.log for errors.
* Set the following trace option in the KFWENYV file:
(UNIT:ctsql INPUT)

DirectDraw thread loops infinitely causing poor Tivoli Enterprise Portal

performance

Java uses DirectDraw by default but VMWare does not support DirectDraw.
Perform the following steps for both desktop and browser clients from Manage
Tivoli Enterprise Monitoring Services to set Java Runtime not to use DirectDraw
for graphic rendering:

1. Right-click Tivoli Enterprise Portal.
2. Select Advanced > Edit Variables . ..

3. Double-click the line with sun.java2d.noddraw to open the Edit Tivoli
Enterprise Portal Parm window.

Ensure the value is true.
Click the In Use box so to place a check-mark in the box.
Click OK to close the window.

Click OK to close the configuration window.

O

Workflow Editor is disabled and the following tools do not display:
Event Console, Graphic View, Edit Navigator View (Navigator view

toolbar)

If you did not enable Manage Tivoli Enterprise Monitoring Services during
installation, the Workflow Editor is disabled and the following tools do not
display:

* Event Console

* Graphic View

 Edit Navigator View (Navigator view toolbar)

1. On the computer where the Tivoli Enterprise Portal Server is installed, select
Start > Programs > Tivoli Monitoring Services > Manage Tivoli Enterprise
Monitoring Services.
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2. Right-click the Tivoli Enterprise Portal Server service, point to Licensing and
select Tivoli Enterprise Portal Server from the menu.

3. In the Tivoli Enterprise Portal Service License window, enter the new license
key if one was issued.

4. Check Enable Tivoli Enterprise Monitoring Server.

5. Click OK.
When you click OK, the server stops and a message in Tivoli Enterprise Portal
says the server is unavailable. If you do not close the client work session, after

the server has been started again (next step), another message says your Tivoli
Enterprise Portal permissions have changed and prompts you to restart.

6. Restart the Tivoli Enterprise Portal Server and, after startup is complete, restart
the Tivoli Enterprise Portal client.

Situations are not firing
Do the following to determine why situations are not firing in the Tivoli Enterprise
Portal:
* Confirm the situation is firing in the event console.
* Ensure that the situation was distributed.

* Verify whether the situation is associated with a node in the Tivoli Enterprise
Portal Navigator.

e Ensure that the situation condition is true.
* Check the operations log of the agent.

Historical UADVISOR situations are started on the agent if historical
collection is configured to collect data

Anytime you configure an IBM Tivoli Monitoring historical collection for any
agent, UA or otherwise, the name of the history situation is always called
UADVISOR_xxxxx. If you see these UADVISOR_xxxxx entries in the list of defined
situations, even though they were never explicitly defined, these history situations
were automatically defined by an IBM Tivoli Monitoring component.

At the bottom of each view, you see a historical workspace
KFWITM217E error

At the bottom of each view, you see the following historical workspace
KFWITM217E error: Request failed during execution, and a red icon.

Ensure that you configure all groups that supply data to the view. In the Historical
Configuration view, ensure that data collection is started for all groups that supply
data to the view. Views containing multi-row attributes show this message if no
row data are collected.

Installation of situation data fails due to /O on VSAM data sets

After installation of application support, product-provided situations do not appear
in the Tivoli Enterprise Portal Situation editor or do not auto start. This problem
occurs only with a z/OS hub monitoring server.

Explanation: The definitions of product-provided situations are installed on the
hub Tivoli Enterprise Monitoring Server when application support for a product is

76  IBM Tivoli Monitoring: Problem Determination Guide



installed. If the VSAM data sets in which the data is stored have filled up so that
the data cannot be added, situations definitions may not be installed or the
definitions may be incomplete.

If application support has been installed, check the NonResSeedkpp.1og files in
install_dir\cnps\logs for errors (where pp is the two-letter product code of a
monitoring product for which you installed support). Any SQL1_OpenRequest
status=81 errors may indicate that you have a VSAM I/0O error.

Workaround: If you see this error, check data sets whose names end in RKDS* to
determine if they are out of space or have run out of extents. For example,
&rhilev.&rte.&vsamfsv.RKSSSITF, where &rhilev is the VSAM runtime high-level
qualifier, &rte is the RTE name, and &vsamusf is the monitoring server EIB VSAM
low-level qualifier.” Refer to the TEMS started task to see a complete list of VSAM
EIB files.

If the data sets are out of space:

1. Use IDCAMS to copy the data to a flat file.

2. Delete the existing file.

3. Modify the ICAT PP#lxxxx job to increase the size (where PP is the two-letter
product code for the product [DS for a standalone Tivoli Enterprise Monitoring
Server] and xxxx is the RTE JCL suffix) as follows:

a. Invoke the Configuration Tool by executing this TSO command:
EX '&shilev.INSTLIB'

where &shilev is the installation high-level qualifier.

b. On the Configuration Tool MAIN MENU, enter 3 (Configure Products) and
select the product you are want to configure (ITM Tivoli Monitoring
Services or an OMEGAMON XE monitoring agent) on the PRODUCT
SELECTION MENU.

c. On the RUNTIME ENVIRONMENTS (RTES) menu, type B for (Build
libraries) next to the runtime environment in which the monitoring server is
configured, and press Enter. The PP#1xxxx job that allocates the runtime
libraries is displayed.

d. Edit the CYL() parameter in the job to increase the VSAM allocation to
whatever value your DASD can accommodate

4. Submit the PP#1xxxx job.
5. Use IDCAMS to copy data from the flat file to the new VSAM.

6. Reinstall the application support for the product or products whose situations
are missing or not starting correctly.

For instructions on installing application support for a monitoring agent installed
on z/0S, refer to the configuration guide for your monitoring agent.

For instructions on installing application support for monitoring agents installed

on a distributed system (Windows, UNIX, Linux) see the IBM Tivoli Monitoring:
Installation and Setup Guide.
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kshsoap client fails because of missing libraries on UNIX-based

systems

On UNIX-based systems, the CandleSoapClient shell script calls kshsoap binary
from inside, while sourcing the environment. You don not need to run the kshsoap
binary, as required on a Windows platform.

Category and Message field of the universal message does not accept

DBCS

To record a DBCS IBM Tivoli Monitoring V6.1 universal message when a situation
is true, following these steps on Tivoli Enterprise Portal client:

Open the situation editor.

Select a situation.

Select the Action tab.

Check Universal Message button.

Move the cursor to Message or Category text field.
Enable Input Method (IM) for DBCS.

Type a key to input DBCS.

N oo~ =

However, at step Iﬂ nothing is set into the text field because the text field does not
accept double byte characters (DBCS). Disable the Input Method and input only
single byte characters (SBCS).

An error occurs when remotely removing an instance on Windows

The following log shows an error occurs when remotely removing an instance on
Windows.

(4300DFC2.0000-828:kbbssge.c,52,"BSS1_GetEnv") KBB_RAS1="ERROR ">
C:\IBM\ITM\tmaitm6\10gs\KNTRAS1.LOG"
(4300DFC2.0001-828:kbbssge.c,52,"BSS1_GetEnv") CANDLE_HOME="C:\IBM\ITM"
(4300DFCE.0000-828:kdytasks.cpp,1063,

"runCommand") Bad return code (3221225477) from command
"C:\IBM\ITM\TMAITM6\kdy xa.exe -r DB2:FROBERTS:UD

-pc ud" (4300DFCE.0001-828:kdytasks.cpp,1066,"runCommand")

STDOUT [0 characters] is: (4300DFCE.0002-828:kdytasks.cpp,1069,

"runCommand") STDERR [76 characters] is: Error 1ine(391): Unable to delete file:
C:\IBM\ITM\tmaitm6\KUDCMA_DB2.exe
(4300DFCE.0003-828:kdytasks.cpp,3291,"setConfig") KDY1008E Received bad return code
[3221225477] from two-way translator

command [C:\IBM\ITM\TMAITM6\kdy xa.exe -r DB2:FROBERTS:UD -pc ud]
(4300E020.0000-864:knt10agt.cpp,243,"getBinaryPath")

Error retrieving binary path for process ID 8.
(4300E021.0000-864:knt10agt.cpp,243,"getBinaryPath")

Error retrieving binary path for process ID 8

This error can occur when the Tivoli Enterprise Monitoring Server is restarted and
the agent displays offline even though its running because the agent did not
register a heartbeat yet.
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Agents display offline in the Tivoli Enterprise Portal but still fire
situations and the agent logs are report that they are running

This error can occur if the agent names in the group identified contained

embedded spaces. Agent names cannot contain embedded spaces. Edit the agent
names to remove the spaces. The CTIRA_HOSTNAME environment variable on

the agents must include a specific definition for correct agent host names.

The Tivoli Enterprise Portal displays erratic sorting behavior when
removing more than one managed system simultaneously

The Tivoli Enterprise Portal display erratic sorting behavior when you remove
multiple managed systems at the same time after clicking Remove Offline

Systems menu item from the Managed System Status view. Allow the display to

finish updating before attempting another operation.

Multiple events that occur at the same time are loaded too slowly

Manually set the variable KFW_CMW_EVENT_SLEEP in cq.ini on Linux or
kfwenv on Windows to less than 10 seconds:

KFW_CMW_EVENT_SLEEP=5

Desktop client performs poorly after installing Language Packs for IBM
Tivoli Monitoring V6.1

Some configuration settings for the IBM Tivoli Monitoring Warehouse database can
cause performance degradation. Perform the following steps from a db2cmd
prompt to correct the DB2 settings:

1.

Check the Health Monitor configuration:

db2 get dbm config | find /I "health"

Turn the Health Monitor off:

db2 update dbm config using HEALTH_MON OFF

Determine what databases IBM Tivoli Monitoring connects to:
db2 Tist application

Check system buffer pool settings on the Tivoli Enterprise Portal Server and
PROXYWH databases:

a. db2 connect to TEPS db2 select * from SYSIBM.SYSBUFFERPOOLS

b. db2 connect reset

C. db2 connect to PROXYWH

d. db2 select * from SYSIBM.SYSBUFFERPOOLS

(Must be a value of 250.)
Adjust buffer pool settings that are too high:

Note: You must be connected to that database.
db2 alter bufferpool ibmdefaultbp size 250
Disconnect all applications:

db2 force application all

Stop DB2:

db2stop

Start DB2:
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db2start

9. Recycle Tivoli Enterprise Portal Server service.

Existing OMEGAMON product imagery displays after upgrading to IBM
Tivoli Monitoring V6.1

Existing OMEGAMON product imagery displays after upgrading because there it
was cached on the client browser. Use the following steps to correct the problem:

1.

Close all browser instances.

2. Clear the browser cache.
3.
4. Verify the correct images display.

Reload the Tivoli Enterprise Portal browser client.

The Warehouse Proxy Agent started, but does not appear in the
Managed System Status list on the Tivoli Enterprise Portal

The database was either not created in UTF-8 or the DB2CODEPAGE was not
setup in the environment as required for proper operation. You need to set the
DB2CODEPAGE=1208 (no spaces after the 1208) on the system environment After
you have done this, shutdown the Warehouse Proxy Agent, drop the UTFSTEST
table from the database, and then restart the agent.
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Chapter 6. Tivoli Enterprise Portal Server troubleshooting

This chapter describes problems that might occur with the Tivoli Enterprise Portal
Server. If you do find the resolution to a problem you experience with the Tivoli
Enterprise Portal Server in this chapter, see [Chapter 4, “Connectivity]|
|troubleshooting,” on page 63|

Tivoli Enterprise Portal Server performance is slow

If you want to increase the performance of your portal server and you are not
concerned about security, you can disable Secure Socket Layer data encryption on
the portal server. If you do not want to use Secure Socket Layer communication
between IBM Tivoli Monitoring components and the Tivoli Enterprise Portal
Server, use the following steps to disable it:

1. In Manage Tivoli Enterprise Monitoring Services, right-click Tivoli Enterprise
Portal Server.

2. Click Advanced > Edit ENV file.

3. Find the following line:
kfw_interface_cnps_ss1=Y

4. Change the Y to N.

5. Save the file and exit.

6. Click Yes when you are asked if you want to recycle the service.

Cannot create a Tivoli Enterprise Portal Server database

When using DB2 8.1 or 8.2, you must install the correct fix pack versions of DB2 in
order to create a Tivoli Enterprise Portal Server database. These fix pack versions
are:

* DB2 V8.1 with Fix Pack 10 or higher fix packs

* DB2 V8.2 with Fix Pack 3 or higher fix packs

Also, on AIX systems, a failure occurs when you attempt to install a Tivoli
Enterprise Portal Server with a DB2 database. Using the db2 installation User ID
(default is db2instl), do the following:

1. Stop the DB2 server if not already stopped using the following command:

cd /db2inst1l/sql1ib/adm
db2stop

2. Issue the following configuration changes:

export EXTSHM=ON
db2set DB2ENVLIST=EXTSHM
db2set -all

3. Using your preferred editor add the following lines to the /db2inst1/sqllib/
db2profile file:

EXTSHM=0N
export EXTSHM

4. Restart the DB2 server using the following command:

cd /db2inst1l/sql1ib/adm
db2start

5. Restart the Tivoli Enterprise Portal Server using the following command:
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cd /opt/IBM/ITM/bin
./itmcmd agent start cq

You receive a KFW error when a query is sent to more than 200
managed systems

82

You receive the following error when a query is sent to more than 200 managed
systems:

KFWITM217E Request error: Request to xxx nodes exceeds the 1limit of 200.
Please specify a smaller distribution or increase the maximum.

There is a default limit of 200 nodes for any single query for a workspace view. If
the following conditions exist in the query for a workspace view, you must
increase the KFW_REPORT_NODE_LIMIT environment variable for the Tivoli
Enterprise Portal server environment variable as described below:

* The query is assigned to a managed system list that contains more than 200
managed systems.

OR

* More than 200 managed systems are explicitly assigned to a query in any
workspace view.

Under these conditions, you must increase the following Tivoli Enterprise Portal
server environment variable.

KFW_REPORT_NODE_LIMIT=xxx

where xxx is an integer that is equal to or greater than one of the following:
* The number of managed systems defined in a managed system list.
OR

* Explicitly assigned to a query over 200 in a Tivoli Enterprise Portal workspace
view.

You must add the KFW_REPORT_NODE_LIMIT environment variable or remove
the comment marker (#) in the following Tivoli Enterprise Portal Server
environment files, and restart the portal server.

* Windows systems: \ibm\itm\cnps\kfwenv
* Linux or AIX systems: /opt/IBM/config/cq.ini

After you change the KFW_REPORT_NODE_LIMIT variable, you might receive
the following error:

KFWITM217E Request error: SQL1_CreateAccessPlan failed, rc=1.

Typically this problem is caused when too many explicitly defined managed
systems are assigned to a query for a workspace view. The best practice for
resolving this problem is as follows:

1. Create a managed system list that specifies the explicitly defined managed
systems.

2. Remove the explicit assignments from the query.
3. Assign the managed system list to the query.

Alternatively, you can reduce the number of managed systems that you explicitly
define in the query.
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Non-hub situations are not associated at the Tivoli Enterprise Portal
Server level

Only pure hub situations should be associated to the Tivoli Enterprise Portal
Server. However, if you want non-hub situations to be associated at the Tivoli
Enterprise Portal Server level, set the Tivoli Enterprise Portal Server environment
variable: KFW_CMW_SPECIAL_HUB_ENTERPRISE=N.

When non-hub situations are associated at the Tivoli Enterprise Portal Server, they
turn TRUE, meaning they are visible in the situation event console. Through the
situation editor, if you assign all the agents and managed systems lists from a
situation, that situation event continues to appear in the situation event console.

Starting and stopping the Eclipse Help Server

The Tivoli Enterprise Portal Server depends on the Eclipse Help Server to display
standalone help. The Eclipse Help Server is treated in the same way as Tivoli
Enterprise Portal Server - as a server component (as opposed to IBM Tivoli
Monitoring v6.1, where the Eclipse Help Server was treated as an agent).

This change necessitates that the Eclipse Help Server is started whenever the Tivoli
Enterprise Portal Server is started (Eclipse Help Server start failure does not affect
Tivoli Enterprise Portal Server startup). The UNIX command itmecmd agent stop or
start all, does not stop or start the Eclipse Help Server now, since it does not also
stop or start Tivoli Enterprise Portal Server. On Windows systems, starting or
stopping of all components using kinconfg.exe still applies to all components
without exceptions. The Eclipse Help Server, by default, cannot be stopped if the
Tivoli Enterprise Portal Server is running. To stop the Eclipse Help Server, first
stop the Tivoli Enterprise Portal Server. The UNIX command option [-f] itmemd
agent -f stop kf, allows you to stop the Eclipse Help Server unconditionally. On
Windows systems, reconfiguration restarts all components. To reconfigure the
Eclipse Help Server while the Tivoli Enterprise Portal Server is running, restart the
Tivoli Enterprise Portal Server along with the Eclipse Help Server.

Non-root stopping or starting agents causes problems

You might experience issues while starting or stopping agents on servers, when
using a non-root user ID. The following message might be received:

KCIIN1191E Cannot execute product_code stop script.

To avoid this situation, use the root account or an account with granted required
permissions (itmuser group).

Root password is not accepted during non-root Tivoli Enterprise Portal
Server configuration

While configuring the Tivoli Enterprise Portal Server, when using non-root user,
the provided root password is not validated correctly. You should use root account
or an account with granted required permissions (itmuser group).
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Corba user exception is included in the Tivoli Enterprise Portal Server
log when creating situations

When a user creates a new situation, the situation name must be unique. To verify
that the new name is unique, the software attempts to access a situation by the
new name. If the situation is found, then the name is already used and the user
must select a new name. If the request fails, then the name is not already used.
The failure to find the situation name is reflected in the log as the CORBA
exception. The CORBA user exception indicates that the name is unique.
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Chapter 7. Tivoli Enterprise Monitoring Server troubleshooting

This section describes problems that might occur with the Tivoli Enterprise
Monitoring Server and provides resolutions to recover from those problems. It
includes the following sections:

» [“Troubleshooting Tivoli Enterprise Monitoring Server problems on distributed]
systems” on page 85|

+ [“Troubleshooting Tivoli Enterprise Monitoring Server problems on z/OS
systems” on page 91}

Troubleshooting Tivoli Enterprise Monitoring Server problems on
distributed systems

The problems described in this section might occur on distributed systems. For
information about configuring the Tivoli Enterprise Monitoring Server, refer to the
IBM Tivoli Monitoring Installation and Setup Guide .

Tivoli Enterprise Monitoring Server application support will

complete all seeding functions but may crash as the program

is exiting
The Tivoli Enterprise Monitoring Server seeding program that adds Tivoli
Enterprise Monitoring Server application support completes all seeding functions,
but may crash as the program is exiting. This crash has only been observed rarely
during product testing. The IBM Tivoli Monitoring configuration tool checks the
output produced by the seeding functions, and it reports that the Tivoli Enterprise
Monitoring Server application support was added successfully. Since all seeding

functions were completed, the Tivoli Enterprise Monitoring Server tables with
application support are correct and not corrupted.

A core or dump file might be created during the program crash. Creation of a core
or dump file usually depends on if the system has been configured to save crash
information. However, even if the system is configured to save crash data, this
particular crash might not produce a core or dump file.

The Tivoli Enterprise Monitoring Server seeding output files contains information
about the crash. An operating system message indicates the condition that caused
the crash. A sample crash message would be:

signal 11(SIG1_SIGSEGV=29) 0BOO0OO00O00O0000100000000000000F84CD256887 CAES6ESF
400570000000048010000EE5DB656B88B9I655A4F70057220000002200000000000000D8F900572C

F800578C81CO56ACEF0057C04DD256484DD2563EB4B656C04DD2560000000000F5005701
000000000000002000000002000000879D8B558C81CO56A8EF0057

The expected seeding completion messages will follow the crash message. The
normal seeding messages are checked by the IBM Tivoli Monitoring configuration
tool for successful completion of all seeding functions. The crash message always
appears in the Tivoli Enterprise Monitoring Server seeding output even if a core or
dump file is not produced.

Tivoli Enterprise Monitoring Server seeding output files are stored in different files
on UNIX and Windows systems.
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UNIX examples:

$ITM_HOME/1ogs/Node ci_query_Process_ID.log
$ITM_HOME/1ogs/Node_ci_query Process_ID.log

where :
Node The system host name

Process_ID
The program process 1D

Windows example:
C:\IBM\ITM\CNPS\1ogs\seedApp.1og

where:

App  The 3-character product code, such as knt for the Monitoring Agent for
Windows OS

The exact cause of the Tivoli Enterprise Monitoring Server seeding program crash
has not been determined. The program has finished all seeding functions and is
exiting. The crash has only occurred when only a few seeding changes are
required. Seeding functions making many updates to the Tivoli Enterprise
Monitoring Server tables have never resulted in this type of program crash. It is
very possible that there is something unique about the system where this crash has
been seen. The crash has only been observed on one internal test system, which
was a Linux for AMD (Opteron) system.

tacmd createSit does not send errors if you mistype the name
of an attribute

The tacmd createSit command enables you to create situations without using the
Tivoli Enterprise Portal. However, if you mistype the name of an attribute when
using this command, you do not receive an error. The situation is created, skipping
the attribute that you meant to type in the command. If the created situation had,
for example, 6 attributes to monitor, the new created situation has only 5 if you
made a mistake in typing 1 of the attribute names in the command.

If you are using the IBM Tivoli Monitoring command line tacmd createSit function
for situation creation, you can use the Situation editor in the Tivoli Enterprise
Portal to validate your specified attributes.

The system crashes when attempting a bulk import or export
command

You might be attempting to import from a 0-byte XML file. Ensure that the XML
file has content. Also, this can also occur if the file contents are corrupted (if some
expected XML elements are missing).

The Tivoli Enterprise Monitoring Server fails to start, but then
does after a reboot

When your Tivoli Enterprise Monitoring Server does not start up properly and you
see the following messages in the Tivoli Enterprise Monitoring Server logs, you
need to check if anything is using the location server/broker (default is port 1918):
(4703AF9A.002B-4:kdcsuse.c,99,"KDCS_UseFamily") status=1c010005,

"cant bind socket", ncs/KDC1_STC_CANT_BIND_SOCK
(4703AF9A.002C-4:kdebpap.c,125,"KDEBP_AssignPort")
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ip.pipe bound to port 14206: base=1918, 1imit=1918 (4703B06C.0000-
4:kdcclsr.c,562,"rpc__sar"

Endpoint unresponsive: "ip.pipe:#9.42.22.26:1918", 1C010001:1DEGOOOF, 210, 5(2),
FFFF/1, 1.1.1.9, d7273a (4703B0O6F.0000-4:kdc10c1.c,129,"KDCLO_ClientLookup")
status=1c020006, "location server unavailable", ncs/KDC1_STC_SERVER_UNAVAILABLE
(4703B08F.0000-

4:kdcclsr.c,562,"rpc__sar") Endpoint unresponsive: "ip:#9.42.22.26:1918",
1C010001:1DEOOOOF, 32, 5(2), FFFF/2, 1.1.1.9, d7273a
(4703B092.0000-4:kdc10c1.c,129,"KDCLO_ClientLookup") status=1c020006,

"lTocation server unavailable", ncs/KDC1 STC SERVER UNAVAILABLE

You can find out what is using that port, stop the process, and then configure your
system to use another port. You can also reboot the system to clean up any stale
IBM Tivoli Monitoring processes that might be bound to this port.

Remote Tivoli Enterprise Monitoring Server lost connection to

the hub Tivoli Enterprise Monitoring Server and all agents

display offline
Check the log for error messages in the RAS1 trace log that indicate timestamp
problems such as Ignoring invalid TastTimeStamp. This error occurs because you
synchronized the time on the hub and remote Tivoli Enterprise Monitoring Server
with another time server. Restart the Tivoli Enterprise Monitoring Server
experiencing the errors because timers and POSIX (timed waits, for example)
depend on reliable system time.

After the set timeout, the Tivoli Enterprise Monitoring Server
is still pending
When you attempt to stop or start the Tivoli Enterprise Monitoring Server service,

after the set timeout, the Tivoli Enterprise Monitoring Server is still pending the
start or stop. You will receive the following error:

TEMS service is still pending start/stop. Check ITM documentation for more details.

The default time for starting and stopping a Tivoli Enterprise Monitoring Server

service is ten minutes. In the following two situations, this time can be ten times as

long;:

1. If you have a large or complicated infrastructure connected to the Tivoli
Enterprise Monitoring Server.

2. If you have a remote Tivoli Enterprise Monitoring Server, but the hub Tivoli
Enterprise Monitoring Server is offline.

In any other situation, call IBM Software Support.

Providing the wrong path to configuration files during LDAP
configuration causes the Tivoli Enterprise Portal login window
to hang

During Security and LDAP configuration at Tivoli Enterprise Monitoring Server, if
you provide an incorrect path to the key.kdb and key.sth files, the Tivoli Enterprise
Portal login window goes into an indefinite loop. This occurs after restarting the
Tivoli Enterprise Monitoring Server and launching the Tivoli Enterprise Portal
client. Ensure that the provided paths are correct during configuration. The
installer does not check if the file exists under the user-provided path.
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Crash on Linux remote Tivoli Enterprise Monitoring Server
during hub failover to Hot Standby

The monitoring server can use a large number of file descriptors, especially in a
large environment. On UNIX and Linux systems, the maximum number of file
descriptors available to a process is controlled by user limit parameters. To display
the user limits, run the following command:

ulimit -a

The "nofiles” parameter is the number of file descriptors available to a process. For
the monitoring server process (kdsmain), the "nofiles” parameter should be set
larger than the maximum number of agents that will be connecting to the
monitoring server. If the monitoring server is unable to get file descriptors when
needed, unexpected behavior can occur, including program failures. Consider
increasing the value to 1000 file descriptors or more.

There are other user limit parameters that control how much data, stack and
memory are available to a process. For large environments, consider increasing
these memory-related user limit parameters for the monitoring server (kdsmain)
process.

Configuring the user limit parameters usually requires root access, and involves
changing system startup files which are operating system specific. Consult the
operating system manuals for information on how to configure the user limit
parameters.

HUB Tivoli Enterprise Monitoring Server quiesce prevents the
display of the data collected by the attached Tivoli Enterprise
Monitoring Agents

A HUB Tivoli Enterprise Monitoring Server has been running. A shutdown of the
Tivoli Enterprise Monitoring Server and Tivoli Enterprise Monitoring Agents on
the remote systems is in process, but the shutdown takes awhile due to abends in
the remote Tivoli Enterprise Monitoring Server. About 8 or 9 minutes go by before
the HUB Tivoli Enterprise Monitoring Server quiesces. There are a lot of remote
request communication messages in the HUB’s RKLVLOG prior to the QUIESCE,
but no other signs of errors until after the abend. You cannot restart the remote
environments following the quiesce, until after the HUB environment is recycled.

The value of the MINIMUM parameter within the KDSSYSIN member of the
RKANPARU library might need to be increased if the STGDEBUG(X) or
STGDEBUG(Y) parameter is also supplied within KDSSYSIN. If the address space
controlled by this KDSSYSIN member enters a "storage quiesce” state (indicated by
a KLVxxxxx message stating that there is a storage shortage or quiesce in effect),
you should increase the value of the MINIMUM parameter and restart the address
space.

During installation of a remote Tivoli Enterprise Monitoring
Server on a Windows system, the agent support is applied,
but fails

In a multiple-level Tivoli Enterprise Monitoring Server environment, the remote
Tivoli Enterprise Monitoring Servers obtain their agent support from the hub Tivoli
Enterprise Monitoring Server. In order to apply agent support to a remote Tivoli
Enterprise Monitoring Server, the hub Tivoli Enterprise Monitoring Server must be
running and reachable by the remote Tivoli Enterprise Monitoring Server.
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During installation of a remote Tivoli Enterprise Monitoring Server on a Windows
system, the agent support is typically applied. This fails if the hub Tivoli
Enterprise Monitoring Server is unreachable.

During remote Tivoli Enterprise Monitoring Server installation on the Windows
platform, ensure the hub Tivoli Enterprise Monitoring Server is running.

The addSystem command fails with error message
KUICCRO099E

The KUICCRO99E error occurs when at least one incorrect parameter was specified.
When adding managed systems with the addSystem command, ensure that you

* Specify the correct product code.

* Specify a correct node that is online. You can run the listsSystems command to
verify that the node is online.

* Specify correct properties.

tacmd addSystem {-t|--type} TYPE
[{{-n|--node} MANAGED-0S} |
{{-d|--dir|--directory} NODEDIR}}} ]
[{-i|--imagePath} IMAGEPATH]
[{-p|--property|--properties} NAME=VALUE ...]

where:

-tl--type
Specifies the type of managed system to add to the monitoring system. You
can specify a managed system type name or its associated two-character
code. Use viewDepot to display a list of correct managed system types.

-n|--node
Specifies the node to start. A node is identified by the managed operating
system that it contains.

MANAGED-OS
Specifies a correct managed operating systems.

-d | --dir | --directory} NODEDIR
Specified the correct name of the directory that contains the node
components, including the OS agent. This syntax is only correct when the
node is on the local machine.

-il--imagePath
Specified the correct directory that contains agent install images.

-p | --property | --properties
Specifies one or more NAME=VALUE pairs that identify configuration
properties of the new system and their values. Run the

describeSystemType command to determine correct values for the
properties.

UNIX and Linux Tivoli Enterprise Monitoring Server requires
restart if you issue itmemd server stop/start commands when
you are already logged on

When you are logged in but restart the Tivoli Enterprise Monitoring Server using
itmemd server stop or start commands, you receive the message: KUICLR099E:
The command did not complete because of a system error. Refer to the log for
details and contact the system administrator.
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A new login solves the problem and enables the tacmd listsystems command. This
behavior is only seen on UNIX and Linux Tivoli Enterprise Monitoring Servers.
Windows Tivoli Enterprise Monitoring Servers do not need a new login after a
Tivoli Enterprise Monitoring Server restart.

The listSystems command consumes high CPU in enterprise
environments

In enterprise environments with many managed systems, high CPU consumption
is expected behavior for the listSytems command.

Log indicates Hub Tivoli Enterprise Monitoring Servers are
down when they are up

The statusPut process fails periodically, resulting in an incorrect hub status. This
condition is harmless and does not cause any operational change by the software.
The following is an example of the log:

Tue Jun 14 04:27:01 2005 K041039 Error in request sqlRequest. Status= 1103.
Reason= 1103.
(42AEA2E5.0011-6:ko4sndrq.cpp,855,"IBInterface_sqlRequest") Distributed request
failed
(42AEA2E5.0012-6:ko4state.cpp,3519,"IBInterface_sendInsert") send insert has no
request handle error
(42AEA2E5.0013-6:ko4ibput.cpp,1407,"IBInterface:insertProcessing")
General error <1103>
(42AEA2E5.0014-6:ko4ibput.cpp,1657,"IBInterface: :put_sList")
table put error <1103>
(42AEA2E5.0015-6:kodibstr.cpp,1139,"IBStream: :insertDef") IB Err: 1103
(42AEA2E5.0016-6:ko4crtsq.cpp,5547,"IBInterface_refreshIB") Hub is not there
(42AEA2E5.0017-6:kodcrtsq.cpp,5547,"IBInterface_refreshIB") Hub is not there
(42AEA2E5.0018-6:ko4crtsq.cpp,5547,"IBInterface_refreshIB") Hub is not there
(42AEA2E5.0019-6:kodcrtsq.cpp,5547,"IBInterface_refreshIB") Hub is not there
(42AEA2E5.001A-6:ko4crtsq.cpp,5547,"IBInterface_refreshIB") Hub is not there
Tue Jun 14 04:27:01 2005 K041034 Monitoring for situation UADVISOR_OMUNX_SP20S
ended.
(42AEA2E5.001B-6:ko4crtsq.cpp,5547,"IBInterface_refreshIB") Hub is not there
Tue Jun 14 04:27:01 2005 K041036 Monitoring for situation UADVISOR_OMUNX_SP20S
started.
(42AEA3C3.0000-6:kdssqrun.c,2995,"Fetch") QueryRowset error. status 302
Tue Jun 14 04:30:43 2005 K041039 Error in request Notify. Status= 1105.
Reason= 302.
(42AEA3C3.0001-6:kodasync.cpp,4744,"IBInterface: :completeRequest") Close failed
request <55BE90>
(42AEA53C.0000-6:kodibstr.cpp,1090,"IBStream: :insertDef")
Ret code 155 indicates hub connection lost.

Attempting to switch hubs o
r reconnect.
(42AEA53C.0001-6:kdcgbin.c,118,"KDCG_Bind") Using GLB at ip:#9.48.157.26[1918]
(42AEA53D.0000-6:kodcrtsq.cpp,6456,"IBInterface: :restartAl110bjects")
No access list records changed
(42AEA53D.0001-6:ko4mxque.cpp,97,"MutexQueue: :"MutexQueue") Reply store <Fc0798B8>
still associated with request <503D98>: info.re
ply <FCO798B8> info.oType <5546> info.oName <INSERTO4SRV.TNODESTS> info.sitName
<*nonamex>
info.reqState <-1> info.physicall0 <1>
info.loglt <0> info.reqGen <412>
Tue Jun 14 04:37:01 2005 K041034 Monitoring for situation UADVISOR_OMUNX_SP20S
ended.
Tue Jun 14 04:37:02 2005 K041036 Monitoring for situation UADVISOR_OMUNX_SP20S
started.
(42AEA61B.0000-6:kdssqrun.c,2995,"Fetch") QueryRowset error. status 302
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Tue Jun 14 04:40:43 2005 K041039 Error in request Notify. Status= 1105.
Reason= 302.

(42AEA61B.0001-6:kodasync.cpp,4744,"1BInterface: :completeRequest")

Close failed request <61D5EQ>

The Platform view in the Manage Tivoli Enterprise Monitoring
Services panel shows the Tivoli Enterprise Monitoring Server
as running as a 32 bit application, but my agents are shown
as running as 64 bit applications

The Tivoli Enterprise Monitoring Server is a 32 bit application that runs on both 32
and 64 bit operating systems.

Tivoli Enterprise Monitoring Server does not release memory
after running a large SQL query

Running a query for data beyond a 24-hour period consumes high CPU and
memory because the data is not stored on the server and must be retrieved from
the endpoints. All users might experience low system performance while a large
amount of data is retrieved from endpoints.

Tivoli Enterprise Monitoring Server aborts unexpectedly when
exiting the telnet session used to start it

A UNIX-based systems Tivoli Enterprise Monitoring Server aborts unexpectedly
when exiting the telnet session used to start it, either from the client or the
command line. If you start the Tivoli Enterprise Monitoring Server from a Bourne
shell, the Tivoli Enterprise Monitoring Server session terminates when you exit the
telnet session. Do the following so you can exit the telnet session without shutting
down the Tivoli Enterprise Monitoring Server.

1. Enter the Korn shell (ksh).

2. Start Tivoli Enterprise Monitoring Server.

KCIINOO84E Timeout appears while waiting for Tivoli
Enterprise Monitoring Server to start on AIX 5.3

After installation the Tivoli Enterprise Monitoring Server and Remote Tivoli
Enterprise Monitoring Server performance is very slow.

Confirm that the prerequisite software has been installed. The C libraries are
critical for the Tivoli Enterprise Monitoring Server performance at start and stop
times and are important for communication between Tivoli Enterprise Monitoring
Server and Tivoli Enterprise Portal Server.

The installation should check the prerequisites and show information in one of the
logs, such as the candle installation log or the Tivoli Enterprise Monitoring Server
log. If one of the prerequisites is missing the installation will not continue
automatically.

Troubleshooting Tivoli Enterprise Monitoring Server problems on z/0S
systems
This section includes describes problems you might experience with Tivoli
Enterprise Monitoring Server on z/OS and provides resolutions. It covers problems

that occur during run-time that you can resolve with the Installation and
Configuration Assistance Tool (ICAT). For more information about configuring the
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Tivoli Enterprise Monitoring Server on z/OS, refer to the Confiquring Tivoli
Enterprise Monitoring Server on z/OS manual.

The Tivoli Enterprise Monitoring Server start task (CANSDSST
default) encountered error message 'KLVST044 LOADLIST
MEMBER NOT FOUND IN RKANPAR DATASET (KDSLLIST)
KppLLIST KLVST001 CANDLE ENGINE INITIALIZATION
ERROR(S), ABEND U0012' in the RKLVLOG at startup

The Tivoli Enterprise Monitoring Server start task (CANSDSST default)
encountered error message "KLVST044 LOADLIST MEMBER NOT FOUND IN
RKANPAR DATASET (KDSLLIST) KppLLIST KLVST001 CANDLE ENGINE
INITTALIZATION ERROR(S), ABEND U0012" in the RKLVLOG at startup. Ensure
the following conditions:

* The pp#2xxxx RTE Load job ran successfully for this RTE:

1. To perform the RTE Load, place the L option next to the RTE on the
KCIPRTE RTE main menu. The Configuration tool generates the pp#2xxxx
RTE Load job.

2. Submit the RTE Load job. The RTE Load job populates the &rhilev.&RTE.RK*
runtime libraries by copying required elements from the SMP/E target
high-level qualifiers (&thilev.TK*).

* If the RTE Load job was performed, then the job references the &thilev.TK*
SMP/E target datasets from where the members are copied. Ensure the datasets
are correct SMP/E target datasets where &svhilev.CSI is installed.

* If the RTE Load job does not reference any &thilev.TK* SMP/E target datasets or
generates an incomplete RTE Load job, then ensure that the Configuration tool
references the correct SMP/E target high-level qualifiers. The Configuration tool
only generates appropriate IEBCOPY TK*-->RK* steps for SMP/E target datasets
that it can access.

Use the following steps to ensure that the Configuration tool references the correct
SMP/E target high-level qualifiers:

1. From the Configuration tool main menu, select Install products or
maintenance > Set up product or maintenance environment >Specify
environment information.

2. Verify that the values for the high-level qualifiers are correct. If the high level
qualifiers values are not the correct, use the following steps to unlock the
SMP/E high-level qualifiers:

a. Run &shilev.INSTLIB.

b. On the Installation tool main menu, select Services and utilities > Unlock
SMP/E high-level qualifiers.

C. Specify Y on the Unlock SMP/E high-level qualifiers? field.

d. Edit the high-level qualifier modifications on the Specify installation
environment information panel.

3. Go to the RTE main menu and regenerate the RTE Load job.

Cannot encrypt text. A call to CSNBSYE failed. Cannot encrypt
contents of keyfile

On the Specify configuration values option on the "Configure the Tivoli
Enterprise Monitoring Server main menu, you can provide the Integrated
Cryptographic Service Facility (ICSF)-related values for password encryption.
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These values generate the KAES256 step in the Tivoli Enterprise Monitoring Server
"Create runtime members” job. To create the encryption key file (KAES256) in the
&rte. RKANPAR library. If within this step, the error occurs, this message indicates
that ICSF is not configured correctly in your system. Consult with your system
administrator. Refer to the Configuring Tivoli Enterprise Monitoring Server on z/OS
manual for more information about configuring a z/OS Tivoli Enterprise
Monitoring Server and the security-related information.

The error "KLVST005 MVS JOBSTEP AUTHORIZATION
REQUIRED KLVST001 CANDLE ENGINE INITIALIZATION
ERROR(S), ABEND U0012 CSV019I - Required module
KLVSTWTO not accessed, it is not APF Authorized
(RKANMODL) CSV028I - ABEND 306-0C" occurs in the z/OS
Tivoli Enterprise Monitoring Server RKLVLOG during startup

Ensure that the load libraries, including RKANMOD and RKANMODL are
correctly APF-authorized. Additionally, in the Configuration tool Complete the
configuration step, specify that any runtime libraries concatenated in the STEPLIB
DDNAME and in the RKANMODL DDNAME of the Tivoli Enterprise Monitoring
Server started task must be APF-authorized.

The error "KLVSQO000 carved mode in effect for extended
storage” occurred in the RKLVLOG during startup

You can increase the MINIMUMY() storage settings in the &rhilev.&rte.
RKANPAR(KDSSYNSIN) member if IBM Support personnel instructs you to do so.
The default value for the MINIMUMY() parameter is MINIMUM(150000,X). Use the
following steps to increase this value or any other storage-related parameters:

1. On the Configure the Tivoli Enterprise Monitoring Server main menu, select
the Specify configuration values option.

2. On the next panel, navigate to the F5=Advanced key.
3. Do the following on the Specify Advanced Configuration Values:
 Edit the Minimum extended storage field to 300000 K.

 Edit the Maximum storage request size fields to 16 (Primary) and 23
(Extended).

4. On the Configure the Tivoli Enterprise Monitoring Server main menu, select
the Create runtime members option to generate the DS#3xxxx Create runtime
members job. Submit the job and verify good condition codes.

5. Recycle the Tivoli Enterprise Monitoring Server.

Error message 'KDSMAO013 OPEN VTAM for VDM1APPL failed
with status 8' occurs in the Tivoli Enterprise Monitoring
Server start task (CANSDSST default)

Error message "KDSMAO013 and the task ends in "ABEND=5000 U0200
REASON=00000000 KDSMAOQ03 Tivoli Enterprise Monitoring Server data collection
server ended successfully”. Ensure the following:

1. The KDS_VTAMID= parameter exists in the &rhilev.&rte. RKANPAR(KDSENYV)
member. If it does not exist, then ensure that the Tivoli Enterprise Monitoring
Server is configured correctly. Refer to the "Configuring Tivoli Enterprise
Monitoring Server on z/OS manual for more information about configuring a
z/0OS Tivoli Enterprise Monitoring Server.
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2. If the KDS_VTAMID= VTAM APPLID exists, ensure that the Tivoli Enterprise
Monitoring Server VTAM major node is activated correctly.

For more information, review the Complete the configuration option on the
Configure the Tivoli Enterprise Monitoring Server main menu.

94  IBM Tivoli Monitoring: Problem Determination Guide



Chapter 8. Monitoring agent troubleshooting

This chapter describes problems you might experiences with the monitoring agent
deploy tool and monitoring agents. If you do not find the resolution to a problem
you experience with a monitoring agent, refer to the agent-specific user guide
listed in{“IBM Tivoli Monitoring library” on page 159|section of this book.

Agent upgrade and restart using non-root

The monitoring agent can run using a non-root user ID on UNIX and Linux
systems. This can be done by running the itmemd agent start command while
logged in as a non-root user, and this can be done remotely by deploying the agent
using the Run As option on the GUI or using the _UNIX_STARTUP_.Username
option on the tacmd addSystem command line. If the agent is running using a
non-root user ID, and then the agent is upgraded, restarted remotely, restarted as a
result of a system reboot, or the itmemd agent start is run using the root user 1D,
then the monitoring agent subsequently runs as the root user. To confirm the user
ID that the monitoring agent is using, run the following command:

itm_install/bin/cinfo -r

If the agent is using root, and that is not the desired user ID, then use the
following steps to restart the agent:

1. Log in as root.

2. Run the itmemd agent stop command.

3. Log in (or 'su’) to the user ID that you want the agent to run as.
4.

Run the itmemd agent start command.

If the agent was running as root because of a system reboot, then edit the startup
file using the following steps so that the appropriate user ID is used the next time
the system is rebooted:

1. Look at install_dir/registry / AutoStart, and get NUM.
2. Edit the autostart for your operating system:
The location of the startup file is platform dependent as follows:
* AIX: /etc/rcitmNUM
¢ HP-UX: /sbin/init.d/ITMAgentsNUM
¢ Linux: /etc/init.d/ITMAgentsNUM
* Solaris: /etc/init.d/ITMAgentsNUM
3. Add entries for your operating system using the following command:

/usr/bin/su - instancename

-c "install_dir/bin/itmemd agent
-h install_dir

-0 instancename

start product_code"

Where:

instancename
Name of the instance

install_dir
Name of the directory
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product_code
2-character product code for the agent, for example, agent_code for the
monitoring agent

Examples:
* For AIX, add entries with the following format:

su - USER -c " /opt/IBM/ITM/bin/itmcmd agent
-0 INSTANCE start agent_code"

Where:
USER Name of the user
INSTANCE

Name of the instance

¢ For Linux, HP_UX, and Solaris, add entries with the following format:
/bin/su - USER -c " /opt/IBM/ITM/bin/itmcmd agent

-0 INSTANCE start agent_code >/dev/null 2>&1"
Where:
USER Name of the user

INSTANCE
Name of the instance
4. Repeat Steps through@ for all occurrences of stop.
5. Save the file.

The command tacmd restartAgent fails if the agent is already stopped
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If the tacmd restartAgent command is issued against an agent that is stopped, it
will generate an error message:

# /opt/IBM/ITM/bin/tacmd restartagent -n zpmaix13:KUX -t ul

KUICRAGO6I: Are you sure you want to restart the UL agent(s) that manage
zpmaix13:KUL?

Enter Y for yes or N for no: Y
KUICRAGO7I: Restarting UL agent(s).

KUICRAGO9E: A problem occurred while restarting UL - refer to the following error
returned from the server:

The monitoring server encountered an error while restarting the managed system.

If the error information returned from the server is not sufficient to help you
resolve the error, contact IBM Software Support.

The command /opt/IBM/ITM/bin/CandleAgent -h /opt/IBM/ITM -c stop ul did not start
or stop agent.
The command returned a return code.

Enable Deployment trace logging on the agent machine. Contact Customer Service
for details on this procedure. Collect the following log files

On Windows the Tog kdsmain.msg log is located in the {CANDLEHOME}\CMS
directory and {hostname} ms_{timestamp}-XX.log files are Tocated in
CANDLEHOME\1ogs directory.

On Unix-Based systems the logs {hostname} {timestamp}.log and
{hostname} ms_{timestamp}-XX.log is located in the {CANDLEHOME}/logs directory.
On the target Managed System Node machine collect the following log files.

On Windows the logs kdyproc_rasl_{timestamp}.log and {hostname} nt_kntcma_
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{timestamp}-XX.log are Tocated in the {CANDLEHOME}\tmaitmé6\logs directory.
On Unix systems the logs kdyproc_rasl {timestamp}.log and {hostname} _
ux_kuxagent {timestamp}-XX.log is Tocated in the {CANDLEHOME}/logs directory.
On Linux systems the logs kdyproc_rasl {timestamp}.log and {hostname}_
1z_klzagent_{timestamp}-XX.log is Tocated in the {CANDLEHOME}/logs directory.
Refer to IBM Tivoli Monitoring v 6.2 Problem Determination Guide
for more information.

The user can verify the agent is stopped by running "tacmd listSystems”:
# /opt/IBM/ITM/bin/tacmd 1istsystems

Managed System Name Product Code Version Status
zpmaix13:KUL UL 06.20.00.00 N
zpmaix13:08 08 06.20.00.00 Y
amshpl6.tivlab.raleigh.ibm.com:K UX 06.20.00.00 Y
TEMS_zpmaix13 EM 06.20.00.00 Y

To start the agent, user can issue "tacmd startAgent’:
/opt/IBM/ITM/bin/tacmd startagent -n zpmaix13:KUX -t ul

Using the kinconfig command and remotely starting, stopping or
recycling agents fails on Windows 2000 systems

If the endpoint is a Windows 2000 systems, you must reboot the system after the
Monitoring Agent for Windows is installed to allow environment variables that
have been set by the OS Agent’s installation to take effect for other processes to
use these variables.

Agent configuration failed on remote deploy while using single quotes
for configuration properties

You cannot provide a deployment or configuration property with single quote
characters embedded within the properties. For paths with spaces in them, wrap
the entire property in single or double quotes. The following examples are valid:

DBSETTINGS.SYBASE=/data/sybase
'DBSETTINGS.SYBASE=/data/sybase’
"DBSETTINGS.SYBASE=/data/sybase"

Whereas this example is NOT valid:
DBSETTINGS.SYBASE="'/data/sybase’

New attributes

missing

When viewing a workspace, not all of the attribute group’s attributes are displayed
in a table view. To see the new attributes in a table, you must create a new query
to retrieve the new attributes, and you must create a new workspace to use the
new query.

Agent deploy operations are not completing before the TIMEOUT

expires

When running agent deploy operations, TIMEOUTs can occur because of slow
network connections or slow hardware. The agent deploy operations can complete
if you increase the TIMEOUT value. Some operations can complete even after a
timeout is returned.
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Table 18. Resolutions for agent deploy operations that TIMEOUT

Problem Resolution
KDY0014E Increase the Tivoli Enterprise Monitoring Server timeout value to 1200
message seconds (TIMEOUT=1200). The default is 600 seconds.
On Windows: installation_dir\CMS\KBBENV.
On UNIX-based systems: installation_dir\host_name_ms_Tivoli
Enterprise Monitoring Server_ID.config.
KDY1009E Increase the OS agent timeout to 600 seconds (TIMEOUT=600). The
KDY1017E default is 300 seconds.
KDY1018E
KDY1022E On Windows: installation_dir\CMS\KNTENV.
KDY1025E ) ) ) . . .
KDY1030E On UNIX-based systems: installation_dir\ux.ini. On Linux, set it in
KDY1033E installation dir\1z.ini. The value must be set in seconds:

A system error
occurs when
running a tacmd
command.

Increase value for the TACMD_TIMEOUT environment variable to 60
minutes.

On Windows:

Enter the following command:

set tacmd timeout=60

Note: Be aware that this command does not affect the statement for
"TACMD_TIMEOUT=x" in the KUIRAS1.log, but it does indeed change
the timeout period.

You can also change the environment variable in the kui.env file on
Windows systems and the tacmd shell script on non-Windows systems.
Both of these files can be found in the CANDLEHOME /bin directory.

A failure occurs
when deploying
an agent from the
Tivoli Enterprise
Portal.

The Tivoli Enterprise Portal Server times out waiting for deployment
action to complete. The default timeout is 600 seconds. You can change
the timeout setting to KFW_SQL1_ASYNC_NOTIFY_MAX_WAIT in
kfwenv:

KFW_SQL1_ASYNC_NOTIFY_MAX _WAIT=1000

KUICCNO68E
error when
running tacmd
createnode.

Increase the timeout value in seconds by adding "-o TIMEOUT=3600"
to the createnode command.

Deploy cannot tell if the install failed

When installing an OS Agent on an endpoint that already has an OS Agent, the
installation program does not write out a C:\IBM\ITM\InstalllITM\ Abort IBM
Tivoli Monitoring 20070924 1319.log in the createNode specified directory. It writes
messages to the existing C:\data\itm61_oqv_ga2_koy\InstalITM\IBM Tivoli
Monitoring 20070924 1319.log log file and reports the error in that log file.

After remote deploy failure, cannot find the kuiras1.log file
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On Windows systems, the kuirasl.log file is created in the %Candle_Home% \bin
directory rather than the correct location %Candle_Home%\logs.
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addBundles command times out

When using the addBundles command to add bundles to a depot, the command
might time out. The default timeout is 600 seconds (10 minutes). The following
message is returned after successful execution:

KUICABO22I: The following bundles were successfully added to the
C:\IBM\ITM\CMS\depot\depot

If the addBundles command times out, this message is not returned. Set the
TIMEOUT environment variable to more than 600 before running the addBundles
command. For example:

#set TIMEOUT=1800

You can also reset the TIMEOUT after the command times out. Then run the
addBundles command.

You can also change the LAN linkspeed and duplex setting from auto detect to
100Mbps/Full Duplex. Then re-start the addbundle process.

createNode command fails

[Table 19 on page 99 provides information to help you recover when the createNode
command fails.

Table 19. createNode command fails

Symptom Resolution

The createNode Because tacmd on UNIX and Linux is a wrapper script for the
command fails on a |createNode command, the character "\" is removed from the
Windows OS agent |command. Specify the path with the "-d” option using either "/" or
from a UNIX or "\\\\" when you deploy a Windows OS agent from a UNIX/Linux
Linux host when host. The following examples display the correct usage to install the
using the "-d” option | Windows OS agent in the path C:\ITM61\WIN\OSAgent:

and "\" as the path

separator. Windows
parator C:/ITM61/Win/OSAgent
UNIX or Linux
¢\ \N\NAITM6INNNAWIn\ \\\OSAgent
createNode On Windows systems, ensure that there are no trisvc* services
command fails on running. If there are trisvc* services running, stop them and remove
Windows system. them. The trisvc binary is used to run remote executions on

Windows. Ordinarily it is automatically removed after an operation,
but in rare cases, that removal fails and the existence of the service
might cause subsequent operations to fail. Run the installation
again, adding --option JLOG_LEVEL=DEBUG_MAX to the command
string to increase the amount of debugging information in the trace
log by a significant amount. After the operation completes, examine
the trace log for messages that indicate a reason for the failure. If
access to the target computer is available, run the installation again,
adding --option AUTOCLEAN=NO to the command string. On the
remote system, examine the contents of the “CSRIO directory in the
system temporary directory searching for information that indicates
the reason for the failure. When the investigation is complete, all
~CSRI# directories must be completely removed.

Chapter 8. Monitoring agent troubleshooting 99



100

Table 19. createNode command fails (continued)

Symptom

Resolution

createNode
command fails with
return code: 2.

The createNode command fails and there are errors in the
$CANDLEHOME/logs/trace_cn.log file. There might be a corrupt
or inconsistent IBM Tivoli Monitoring software depot.

The agent installation appears to have failed.
Return code: "2" (0 was expected)

Remove all software from depot directory, recreate the depot, and
deploy the OS agent again.

createNode on a
Windows system
fails to connect with
the KUICCNO35E
message.

Determine if Server Message Block (SMB) signing is required on the

target system by looking at the following security setting:

1. From a Windows start menu, select Program Files > Control
Panel > Administrative Tools > Local Security Policy Under
Local Policies > Security Options.

2. Ensure the following Security Settings are disabled:
* Server: Digitally sign communication (always)
* Client: Digitally sign communication (always)
If the system belongs to a domain and these settings are defined

at the domain level, you must change them in the Domain
Security Policy.

Note: Disabling these settings reduces the security of the SMB
protocol. See http:/ /support.microsoft.com/?kbid=887429 for more
information about SMB signing.

The createnode
command fails to
connect to a
UNIX-based systems
target system

If you run the createnode command on a machine with only sshd
running, you must configure the sshd to allow password
authentication. Do the following steps to enable password
authentication:

1. Edit the /etc/ss/sshd_config file on the target computer.
2. Locate the following line:

PasswordAuthentication no
3. Change the no to yes and save the file.

4. Restart the daemon.
Note: If you are using private key authentication in your
environment, you do not need to set SSH to permit password
authentication.

If the createnode command fails to connect after enabling password
authentication, run the following command with each protocol (ssh,
rexec, rsh) specified explicitly with the -h parameter to determine
which protocol is used for the connection attempt:

createnode -h [{ssh|rexec|rsh}://Ihost[:port] ...

Errors are logged in SCANDLEHOME /logs/trace_cn.log.

createnode command
does not handle or
convert backslashes
on Windows systems

Specify the path within double quotes and add a double slash in the
path name instead of single back slash.
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An agent does not display in the Tivoli Enterprise Portal or in the
output from the listSystems command

If you have multiple instances of a monitoring agent, you must decide how to
name the monitoring agents. This name is intended to uniquely identify that
monitoring agent. The agent's default name is composed of three qualifiers:

¢ Optional instance name
* Machine network hostname
* Agent product node type

An agent name truncation problem can occur when the network domain name is
included in the network hostname portion of the agent name. For example, instead
of just the hostname myhostl being used, the resulting hostname might be
myhostl.acme.north.prod.com. Inclusion of the network domain name causes the
agent name in the example above to expand to
SERVER1:myhostl.acme.north.prod.com:KXX. This resulting name is 39 characters
long. It is truncated to 32 characters resulting in the name
SERVER1:myhostl.acme.north.prod.

The agent name truncation is only a problem if there is more than one monitoring
agent on the same system. In this case, the agent name truncation can result in
collisions between agent products attempting to register using the same truncated
name value. When truncated agent names collide on the same system, this can lead
to Tivoli Enterprise Monitoring Server problems with corrupted EIB tables. The
agent name collision in the Tivoli Enterprise Monitoring Server might cause a
registered name to be associated with the wrong product.

In general, create names that are short but meaningful within your environment.
Use the following guidelines:

* Each name must be unique. One name cannot match another monitoring agent
name exactly.

¢ Each name must begin with an alpha character.
* Do not use blanks or special characters, including $, #, and @.
* Each name must be between 2 and 32 characters in length.

* Monitoring agent naming is case-sensitive on all operating systems.

Create the names by completing the following steps:
1. Open the configuration file for the monitoring agent, which is located in the
following path:

* On Windows: install_dir\tmaitmé\Kproduct_codeCMA.INI. For example, the
product code for the Monitoring Agent for Windows OS is NT file name for
is KNTCMA.INI.

* On UNIX and Linux: install_dir/config/product_code.ini and
product_code.config. For example, the file names for the Monitoring Agent
for UNIX OS is ux.ini and ux.config.

2. Find the line the begins with CTIRA_HOSTNAME-=.

3. Type a new name for host name that is a unique, shorter name for the host
computer. The final concatenated name including the subsystem name, new
host name, and AGENT_CODE, cannot be longer than 32 characters.
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Note: You must ensure that the resulting name is unique with respect to any
existing monitoring component that was previously registered with the
Tivoli Enterprise Monitoring Server.

4. Save the file.
5. Restart the agent.

6. If you do not find the files mentioned in Step 1, perform the workarounds
listed in the next paragraph.

If you do not find the files mentioned in the preceding steps, perform the

following workarounds:

1. Change CTIRA_HOSTNAME environment variable in the configuration file of
the monitoring agent.

* Find the KAGENT_CODEENYV file in the same path mentioned in the
preceding row.

* For z/OS agents, find the RKANPAR library.

¢ For i5/0S agents, find the QAUTOTMP/KMSPARM library in member
KBBENV.

2. If you cannot find the CTIRA_HOSTNAME environment variable, you must

add it to the configuration file of the monitoring agent:

* On Windows: Use the Advanced > Edit Variables option.

* On UNIX and Linux: Add the variable to the config/product_code.ini and to
config/product_code.config files.

* On z/0OS: Add the variable to the RKANPAR library, member
Kproduct_codeENV.

* On i5/0S: Add the variable to the QAUTOTMP/KMSPARM library in
member KBBENV.

3. Some monitoring agents (for example, the monitoring agent for MQ Series) do
not reference the CTIRA_HOSTNAME environment variable to generate
component names. Check the documentation for the monitoring agent that you
are using for information on name generation. If necessary, contact IBM
Software Support.

Issues with starting and stopping an agent as a non-Administrator
user

You might experience issues with starting and stopping an agent as a
non-Administrator user. This issue is caused because of improper permissions set
for the hostname_pc.run file.

That file is created or modified every time an instance is started or stopped. All
instances must use the same user ID.

UNIX-based systems Log agent was deployed, configured, and started
but returns the KFWITM290E error
The Tivoli Enterprise Monitoring Server is timing out waiting for deployment

action to complete. The default timeout is 600 seconds. You can change the timeout
setting to KFW_SQL1_ASYNC_NOTIFY_MAX_WAIT in kfwenv.

KFW_SQL1_ASYNC_NOTIFY_MAX_WAIT=1000
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KDY1024E error displays when configuring the run-as user name for
an agent

The error message KDY1024E displays when configuring the run-as user name for
an agent when the UNIX-based systems monitoring agent was installed as a
non-root user. For UNIX-based systems, you can only configure the run-as user
name if the UNIX-based systems/UNIX-based systems monitoring agent was
installed using the root user. In this case, leave the entry for the run-as user blank
or set the run-as user to the same user ID used to install the UNIX-based systems
monitoring agent.

Interface unknown messages in ras1 logs

Interface unknown messages appear in the rasl log. For example:

(46CB65C1.0001-F:kdcsdrg.c,466,"do_request") Interface unknown
684152a85219.02.c6.d2.2d.fd.00.00.00,

activity c638270e4738.22.02.09.2a.15.06.28.a2,

7509.0

These are issued to alert you that some set components are driving RPC requests
to a server that is not setup to handle that request. Often, this occurs when the
Warehouse Proxy Agent is not setup on a fixed port number. For information on
how to setup the Warehouse Proxy Agent, see the IBM Tivoli Monitoring
Installation and Setup Guide.

The Warehouse Proxy Agent fails

If the Warehouse Proxy Agent fails, this might be due to the port numbers are not
the same every time you restart the Warehouse Proxy Agent. See the IBM Tivoli
Monitoring Installation and Setup Guide for instructions on how to setup a static
port number for the Warehouse Proxy Agent.

The Tivoli Data Warehouse fails and you either lose data or have
memory problems

On distributed systems, the data is written to the local file system. When the
Warehouse Proxy Agent receives the data, it copies the data to the Tivoli Data
Warehouse. If the Tivoli Data Warehouse is not available, the collected data could
take up a significant amount of memory.

On z/0S systems, the data is written to the persistent datastore. Maintenance
procedures must be installed and workable to handle cases other then simply
saving copies of the data. These procedures are used to recover corrupted datasets
and to handle migration issues. When the persistent datastore is started, it looks at
the status of a dataset and determines if it has corrupted data. If there is
corruption, it launches maintenance with the options to export the data, reallocate
and initialize the dataset, and then restore the exported data. Also when the
persistent datastore is started, it compares the information in the dataset against
the current configuration to see if any table structures have changed. When it
detects a change, it goes through the same process that effectively does a database
REORG. If you do not have the maintenance procedures installed and usable, the
datasets might become unusable, and therefore there might be a loss of data.

If maintenance is set-up so that the data is rolled-over, the data that would have
been copied to the Tivoli Data Warehouse is copied over after a set period of time.
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You can set maintenance to roll off the data. For more information on rolling of
this data so that it is backed up, see the IBM Tivoli Monitoring Configuring Tivoli
Enterprise Monitoring Server on z/OS Guide.

If maintenance is not performed, then the agent stops writing to the Tivoli Data
Warehouse until initialization is performed. Because the agent has stopped writing,
the data is there "forever” until you re-initialize and start again writing from the
top of the first dataset.

If persistent datastore maintenance is allowed to proceed automatically as it is
intended, then the agent starts writing from the top of the first persistent datastore,
therefore wrapping occurs.

The persistent datastore is set up to allow for 24 by 7 data collection even if
maintenance is not specified when configuring the product in ICAT. There are
typically 3 datasets, though having more is allowed.

The minimum of 3 datasets allows for continuous collection, the normal case is
that one dataset is empty, one or more are full, and one is active. When an active
dataset becomes full, the empty dataset is activated for continued writing. When
the persistent datastore detects that there are no empty datasets left, it finds the
one with the oldest data and maintains it. If the BACKUP or EXPORT options are
not specified, maintenance is done within the persistent datastore to initialize the
dataset so that its status changes from full to empty. If BACKUP or EXPORT are
specified, a job runs to save the data, then the dataset is initialized and marked as
empty. If the BACKUP or EXPORT was specified, but the maintenance jobs fail to
do their job, the recording would stop in the persistent datastore. In this case,
datasets are taken off-line until there are no more available datasets for reading or
writing.

Note: If you allocate persistent datastores that fit more than 24 hours worth. The
agent initializes and writes as much data as it can fit in the persistent
datastores, 24 hours or more. The Tivoli Enterprise Portal, for short term
history display, only pulls up 24 hours worth of data. The warehouse can
archive ALL the data in the persistent datastores, regardless if it has been 24
hours or more worth of data.

If you create a Tivoli Enterprise Portal query that is over 24 hours, then the
warehouse fulfills that request regardless if the data is in the online persistent
datastores.

Also, because the agent or Tivoli Enterprise Monitoring Server reads the entire
persistent datastores at initialization time, you should not allocate very large
persistent datastores to potentially store more than 24 hours. That increases the
Tivoli Enterprise Monitoring Server and agent startup time. As mentioned above,
the agent writes to it, but the Tivoli Enterprise Portal only displays 24 hours from
it. The warehouse processing reads all the data in the persistent datastores (24
hours or more), but there is a trade-off in Tivoli Enterprise Monitoring Server and
agent startup time. It is always best to calculate space for 24 hours as best as
possible.

As far as the potential of losing historical data, if the warehouse is down over 24
hours, that is a potential problem, assuming the persistent datastore’s backup
processing is functioning and, therefore, the agent does not stop writing to the
persistent datastores.
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Since you have the choice of collecting history data at the Tivoli Enterprise
Monitoring Server or the Tivoli Enterprise Monitoring Agent, the persistent
datastore should be defined in both places. If you are 100% sure that you will
always collect at the Tivoli Enterprise Monitoring Agent or always collect at the
Tivoli Enterprise Monitoring Server then you can optionally define the persistent
datastore in only one location. Note that many configuration issues occur because
the person installing the product selects one location for the persistent datastore
and sometime later someone else enables history collection for the other location.

Error list appears in warehouse logs

The following error list appears in the warehouse logs:

== 25 t=Thread-1 com.ibm.db2.jcc.c.DisconnectException:
A communication error has been detected.

Communication protocol being used: T4Agent.sendRequest().
Communication API being used: OutputStream.flush().

Location where the error was detected:

There is no process to read data written to a pipe.

Communication function detecting the error: *. Protocol specific error codes(s)
TCP/IP SOCKETS  DB2ConnectionCorrelator: G92A17E8.C3D2.071018074633
at com.ibm.db2.jcc.b.a.a(a.java:373)

at com.ibm.db2.jcc.b.a.y(a.java:346)

at com.ibm.db2.jcc.b.a.1(a.java:298)

at com.ibm.db2.jcc.c.j.c(j.java:234)

at com.ibm.db2.jcc.c.uf.1b(uf.java:1934)

at com.ibm.db2.jcc.c.uf.addBatch(uf.java:1348)

at com.tivoli.twh.khd.khdxjdbc.addBatch(khdxjdbc.java:1290)

Check the ethernet adapter settings on both the client and server. There are
problems if the adapter is set to Auto and the switch is set to 100/Full Duplex.

The Warehouse Proxy Agent leaks memory when either the User ID or
password is incorrect

A memory leak can occur if the Warehouse Proxy Agent User ID or password is
incorrect, and this leak is most probably occurring in the ODBC layer.

When configuring the Monitoring Agent for Sybase and the Warehouse
Proxy Agent, receive message to use CandleManage

The CandleManage command has been deprecated. The message should reference
the ./itmcmd manage command.

listSit command with the type option fails with a KUIC02001E message
on Japanese Systems

Edit the kuilistsitVld.xml file to replace the following text:

<Type argl="-t" arg2="--type" Type ="String" ValidationRegExp=
"[-A-Za-z0-9 _/()\&%.]" Required="Y"/>

with the following text:

<Type argl="-t" arg2="--type" Type ="String" ValidationRegExp=
"[-A-Za-z0-9 _/()\%.]" Required="Y"/>
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New agents do not display in the Tivoli Enterprise Portal navigator

The Tivoli Enterprise Portal navigator does not update automatically when an
agent is installed or uninstalled from to the managed system. You must refresh the
navigator to display changes. Do the following to refresh the navigator from the
Tivoli Enterprise Portal menu:
* Press the F5 key on your keyboard.

—OR-
e Click View > Refresh.

An agent does

not start on a Solaris system

The log shows error messages such as the following:

(42D58E75.001B-1:kglcry.c,204, " "checkICCStatus") ICC error detected
(42D58E75.001C-1:kglcry.c,172,"printICCStatus") majRC=2, minRC=3, mode=0
(42D58E75.001D-1:kglcry.c,174,"printICCStatus") desc=Unable to Tload
/icc/oss1ib/libcrypto.so0.0.9.7
(42D58E75.001E-1:kglcry.c,2196,"initializeICC") ICC attachment failed

These log messages indicate that you are running the IBM Tivoli Monitoring agent
on Solaris 2.9 hardware, which is not supported. Install the IBM Tivoli Monitoring
agent on Solaris 2.10 hardware.

An agent displays unavailable in the Tivoli Enterprise Portal

The agent is not online. Do the following to ensure the agent is online:
* Check the agent log for data communication errors.

¢ Check the managed system status in the Tivoli Enterprise Portal.

* Ensure that the agent process started.

* Check the Tivoli Enterprise Monitoring Server kfwrasl.log for errors.
* Check the Tivoli Enterprise Monitoring Server kfwrasl.log.

CTIRA_HOSTNAME has no effect on log file names

Setting CTIRA_HOSTNAME with the virtual hostname shows the agent on the
workspace as one entity no matter the node on which it is running. However, the
setting has no effect on the log file names. These names still use the local
nodename instead of the virtual hostname.

Summarization and Pruning Agent in large environment

The following index and tuning changes were made to reduce Summarization and
Pruning run time in an environment with 10,000 agents. The database server was
DB2 running on AIX:
* Async IO changes to AIX
Change Minimum Servers and Maximum Servers from 1 and 10 to 40 and 80. A
reboot is required.
¢ Change the DB2MAXFSCRSEARCH value, using the following command:
db2set DB2MAXFSCRSEARCH=2

* Enable the DB2_USE_ALTERNATE_PAGE_CLEANING value, using the
following command:

db2set DB2_USE_ALTERNATE_PAGE_CLEANING=ON
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* Enable the DB2_PARALLEL_IO value (with the number of disks in the largest

array):
db2set DB2_PARALLEL_I0=x:9
* Increase the DBHEAP value from 1800 to 3000 by updating the database

configuration for the WAREHOUS database by using the following command:

update database config for WAREHOUS using dbheap 3000

* Increase the LOGBUFSZ value from 1024 to 2048 by updating the database
config for the WAREHOUS database by using the following command:

update database config for WAREHOUS using Togbufsz 2048

* Increase the prefetch size from AUTOMATIC (32) to 288 by altering the
tablespace userspacel by suing the following command:

alter tablespace USERSPACEL prefetchsize 288
e Drop all HX2 and DX2 indexes from aggregate tables.
¢ Drop all of the indexes on the WAREHOUSELOG table:

drop index "ITMUSER"."WHLOG_IDX1";
drop index "ITMUSER"."WHLOG_IDX2";
drop index "ITMUSER"."WHLOG_IDX3";

* Create this index on the WAREHOUSELOG table. This index greatly improves

SELECT statements made during pruning of the WAREHOUSELOG.:

CREATE INDEX "ITMUSER "."WHLOG_IDX1" ON "ITMUSER "."WAREHOUSELOG"
("ORIGINNODE" ASC, "EXPORTTIME" ASC) ALLOW REVERSE SCANS;

¢ In the Summarization and Pruning Agent configuration file, increase the
KSY_MAX_ROWS_PER_TRANSACTION value from 1000 to 3000 in the file,
ksy.ini.

* From the root user, change the Ulimit file parameter by using the following
command:
ulimit -f unlimited

¢ Increased the NUM_IOCLEANERS value from 14 to 24.

The Summarization and Pruning Agent is logging "Interface unknown”

messages

This happens when you have the Warehouse Proxy Agent and some other
component on the same system and you shutdown the Warehouse Proxy Agent

and start the other component, which may re-use the same port previously used
by the Warehouse Proxy Agent. These messages are benign but end up filling the
logs until the Warehouse Proxy Agent is restarted, and the synchronization of the
Warehouse Proxy Agent location is sent to all Tivoli Enterprise Monitoring Servers.

The Summarization and Pruning Agent and the Warehouse Proxy
Agent do not work with DB2 9.1 Fix Pack 2

Do not try to use these agents with this version of DB2.

An error of 'can bind a LONG value only for insert' appears

The following message appears in the Warehouse Proxy Agent:
ORA-01461: can bind a LONG value only for insert into a LONG column

Upgrade to Oracle 10.1.0.5 or later.
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Errors in either the Warehouse Proxy Agent or Summarization and
Pruning Agent logs

You receive the following error in either the Warehouse Proxy Agent or
Summarization and Pruning Agent logs:

DB2 SQL error: SQLCODE: -964, SQLSTATE: 57011, SQLERRMC: null

The solution is to increate the DB2 logging for the warehouse database. See the
IBM Tivoli Monitoring for Databases: DB2 Agent User’s Guide for more information.

Receive a message saying that the statement parameter can only be a
single select or a single stored procedure

You receive the following message when connecting to a Microsoft SQL Server
2000 database on a Windows 2000 system from a Warehouse Proxy Agent on a
Linux system using Microsoft SQL Server 2005 JDBC driver 1.2 April 2007.
SSQL error: Exception message: sp_cursoropen/sp_cursorprepare:

The statement parameter can only be a single select
or a single stored procedure.

This was fixed by not adding by default the selectMethod=cursor string in a
Microsoft SQL Server URL, but you also must remove the string
selectMethod=cursor that comes by default when choosing the Microsoft SQL
Server database in the Warehouse Proxy Agent configuration panel on UNIX
systems.

The Summarization and Pruning Agent hangs or has a worker thread

that hangs

This can be caused (on DB2 at least) if there is another application (DB2 Control
Center) holding a lock on the table. DB2 by default has LOCKTIMEOUT set to -1,
meaning a long wait that causes the Summarization and Pruning Agent to appear
to hang. Closing the offending application (or resolving the deadlock) solves the
problem.
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Chapter 9. Universal Agent troubleshooting

This chapter describes problems that might occur with the Universal Agent.

Preliminary Universal Agent problem determination

Correct operation of the IBM Tivoli Monitoring requires correct application data
definitions, environment variables, and Tivoli Enterprise Monitoring Server and
Tivoli Enterprise Portal configuration. Many problems are caused by incorrectly
formatted data or data interpretation. Therefore, begin Universal Agent problem
determination with the data provider.

Before troubleshooting a problem with the Universal Agent, review the following
list of fundamental Universal Agent problem determination tasks.

Validate the metafiles using the console command VALIDATE. Review the
validation messages and report. Resolve all identified errors and warnings.
Because the IBM Tivoli Monitoring calls the same validation subroutines when it
loads a metafile, it encounters the same problems as the KUMPCON VALIDATE
program.

Verify that the first three characters of the application name defined in the APPL
statement of the metafile are unique throughout the enterprise.

Verify that the sequence of data fields on the data record matches the listed
sequence of attributes in the metafile. In addition, ensure that the attribute type
and the maximum data value size correspond to the actual application data
values.

Verify that the actual data fields are delimited exactly as specified in the
delimiter specification of the ATTRIBUTES statement. If the delimiter is specified
as NONE, ensure that defined attribute value sizes exactly match the data values
on the application data record.

For FILE Data Providers, verify that only one file source (SOURCE FILE
statement) is specified for each attribute group (NAME statement) or that you
used ManagedSystemName to distinguish the sources.

For SOCK Data Providers, verify that you have the correct socket source host
name (SOURCE SOCK) specified for the application.

Examine the UAGENT DPLOG report in Tivoli Enterprise Portal. It might
include messages that provide clear indications concerning data provider
operation and the data source disposition.

Universal Agent does not start

The Universal Agent did not allocate its DCH port 1919 for one of the following
reasons:
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Table 20. Universal Agent does not start

Problem

Explanation

Another Universal Agent The following are the last messages that display in the Universal Agent RASI log.

process is running on th? same | kym@sock.c,110,"KUMO_OpenLocalSocket") bind failed for local address
system and the other Universal | ypp socket 512, port=1919, = error=10048 kum@sock.c,110,
Agent was not shut down. "KUMO_OpenLocalSocket") bind failed for local address TCP

socket 512, port=1919, error=10048 kumdsock.cpp,964,
"ipcSock::allocateDCHport") Error: Could not open TCP/UDP
sockets bound to universal agent DCH port 1919
kumdsock.cpp,965,"ipcSock::allocateDCHport")

Determine if another copy of

There is a non-Universal Agent
process running on the same
system and the Universal
Agent was not shut down.

Universal Agent is already active on this system. Exiting...

Note: In the RASI log above, the Winsock error code 10048 indicates the "Address
is in use”. On UNIX-based systems platforms, the equivalent "Address in use”
error code is usually 125. Run netstat —a for more information about port usage
on the local system.Stop the other process if it is not required. If the other process
is required, set KUMA_DCH_PORT=nnnnn in the KUMENV or um.ini file. The
environment variable causes the Universal Agent to allocate a different DCH port
during startup.

Custom Universal Agent's data is not being summarized

Specify the PRIMARYKEY option for the key fields to tell the Summarization and
Pruning Agent how to distinguish multiple instances.

The option below is used to designate a key attribute:
OPTION{PRIMARYKEY=n}

This option is required for every attribute group. The variable 7 starts at 0 for each
attribute and increases by 1 as necessary. Use PRIMARYKEY=0 for the key of the
unique identifier in a multirow attribute group. For example, if an attribute group
describes disk drives, you should specify PRIMARYKEY=0 with each attribute that
contains the unique ID for each disk drive. This keyword is used at the column
level.

The sysxlogins report is empty in the TIVOLI_DATA_WAREHOUSE
ODBC application

Use the steps to determine why the sysxlogins report is empty in the
TIVOLI_DATA_WAREHOUSE ODBC application.

1. Check the UAGENT DPLOG for the ODBC DP for error messages.

2. Resolve any errors. If there are no error messages, the log indicates that
monitoring started for the sysxlogins table.

3. Verify that other attribute groups for this metafile display data.
If other attribute groups display data, the connection to the data source is
performing as expected and only the sysxlogins report is having the problem.

4. Check the RASI log for error messages pertaining to the sysxlogins attribute
group, including message that state data was not found for key attributes srvid
and sid.

The following example shows that indexed key attributes srvid and sid are not
defined with a value. Therefore all four rows in the attribute group table were
skipped, resulting in error an empty sysxlogins report.
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#x*xx* No ODBC table data found for key attribute <srvid> row #1
in attribute group <sysxlogins>, skipping this row...

#x*xx* No ODBC table data found for key attribute <srvid> row #2
in attribute group <sysxlogins>, skipping this row...

#x*xx* No ODBC table data found for key attribute <srvid> row #3
in attribute group <sysxlogins>, skipping this row...

**x+% No ODBC table data found for key attribute <sid> row #4
in attribute group <sysxlogins>, skipping this row...

5. Check the sysxlogins attribute group in the generated
TIVOLI_DATA_WAREHOUSE metafile for the following data:
//NAME sysxlogins K 300 @System table
//SOURCE ODBC 'Tivoli Data Warehouse' user=sa pswd=tivoli
//SQL Select * from dbo.sysxlogins
//ATTRIBUTES
srvid C 999999 KEY
sid D 88 KAY ATOMIC
xstatus C 999999
xdatel D 24
xdate2 D 128 KAY ATOMIC
password D 256

dbid C 999999

Note: When ODBC metafile generation occurs, every column defined in the
catalog as indexed receives the KEY specification in the associated
Universal Agent attribute. KEY attributes in any Universal Agent
metafile must have a correct value or the row is not sent to the data
server. The srvid and sid columns are not correctly defined as indexed
because they often do not contain a value.

6. Remove the KEY specifications for these two attributes and refresh the metafile.
The table can maintain the KEY designation because there is another attribute
in sysxlogins marked as KEY.

Universal Agent console program fails to connect

The Universal Agent console interface, implemented with the um_console shell
script on UNIX and the kumpcon program on Windows, requires a successful
socket connection to the main Universal Agent process. The following error
message can occur whenever you issue a Universal Agent console command or a
Distributed Monitoring Upgrade Toolkit command:

KUMPSOO5E Unable to connect to console command server on myhost[7700]

This error can occur for the following reasons:
* Universal Agent is not currently running.

* An alternate instance of Universal Agent is running. Alternate instances do not
use the default console server listening port number of 7700. Instead, the first
alternate instance uses 8700, the next instance uses 9700, and so on. To target the
correct alternate instance, set the KUMP_DPCONSOLE_PORT environment
variable. See the following example:

KUMP_DPCONSOLE_PORT=8700
kumpcon import monitor.mdl

* There is a firewall on the system that blocks the socket connection between the
Universal Agent console program and the Universal Agent process. If all port
communications on the system require explicit permission, then the kumpcon
program must be granted access to the console server listening port.
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The agent fails, but events are still seen as active

It is possible for a situation to remain open for almost four times the sample
period before the event closes. For example if a situation had a sample period of 15
minutes the following could occur:

The first sample true - 00:00

- sample true - no change in status 15:00
- agent crashes - 15:01

proxy sends last sample - 30:01

proxy sends last sample - 45:01

proxy ends. return no sample 60:00

Previously defined situations display in the Tivoli Enterprise Portal
with a Problem or Error status

Situations with a problem or error status are most likely the result of running
um_cleanup, which deletes the Tivoli Enterprise Portal Server catalog and attribute
files and the Tivoli Enterprise Portal Server ODI files for all Universal Agent
applications. When the Tivoli Enterprise Portal Server and Tivoli Enterprise Portal
server are recycled, they detect situations with no corresponding definition files.
These situations are flagged as a problem until the application definition files are
regenerated and uploaded again to the Tivoli Enterprise Portal Server and Tivoli
Enterprise Portal Server.

All Universal Agent-emitted traps display with the same severity

Many different policy-generated traps are sent by Universal Agent to a 3rd party
SNMP Manager product, but all the traps show up with the same severity and it’s
not the severity specified in the policy definition. Turn on the Universal Agent
environment variable KUMP_TRAP_USE_POLICY_SEVERITY:

KUMP_TRAP_USE_POLICY_SEVERITY=Y

The Managed system version suffix increases

Each time the Universal Agent is restarted, the managed system version suffix for
an application is incremented even though the metafile has not changed. There are
two metafiles activated that have the same three-character application prefix. If the
metafiles are activated one after the other, the Universal Agent determines that the
three-character application was modified and registers a new version suffix and
upload new CAT, ATR, and ODI files.

Tivoli Enterprise Portal column headings are missing for a Universal
Agent application
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A Universal Agent application is online to Tivoli Enterprise Portal but all of its
column headings are missing in the application workspace.

The Universal Agent-generated CAT, ATR, and ODI files were not uploaded to the
Tivoli Enterprise Portal Server and Tivoli Enterprise Portal Server directories. The
most current and accurate copies of these definition files are in Universal Agent’s
work directory. If necessary, you can copy or FTP these files from the work
directory to the appropriate Tivoli Enterprise Portal Server and Tivoli Enterprise
Portal Server directories.
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A variation of this problem is that some of the column headings display but not all
of them, or the column headings are incorrect. This could indicate old or
out-of-synch CAT, ATR, and ODI files in the Tivoli Enterprise Portal Server and
Tivoli Enterprise Portal Server directories. Again, you can always synchronize these
files by copying them from the Universal Agent work directory and recycling the
Tivoli Enterprise Portal Server and Tivoli Enterprise Portal Server.

Another possible explanation is that Universal Agent is connected to a remote
Tivoli Enterprise Portal Server, and the Universal Agent-generated CAT and ATR
files for the application didn’t get propagated to the hub Tivoli Enterprise Portal
Server. Tivoli Enterprise Portal Server only queries the hub Tivoli Enterprise Portal
Server, so it’s unable to retrieve the data rows. Copy or FIP the Universal
Agent-generated CAT and ATR files from the remote Tivoli Enterprise Portal
Server to the hub Tivoli Enterprise Portal Server.

Tivoli Enterprise Portal charts and graphs do not work for numeric

data

Tivoli Enterprise Portal charts and graphs for a Universal Agent application are
empty even though the attributes are defined as "N” in the Universal Agent
metafile. The Universal Agent "N” attribute type means DisplayNumeric. It is a
string representation of a numeric attribute that can include non-numeric
characters, such as a floating point number or a large number with comma
separators. A DisplayNumeric attribute is a string in the ODI file and is not eligible
for Tivoli Enterprise Portal charting and graphing. If you want to use a Universal
Agent attribute in a chart or graph, define the attribute in the metafile as a true
numeric attribute, for example:

* C for Counter
* G for Gauge

kumstrap and kumsnetd processes do not start

After running itmemd agent start um on UNIX-based systems, the following error
messages display:

elsun02% itmcmd agent start um

itmecmd agent : installer level 350 / 552.

itmemd agent : running sol25 jre.

Starting agent ..

Note: Universal agent process kumsnetd did not start.

NOte: UNiversal agent process kumstrap did not start.

Agent Started . . .

When you check the Universal Agent RAS1 log file, the following messages
display at the bottom:

-16:kumOsock.c,132,"KUMO_OpenLocalSocket") bind failed for local address
UDP socket 71, port=162, error=13
-F:kumsrcfg.c,73,"KUMS_ReadNetConfigFromExt")

Network configuration file /controll/dbisk/
candlelUa410/s01276/um/work/KUMSNETS open failed,

ErrorText <No such file or directory>. \

Load network configuration bypassed

-18:kbbssge.c,52,"BSS1_GetEnv") KUMP_SNMP_NET DISCOVER ENTERPRISE="N"
Network configuration discovery tasks started.
-17:kumsrcfg.c,267,"KUMS_ReadRouterConfigFromExt") Router configuration
file /controll/dbisk/ candleUa410/s01276/um/work/KUMSROUT open failed,
ErrorText <No such file or directory>. \

Load router configuration bypassed 17:kumsrcfg.c,294,
"KUMS_ReadRouterConfigFromExt") 0 router record(s) loaded from router

Chapter 9. Universal Agent troubleshooting 113



configuration file /controll/dbisk/candleUa410/s01276/um/work/KUMSROUT
-19:kbbssge.c,52,"BSS1_GetEnv") KUMP_SNMP_MANAGE_LOCAL_NETWORK="N"
-16:kumsplst.c,167,"KUMS_PrepareListenSNMPtrap") #xxxx

UnabTe to open SNMP trap Tisten port
-16:kumsplst.c,193,"KUMS_PreparelListenSNMPtrap")

Note: Determine if another SNMP Manager \

process is active on this system.

Monitoring of SNMP traps disabled. No trap receiving port or API available.
Insufficient process authority for executing ICMP procedures.
-17:kumOsock.c,132,"KUMO_OpenLocalSocket") bind failed for local address
UDP socket 71, port=520, error=13
-17:kumsIrtu.c,148,"KUMS_ListenRouterUpdates")

**%%% unable to open socket with router \

well-known port-17:kum@sock.c,132,"KUMO_OpenLocalSocket")

bind failed for local address UDP socket 73, \

port=520, error=13

-17:kumsTrtu.c,148,"KUMS_ListenRouterUpdates")

**%%* unable to open socket with router well-known port

The error=13 indicates a permission failure. The Universal Agent was not started
with a root ID so the trap receiving and router/network discovery processes did
not acquire the low-numbered ports needed. The kuma610 continues to run
without those two processes.

Note: The kumstrap and kumsnetd processes are required only if you configured
the SNMP data provider on a UNIX-based system with the following
environment variables specified:

e KUMP_SNMP_MONITOR_TRAP=Y
¢ KUMP_SNMP_NET_DISCOVERY=Y

You can correct the authorization problem either by doing one of the following:

* Start the Universal Agent with a root ID.
—_OR-

* Use the SetPerm script in the /bin directory to grant root access to the kumstrap
and kumsnetd binaries.

If you use the SetPerm script to grant root access to kumstrap and kumsnetd,
you do not need to start Universal Agent with a root ID for the two processes to
start successfully. Because the kumsnetd process has the necessary root authority
to acquire port 520, you can ignore the following error messages in the Universal
Agent RASI log file:

kum@sock.c,134,"KUMO_OpenLocalSocket") bind failed for local address UDP

socket 67, port=520, errno=13

kums1rtu.c,148,"KUMS_ListenRouterUpdates") #*x*** unable to open socket with
router well-known port

The Universal Agent stops functioning if the system IP address
changes while it is running
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If a network connection failure occurs and the UA system is assigned a different IP

address after the reconnection, UA will stop processing new input data because of
socket bind failures. Recycle the Universal Agent so that it uses the new IP
address.
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’Unable to get attribute name for tablename/column’ error occurs in
the Tivoli Enterprise Monitoring Server log after creating a situation

After creating a situation for Universal Data Provider to fire event, the following
error occurs in the Tivoli Enterprise Monitoring Server log file:

(4320916A.0049-F60:kfaottev.c,1572,"TransTate_ResultBuffer")
Unable to get attribute name for tablename/column <UAG524400.UA4>. Ignored.

The Tivoli Enterprise Monitoring Server log messages are harmless for Universal
Agent applications because of the time lag between the issuing of the messages
and when the Universal Agent-uploaded attribute files are stored at the Tivoli
Enterprise Monitoring Server. However, if these messages occur for other agent
applications, they can indicate that the agent attribute files were not installed on
the Tivoli Enterprise Monitoring Server.

SNMP data provider problems

This section describes symptoms and tips for diagnosing SNMP data provider
problems.

SNMP-MANAGER Trap workspace is unavailable in many
columns

Every Independent Software Vendor (ISV) product that emits a trap to the SNMP
DP must have a Type 2 and Type 3 record with a unique enterprise OID defined in
Universal Agent trapcnfg file in Universal Agent work directory. When a trap is
received, the SNMP data provider looks up the trap enterprise OID value, generic
trap number, and specific trap number in the trapcnfg. The trap definition values
received by the SNMP data provider must match the definitions in the trapcnfg
file. If the SNMP data provider does not find a match for the values in the
trapenfg, it sets the status of the trap as "Unavailable” in the SNMP-MANAGER
Trap table attributes. Although the traps are received, they display the
"Unavailable” status in the SNMP-MANAGER Trap workspace.

The following example shows an intelliWatch trap definition:

intelliWatch-Monitor {1.3.6.1.4.1.1983.1.1}
(Type 2)
criticalAlarm {1.3.6.1.4.1.1983.1.1} 6 1 A 1 0 "Status Events" (Type 3)

where:

1983  Specifies the Enterprise OID.

6 Specifies generic trap number.

1 Specifies the specific trap number.

Define the correct traps values in the trapcnfg file in the Universal Agent work
directory.

The TRAP workspace does not display expected traps

For the SNMP to receive traps from SNMP agents, the trap destination list of the
monitoring agent must include the host name or IP address of the host on which
the Data Provider resides. Configuration of SNMP agents varies from monitoring
agent to monitoring agent. Refer to your SNMP monitoring agent documentation.

If you are not receiving traps ensure that:
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e SNMP is in the list of data providers being started
* The host of the SNMP Data Provider is configured to receive traps

* Agents are configured to send traps to the host of the SNMP data provider.

* That the trap listener started successfully by checking the UAGENT DPLOG
workspace for the SNMP Data Provider

* KUMP_SNMP_MONITOR_TRAP is not set to N
* You add the trap description data to the file trapcnfg if a trap field shows

UNAVAILABLE,

SNMP metafiles are imported but MIB data collection is not

working

The MIB application workspaces are empty after initiating MIB data collection

(Take Action > Monitor Start).

Table 21. MIB data collection is not working

Problem

Resolution

The community name was not specified correctly for the
SNMP agent.

The SNMP agent is not responding to any SNMP Get
requests.

The MIB OIDs on the SNMP agent host do not match the
OIDs specified in the Universal Agent metafile.

Use an MIB browser or freeware utility such as snmputil
to retrieve MIB variables from this SNMP agent to
determine the source of the problem.

The agent does not respond to basic SNMP Get requests
from Universal Agent.

All SNMP agents support the MIB2 OIDs such as
SysName and SysLocation. Use the rfc1213 metafile to
establish a baseline of functionality. Use the Universal
Agent RFC1213_mib-2.mdl to collect MIB-2 data from the
agent to verify that the SNMP agent responds to basic
SNMP Get requests from Universal Agent.

Universal Agent-emitted traps are not received by third-party

SNMP Manager

The policies are configured to emit SNMP traps, but the traps do not display in the
receiving system console. Use the following table to determine the source of this

problem.

Table 22. Universal Agent-emitted traps are not received by third-party SNMP Manager

Symptom

Explanation

There are error
messages in the
Universal Agent RAS1
log in the
kumaeagt.cpp
module.

Error messages indicate why the policy is not being driven, for
example:

kumaeagt.cpp,154,"kum_kumact_agent::TakeSample")
Error: could not find terminator in
<Local_Time.Day_Of Week> =
'06' AND Local _Time.
Time>= '053000' AND Local_Time.Hours <= '21' AND
Queue_Statistics.Current_Depth >= 12800 \
AND STRSCAN(QMQUEUES.QNAME, 'ACK') = 0;> tokl @NULL tok2
ONULL tok3 @NULL attrValTemp <>

'02' AND Local_Time.Day_Of_Week <=

The kumaeagt.cpp module implements Universal Agent’s Alert
Emitter probe. Any error messages in this module might indicate
that the policy request never got to the Universal Agent module
that sends the traps.
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Table 22. Universal Agent-emitted traps are not received by third-party SNMP
Manager (continued)

Symptom Explanation
There are no error If the Universal Agent RAS1 log has no error messages, check
messages in the whether there are error messages in the Tivoli Enterprise

Universal Agent RAS1 | Monitoring Server log. If there are errors that report a duplicate
log but the traps are | CAT and ATR files, there might be a name conflict with other

not received. installed IBM Tivoli Monitoring emitters.
Search for errors In an MVS-based Tivoli Enterprise Portal Server, a "cmd failed”
showing policies reason code indicates the KUMATR and KUMCAT files are

ending with a "emd missing from RKANDATV.
failed” reason code.

If the Universal Agent | A firewall might prevent communication between the machine
RASI log contains where Universal Agent is running and the machine where the
"SNMP trap emitted | SNMP Manager product is running.

to destinations(s) ..."

messages, but the
traps do not display | Configuration steps might be required on the SNMP Manager

Security rules might filter, block, or divert SNMP traps.

on the 3rd party product so that it can receive and display the Universal Agent
SNMP Manager traps.
console.

The SNMP Manager product might have a log file that indicates
whether it receives or rejects the Universal Agent traps.

If the host name of the Universal Agent SNMP Data Provider is
added as a trap destination, the Universal Agent Emitter traps do
not display in the SNMP-MANAGER Trap workspace.

The NETWORK workspace is empty
Ensure the following:
¢ The host where the SNMP Data Provider is running is TCP/IP configured.

* You can ping the default router/gateway from the host of the SNMP Data
Provider.

* You have initiated network discovery using Take Action > Manage Start.

A MIB workspace is not showing expected data

For MIB workspaces to display data, you must initiate data collection using the
Monitor Start option of the Take Action feature. If you are still not receiving data:

e Ensure that the correct metafile was loaded.

* Confirm that the correct target monitoring agent nodes were specified in the
Monitor Start window, separated by commas.

* Confirm that the node and correct community name were entered in brackets.
The following example displays correct formatting if the SNMP community
name of the target is not the default (public) nor specified by
KUMP_SNMP_NET_COMMUNITY, and there is no entry in the KUMSCOMM
file:

{athens IBM}

Take Action > Manage Start or Take Action > Manage Stop is
not working
Ensure the following for the Manage Start and Manage Stop Take Action to work:

* The address is correct if you entered the network address manually (rather than
selecting it in the NETSUMMARY workspace).
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* The destination managed system you specified when distributing the action is
host name:SNMP-MANAGERNN.

Problems with Take Action commands and curly brackets

Take Action commands that are created with curly brackets, {}, are not recorded
and cannot be selected from the Tivoli Enterprise Portal. This happens only for "{"
(ALT+123) and not for "}".

There has been a change in syntax where attributes that are enclosed in curly
brackets, {}, no longer are required to have quotes. See the following example:

&{grpl.atrl}.&{grp2.atr2}

The SNMP Data Provider does not start with IBM Tivoli
Universal Agent

Ensure you included SNMP as a value for environment variable
KUMA_STARTUP_DP.

You do not see the TakeAction options

Seed the Tivoli Enterprise Monitoring Server with KUM.SQL and restart the Tivoli
Enterprise Monitoring Server and Tivoli Enterprise Portal sessions.

A managed system for a MIB application does not come
online as expected

Ensure that you imported the application metafile either through the console
command IMPORT or updating your KUMPCNEFG file. Check your DPLOG
workspace in the application UAGENT for error messages regarding the importing
of the metafile.

The NETSUMMARY workspace does not show expected data

Ensure that you can ping the default gateway or router from the host running the
SNMP Data Provider.

A MIB workspace displays empty when you expect to see data

A MIB workspace displays empty if the community name used for the SNMP
query was not the correct one for a particular SNMP monitoring agent.

To determine that a MIB workspace is empty as a result of an incorrect community
name, monitor for the Authentication failure trap from the SNMP monitoring
agent. Assuming the SNMP monitoring agent is configured to generate traps to the
host running the SNMP DP, you can browse your SNMP-MANAGER TRAP
workspace to look for Authentication failure traps (Generic trap number 4).

118 IBM Tivoli Monitoring: Problem Determination Guide



Chapter 10. Database troubleshooting

This chapter provides information you need to solve problems you might
experience with the database. It covers data loss prevention information and
descriptions of common problems and appropriate resolutions. It also addresses
issues you might experience with the Tivoli data warehouse and Warehouse Proxy
agent.

Data loss prevention

This section provides information about utilities you can use to back up and
restore databases.

Backing up the database for recovery purposes
You can use the following utilities to back up the database:

Table 23. Utilities for backing up the database

migrate- The migrate-export.bat utility backs up the entire database by writing its
export.bat contents as insert statements to a flat file called saveexport.sql located in
install_dir\cnps\sqllib. It can also be used to move the contents of the
database from one database instance to another. You might use this utility to
move the contents of the database from one windows server to another.

migrate- This utility is used to read the contents of the saveexport .sql file created in
import.bat | the migrate-export process and insert them back into the database. This
utility can be used to recover the database. It reads the contents in the
install_dir\cnps\sqllib\saveexport.sql and rebuilds the database tables and
contents. You can also use the migrate-import.bat to move the contents of
the database to another windows server running the database.

1. Run migrate-export.bat

2. Copy the saveexport.sql file from the old Tivoli Enterprise Portal Server
to the new Tivoli Enterprise Portal Server into the install_dir\cnps\sqllib
directory.

3. Run migrate-import.bat to read and build the database tables and
contents on the new machine.

Restoring the original database contents

The migrate-clean.bat utility cleans the contents of the database. Use the
migrate-clean.bat file with caution. You must backup the database before running
the migrate-clean.bat file or you lose all customization of the database. When you
restart the Tivoli Enterprise Monitoring Server, the database is restored to its
original state after installation. This is a quick way to reset the database back to its
original state. After running this bat file and restarting the Tivoli Enterprise
Monitoring Server server, the original content provided by IBM Tivoli Monitoring
is restored to the database.

If you modify your password or if it expires

The database requires the following user IDs:
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db2admin
This ID is added when you install the database and is required by the
product installer when you configure the Tivoli Enterprise Portal Server
data source.

TEPS This ID is added during installation for creating the Tivoli Enterprise Portal
Server data source.

If the Windows Local Security Settings are enabled for long or complex passwords,
ensure your password meets those syntax requirements for these IDs. If your
Windows environment requires you to change passwords regularly do the
following to change the Tivoli Enterprise Portal Server database user account
password.

Note: The following instructions do not apply in UNIX-based systems.

1. On the computer where the Tivoli Enterprise Portal Server is installed, be sure
you are logged on to Windows with an ID having administrator authority.

2. From your Windows desktop, select Start > Programs > Tivoli Monitoring
Services > Manage Tivoli Enterprise Monitoring Services.

3. Right-click the Tivoli Enterprise Portal Server and select Advanced > Utilities >
Build Tivoli Enterprise Portal Server Database from the menu.

4. Click DB2 to open the Tivoli Enterprise Portal Server Data Source Config
Parameters window.

5. Enter the Admin Password.

6. Enter the new Database Password for the Tivoli Enterprise Portal Server
Database User ID.

Tivoli Enterprise Portal Server cannot connect to the database
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If an error message displays indicating the connection failed for security reasons,
the end user is logged in to the server with a userid with administrator authority,
but is logged into the local domain instead of locally on the machine. The user
does not have authority to create a data source and register with windows, or the
authority to create a windows user account. Continue installing the software, using
the following steps to resolve the error:

1. When the install completes, log off the current Windows user session and log
in with using the db2admin userid.

2. Run install_dir\installITM\DB2DataSource.exe from Windows Explorer or a
command prompt. You can run this program again, even if one or more of the
tasks completed the first time it ran.

3. Start the Tivoli Enterprise Monitoring Server after the software indicates the
Tivoli Enterprise Portal Server configuration was successful.

If the Tivoli Enterprise Portal installation is complete but it does not start, the data
source might not be defined. Go to the install_dir\cnps\kfwrasl.log file. If error
messages similar to the following are present in the log, the data source was not
defined.

[1BM] [ODBC Driver Manager]
Data source name not found and no default driver specified.

Use the follow steps verify whether or not the data source was created and resolve
the problem:

1. Open the ODBC datasource window: Start > Settings > Control Panel >
Administrative tools and double-click the Data Sources (ODBC) .
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2. Verify that the Tivoli Enterprise Monitoring Server IBM DB2 ODBC DRIVER
datasource is defined.

3. If the IBM DB2 ODBC DRIVER data source is not present, run the
install_dir\install1ITM\DB2DataSource.exe file.

4. Read the error messages after running the program.

5. If the error is security related or mentions incorrect user IDs or passwords, log
in to the windows server with the db2admin user account and run the
db2datasource program.

If the password for db2admin changes, the logon information for the services must
also change, otherwise the Tivoli Enterprise Portal Server database does not start
because the DB2 processes cannot logon. Use the following steps to resolve this
problem:

1. From a Windows desktop, select Start > Control Panel > Administrative Tools
> Services

2. Scan the column on the right for the value .\db2admin
3. Do the following for each .\db2admin value:

a. Open the Properties window.

b. Select the Log On tab.

c. Type the new password for the user.

Data did not migrate from the Microsoft SQL Server database to the
DB2 Universal Database

You can run the movefrom-m2i.bat located in the install_dir\cnps directory to
recover the contents of the Universal Database. The movefrom-m2i.bat utility
creates a flat file from the SQL server database contents and imports into the
Universal Database. The movefrom-m2i.bat utility runs during the installation of
the Tivoli Enterprise Portal when the option to migrate from Microsoft SQL Server
to the Universal Database is selected but can also be used after installation or
routine Tivoli Enterprise Portal usage. This migration utility can fail if the Tivoli
Enterprise Portal userid and password do not have the correct authority to connect
to the Tivoli Enterprise Monitoring Server Universal Database. The
movefrom-m2i.bat requires that the Microsoft SQL server database is on the same
Windows platform as the Tivoli Enterprise Monitoring Server server and the new
Universal Database installation. Use this utility only after migration problems and
before customizing Tivoli Enterprise Monitoring Server. The movefrom-m2i.bat is
only used to migrate the contents of Microsoft SQL Sever to Universal Database.

Database contents are incorrect after installation

You can run the movefrom-m2i.bat located in the install_dir\cnps directory to
recover the contents of the database. The movefrom-m2i.bat utility creates a flat file
from the SQL server database contents and imports into the Universal Database.
The movefrom-m2i.bat utility runs during the installation of the Tivoli Enterprise
Portal when the option to migrate from Microsoft SQL Server to the Universal
Database is selected but can also be used after installation or routine Tivoli
Enterprise Portal usage. This migration utility can fail if the Tivoli Enterprise Portal
userid and password do not have the correct authority to connect to the Tivoli
Enterprise Monitoring Server Universal Database. The movefrom-m2i.bat requires
that the Microsoft SQL server database is on the same Windows platform as the
Tivoli Enterprise Monitoring Server server and the new Universal Database
installation. Use this utility only after migration problems and before customizing
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Tivoli Enterprise Monitoring Server. The movefrom-m2i.bat is only used to migrate
the contents of Microsoft SQL Sever to Universal Database.

The error SQL0443N with 'SYSIBM:CLI:-805' occurs after upgrading to
DB2 UDB Version 8.1 Fix Pack 10

An error occurs with the SQLTables if the database was created before applying
IBM DB2 V8.1 Fix Pack 10 (also known as Version 8.2 Fix Pack 3), you encounter
an SQL0443N error if you run a DB2 Call Level Interface (CLI) catalog function
(such as SQLTables(), SQLColumns(), or SQLStatistics()). The following is an
example of the error in a log:
(430F82BD.0000-3C4:khdxodbc.cpp,319,"initializeDatabase") Connection with
Datasource "ITM Warehouse" successful
(430F82BD.0001-3C4:khdxbase.cpp,250,"setError") Error 20/3/-443(FFFFFE45)/0
executing SQLTables

(430F82BD.0002-3C4:khdxbase.cpp,266,"setError") Error "[IBM][CLI Driver] [DB2/NT]
SQLO443N Routine "SYSIBM.SQLTABLES" (specific name "TABLES") has returned an
error SQLSTATE with diagnostic text "SYSIBM:CLI:-805". SQLSTATE=38553
+430F82BD.0002 "

Bind the db2schema.bnd file against each database to resolve this error. Run the
following command from a DB2 command prompt:

1. db2 connect to dbname (Warehouse Database)

where:

dbname
Specifies the name of a database to which you want to bind the
utilities, or the Warehouse Database name.

2. DB2 bind path_name

where:

path_name
Specifies the full path name of the directory where the bind files are
located, usually sqllib/bnd.

The following examples shows the rebinding commands from the
c:\SQLLIB\bnd>DB2 directory:

¢:\SQLLIB\bnd>DB2 connect to dbname (Warehouse Database)
c:\SQLLIB\bnd>DB2 bind @db2ubind.Tst blocking all grant public
c:\SQLLIB\bnd>DB2 bind @db2c1i.1st blocking all grant public
c:\SQLLIB\bnd>DB2 bind db2schema.bnd blocking all grant public

Some rows do

not display in an upgraded table

You might not see all rows after upgrading the Warehouse Proxy agent to IBM
Tivoli Monitoring V6.1 because some tables might be corrupted. Do the following
to find the errors that occurred during the upgrade:

1. Edit the KHDRAS1_Mig_Detail log file.
2. Search for the word EXCEPTION.

The KHD MAX_ROWS_SKIPPED_PER_TABLE environment variable in the
KHDENV_MIG file allows you to skip bad data. Use
KHD_MAX_ROWS_SKIPPED_PER_TABLE to specify the number of rows per table
to skip to migrate if the data that needs to be inserted is incorrect. When this
number is reached, migration of the table is aborted.
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Historical data is not warehoused

Check the following Warehouse Proxy agent logs for errors that indicate why
historical data is not warehoused:

¢ Windows Event Log (all critical errors)

* WHProxy Agent RAS1 Log.

* Operations Log

The Warehouse Proxy agent contains an audit trail for each export written to the

warehouse database. You can also check the database table called
WAREHOUSELOG as it contains the same information as the logs.

Historical data for logs is incorrect

If there are duplicate or missing rows in a table, incorrect historical data is
collected for logs, such as managed system or situation status. Correct the incorrect
rows to ensure reliable logs.

Warehouse Proxy Agent or Summarization and Pruning Agent fails due
to DB2 transaction log full

If the DB2 transaction log is not large enough and fills, operations performed by
the Warehouse Proxy Agent or Summarization and Pruning Agent will fail. If this
happens you will see a message like the following in the Warehouse Proxy Agent
log file (hostname_hd_java_nnnnnnnnnn.log) or the Summarization and Pruning
Agent log file (hostname_sy_java_nnnnnnnnnn.log):

com.ibm.db2.jcc.a.SqlException: DB2 SQL error: SQLCODE: -964, SQLSTATE: 57011,
SQLERRMC: null

Increase the DB2 transaction log size. See the DB2 manuals for altering the
LOGFILSIZ, LOGPRIMARY, and LOGSECOND parameters within DB2.

Too much historical data is collected

The Summarization and Pruning agent is responsible for generating and storing
summarized data, and pruning the data based on information that is stored in the
Tivoli data warehouse. The data in the Tivoli data warehouse is a historical record
of activity and conditions in your enterprise. The size of summarization data that
is collected depends on the following criteria:

¢ The number of agents collecting data

* The number of table collected per agent

* The size of the table (number and size of columns)

* The collection interval (for example 5, 10, 15 or minutes)

Pruning data is deleting old data automatically, rather than manually. To reduce
the data that is collected, limit the size of your database tables by regularly
pruning old data from the Tivoli data warehouse. If you installed the
Summarization and Pruning agent, your configuration settings are set to default
values. You can view the current values in the History Collection Configuration
window. Refer to "Changing configuration settings using the History Collection
Configuration window in the Tivoli Enterprise Portal" in the IBM Tivoli Monitoring
Administrator’s Guide for instructions.
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If you need to install the Summarization and Pruning agent, see the IBM Tivoli
Monitoring Installation and Setup Guide. There you can find information for
environment-wide capacity planning. You can find agent-specific capacity planning
information in the user guide for the specific monitoring agent.

Warehouse Proxy agent failed to export data

The ODBC connection enables the Warehouse Proxy agent to export data to the
warehouse database. The WAREHOUSELOG table lets you know how many
exports succeeded and how many failed because of an ODBC error or a TIMEOUT
issue. See the IBM Tivoli Monitoring Installation and Setup Guide for more
information about the WAREHOUSELOG table and configuring the Warehouse
Proxy agent.

There are ORACLE or DB2 errors in the khdras1.log file

The following errors can occur in the khdrasl.log if the globalization system
environment variable is not set correctly:

ORACLE error: [Oracle][ODBC][Ora]ORA-01461: can bind a LONG value only
for insert into a LONG column
1. Set the environment variable
NLS_LANG=AMERICAN_AMERICA.AL32UTF8 as a system
environment on the Windows computer on which the Warehouse Proxy
is installed.
2. Restart the Windows computer so that the Warehouse Proxy windows
service recognizes the change.

DB2 error: SQL0302N The value of a host variable in the EXECUTE or OPEN
statement is too large for its corresponding use. SQLSTATE=22003 sqlstate =
22003
1. Set the environment variable DB2CODEPAGE=1208 as a system
environment on the Windows computer where the Warehouse Proxy is
installed.
2. Restart the Windows computer so that the Warehouse Proxy windows
service recognizes the change.

SQL0552N "ITMUSER" does not have the privilege to perform
operation "CREATE BUFFERPOOL"” SQLSTATE=42502
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If the Warehouse database user does not have the correct permission, the following
erTor can occur:

(42ED71FA.0000-EAC:khdxbase.cpp,250,"setError")

Error 20/3/-552(FFFFFDD8)/0 executing SQLExecute
(42ED71FA.0001-E4C:khdxbase.cpp,266,"setError")

Error "[IBM] [CLI Driver] [DB2/NT] SQLO552N "ITMUSER" does not have
the privilege to perform operation "CREATE BUFFERPOOL" SQLSTATE=42502

When you configure a DB2 Warehouse Proxy connection from the Manage Tivoli
Enterprise Monitoring Services utility using the Configure DB2 Datasource for
Warehouse window, the user ID the Warehouse Proxy uses to connect to the
warehouse database must have SYSADM permission. SYSADM permission is
required to create an 8K Tablespace and Bufferpool.
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Windows
If the database is on Windows, the user must be a member of the local
Administrators group.

UNIX-based system
If the database is on Linux or UNIX user must belong to the SYSADM
group.
1. Log in as the DB2 instance owner (usually "su - db2inst1”),

2. Run the following command to determine the group that the
UNIX-based system user must belong.

db2 get dbm cfg | grep SYSADM
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Chapter 11. IBM Tivoli Enterprise Console event
synchronization troubleshooting

This section provides descriptions of and resolutions for problems you might
experience with IBM Tivoli Enterprise Console event synchronization, including
the forwarding situations and the Rules Check Utility.

Preliminary IBM Tivoli Enterprise Console event synchronization
problem determination

Before troubleshooting a problem with IBM Tivoli Enterprise Console event
synchronization, review the following list of fundamental IBM Tivoli Enterprise
Console event synchronization problem determination tasks:

* Before you install the IBM Tivoli Enterprise Console event synchronization on
Windows and import event forwarding functionality into an existing rule base
with an absolute path, you must copy setupwin32.exe to the local drive on
which the rule base resides to import the IBM Tivoli Enterprise Console event
synchronization functionality into that rule base. Launch the copied
setupwin32.exe to start IBM Tivoli Enterprise Console event synchronization
installation.

* Use the IBM Tivoli Enterprise Console Java Console to make any configuration
changes to consoles and associated operator and event groups.

* Connect to a different IBM Tivoli Enterprise Console server using the embedded
viewer:

— From the desktop client:

1. Log off the Tivoli Enterprise Portal.

2. Log on the Tivoli Enterprise Portal.

3. Log into a different IBM Tivoli Enterprise Console server.
— From the browser client:

Recycle the browser.

* For a listing of product messages, refer to the document IBM Tivoli Monitoring
Messages.

T/EC ITM Synchronization Tasks

By default, all situation events that originate from a recycled Tivoli Enterprise
Monitoring Server are CLOSED. As a result, you do not need to run any of the
three tasks that reside in the T/EC ITM Synchronization Task Library.

Changing the TCP/IP timeout setting on your event server

If the Situation Update Forwarder cannot reach a monitoring server to send an
update, depending on the TCP/IP settings for the computer where your event
server is running, it could be up to 15 minutes before the Situation Update
Forwarder tries to connect to the monitoring server again. This might occur if your
event server is running on an AIX, Solaris, or HP-UX computer.

Use the following steps to change the TCP/IP timeout for your computer.
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On AIX, run the following command:
no -o tcp_keepinit=<timeout_value>

where <timeout_value> is the length of the timeout period, in half seconds. To
configure a timeout of 30 seconds, set the <timeout_value> value to 60.

On Solaris and HP-UX, run the following command:
ndd -set /dev/tcp tcp_ip_abort cinterval <timeout value>

where <timeout_value> is the length of the timeout period, in milliseconds. To
configure a timeout of 30 seconds, set the <timeout_value> value to 30000.

Situation continues to send events even after it is stopped or sends
events for undefined processes

You create a situation and set a take action to send email when the situation
occurs. The situation checks for specified missing processes "’ /usr/*/sshd’,’/usr/*/
syslogd’,’ /usr/*/ntpd’,” /usr/*/xinetd’,’ /usr/*/crond’. The situation continues to
send email even after the situation has been stopped, the take action has been
removed and applied, and the situation has been deleted. You try to recycle the
agent, recreate the situation and delete, but you still receive the emails.

Also, the situation event console only reports on the defined situations as expected,
but the take action commands send events for several processes, rather than
reporting only those that are defined.

The primary remote Tivoli Enterprise Monitoring Server probably has a required
but missing C++ Runtime.

IBM Tivoli Enterprise Console task timeout expires while in process

Some tasks like "Close_All_Reset_Events” can require up to an hour to complete,
depending on the number of events processed. The task continues processing in
the background if the timeout expires, however, the task output does not display.
You do not need to run the task again. You can increase the task timeout value on
task panel to prevent the task from timing out.

Situations with assigned severity not taking the user-assigned severity
from the Tivoli Enterprise Portal
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This issue only occurs in situations that were defined in fix packs prior to IBM
Tivoli Monitoring Fix Pack 5. You set the Tivoli Enterprise Portal severity, but there
was a SEV= parm in the SITINFO that took precedence over the "assign tec
severity by situation name suffix” rule in the code. Complete one of the following
options to correct this problem:

¢ Code an entry in the tecserver.txt file to explicitly assign the correct Tivoli
Enterprise Console severity for the situation.

* Manually update the situation definition to either remove the SEV= parm from
the SITINFO column or remove the SEV= parm.
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Situations are not forwarded from Tivoli Enterprise Monitoring Server
to the Tivoli Enterprise Console server

[Table 24 on page 129| provides troubleshooting information for when Tivoli

Enterprise Monitoring Server does not forward situations to the Tivoli Enterprise
Console server:

Table 24. Troubleshooting when situations are not forwarded

Problem

Resolution

The IBM Tivoli Enterprise
Console Event Integration
Facility is not enabled or
configured correctly.

See "Configuring IBM Tivoli Enterprise Console integration” in the IBM Tivoli
Monitoring Administrator’s Guide

The correct values are not
specified for connection to the
Tivoli Enterprise Console server
in the om_tec.config file.

Edit the following parameters in the om_tec.config to specify the correct
information for connection to the Tivoli Enterprise Console server:

ServerLocation
Specifies the host name or IP address of IBM Tivoli Enterprise Console
server.

ServerPort
Specifies the IBM Tivoli Enterprise Console server listening port. Specify
0 if the IBM Tivoli Enterprise Console server uses port mapper.

* On a Windows system:

1. Click Start > Programs > IBM Tivoli Monitoring > Manage Tivoli
Enterprise Monitoring Services.

2. Right-click Tivoli Enterprise Monitoring Server >Advanced.
3. Select Edit EIF configuration to open the om_tec.config file in Notepad.
4. Specify the correct parameters and save the file.
¢ On a UNIX-based systems system:

1. cd/opt/IBM/ITM/tables/hubname/TECLIB

where:

hubname

Specifies the name of the hub monitoring server.

2. Open the om_tec.config file in a text editor.

3. Specify the correct parameters and save the file.
where:

hubname
Specifies the name of the hub monitoring server.
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Table 24. Troubleshooting when situations are not forwarded (continued)

Problem Resolution

Events are filtered out based on |Edit the om_tec.config file in the following locations:
the parameter values in the ¢ On a windows system: c:\ibm\itm\cms\TECLIB.
om_tec.config file.
* On UNIX-based systems: /opt/IBM/ITM/tableshostname/TECLIB.

where:

/opt/IBM/ITM is the default location where the Tivoli Enterprise Monitoring
Server is installed and the host name is the value supplied during the Tivoli
Enterprise Monitoring Server configuration.

¢ On a Windows system:

1. Click Start > Programs > IBM Tivoli Monitoring > Manage Tivoli
Enterprise Monitoring Services.

Right-click Tivoli Enterprise Monitoring Server >Advanced.
Select Edit EIF configuration to open the om_tec.config file in Notepad.
Examine the FilterMode: and Filter: statements.

o w0bd

Specify the appropriate filter statements.

— See the IBM Tivoli Monitoring Administrator’s Guide for the supported EIF
configuration parameters

— Also see the Tivoli Event Integration Facility, Version 3.9 reference manual
SC32-1241 for more details.

¢ On a UNIX-based systems system:

1. cd /opt/IBM/ITM/tables/hubname/TECLIB

where:

hubname

Specifies the name of the hub monitoring server.

2. Open the om_tec.config file in a text editor.
3. Examine the FilterMode: and Filter: statements.
4. Specify the appropriate filter statements.

— See the IBM Tivoli Monitoring Administrator’s Guide for the supported EIF
configuration parameters

— Also see the Tivoli Event Integration Facility, Version 3.9 reference manual
SC32-1241 for more details.
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Table 24. Troubleshooting when situations are not forwarded (continued)

Problem Resolution

Events are cached because the 1. Check the cache files to determine if events are cached on the Tivoli

target IBM TiVO.li Enterprise Enterprise Monitoring Server. The cache files are located in the TECLIB
Consple server is not currently directory on Tivoli Enterprise Monitoring Server:
FURNg. * Windows:

/IBM/ITM/cms/TECLIB

¢ UNIX-based systems:
/opt/IBM/ITM/tables/hubname/TECLIB

where:

hubname
Specifies the name of the hub monitoring server.

2. Run the wstartesvr command to restart the IBM Tivoli Enterprise Console
server from a Tivoli sourced environment.

3. Run the wstatesvr [-S server] command on the IBM Tivoli Enterprise
Console server to check the status of an event server.

where:

-S server
Specifies the name of an event server in name registry format. The
default server is the local event server. To indicate a remote server,
specify @EventServer#tmr, where tmr is the name of a Tivoli region.
Refer to the IBM Tivoli Enterprise Console documentation for more
information about checking the status of the IBM Tivoli Enterprise Console
server.

See [“Trace logging” on page 5|for more information about tracing for IBM Tivoli
Enterprise Console forwarding.

Verifying that events are being received by Tivoli Enterprise Console

On the Tivoli Enterprise Monitoring Server, set this UNIT trace level:
ERROR (UNIT:kfaot ALL)

This will trace the communication between the Tivoli Enterprise Monitoring Server
and Tivoli Enterprise Console. The *_ms_* logs from the Tivoli Enterprise
Monitoring Server show this traffic. You can then verify that events are being
received by Tivoli Enterprise Console by looking at the wtdumprl output. If there
are no "PARSE FAILED"” messages and the Tivoli Enterprise Console is working
correctly, the events should be processed and show in the Tivoli Enterprise
Console.

Enabling tracing of events from the Tivoli Enterprise Console to the
Tivoli Enterprise Monitoring Server

Complete the following steps to enable tracing of events:

1. Rule tracing can be set up for the omegamon.rls. In the OMEGAMON rule
trace file verify that the exec_program predicate is called in the rules trace to
indicate that the rule set invoked situpdate.sh. A line like this will be seen in
the log:
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[357] call exec_program(0x209372e8,
'OM_TEC/bin/situpdate.sh','-size %s
-num %s -path %s %s',['50000','10"',"'"/space/Tivoli_
4141/var/TME/TEC/OM_TEC/persistence"’,

' /tmp/SUFO.tmp'],NO)
Tracing can be set up within the situpdate.sh running by editing the script (the
situpdate.sh script is located at $BINDIR/TME/TEC/OM_TEC/bin). Change
the debugVerbose="expr 0" to debugVerbose="expr 1" .

The files are then /tmp/situpdate.log and /tmp/situpdate.trace.

The tracing can be increased on the Situation Update Forwarder, by editing the
sitconfig.sh script to change the logLevel in the configuration file to low, med,
or verbose. The logfiles will be /tmp/itmsynch/logs/synch_trace.log and
synch_msg log.

Verify that the situpdate.log log file for the short-running script indicates events
are being written to the cache file, such as:

Sat Sep 2 15:36:03 GMT 2006 : 51600 : 1 events from /tmp/SUF1l.tmp written

to cache file /space/Tivoli_4141/var/TME/TEC/OM_TEC/persistence
/situpdate_1157135641

Verify that the Situation Update Forwarder is running.

Verify from the SUF log synch_trace.log file that it is reading from the cache

files, such as:

2006.09.02 17:36:05.876+02:00 com.tivoli.candlenet.SituationUpdateForwarder
readCacheLine IBM Tivoli Monitoring TEC Synchronization

Verify that the SUF log synch_trace.log file contains successful send event

messages:

2006.09.02 17:36:06.311+02:00 com.tivoli.candlenet.SituationUpdateForwarder
pol1CacheFile IBM Tivoli Monitoring TEC Synchronization

Machine_Name IP Successfully sent event:

If there are no successful event sent messages, check the synch_trace.log for

exceptions.

If there is no indication that the Situation Update Forwarder attempted to send
the event, ensure the Situation Update Forwarder is running and verify that the
Tivoli Enterprise Monitoring Server of the event (indicated by
sv=TEMS_server:port in the cache file or the cms_hostname attribute of the TEC
event) matches any of the Tivoli Enterprise Monitoring Servers defined in the
situser.conf configuration file.

Situation Events have an UNKNOWN severity in the Tivoli Enterprise

Console

If a situation was not mapped to a specific severity in the tecserver.txt file in
TECLIB directory, then IBM Tivoli Enterprise Console event synchronization
forwards these situation events to Tivoli Enterprise Console with an UNKNOWN
severity.

You can determine the event severity by checking the following:
* The situation SITINFO field.
* The severity keyword if the situation name was defined in tecserver.txt.

See the section "Defining event severities from forwarded IBM Tivoli Monitoring
situations" in the IBM Tivoli Monitoring Administrator’s Guide .
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Forwarded IBM Tivoli Enterprise Console events display with the
PARSING_FAILED status in the IBM Tivoli Enterprise Console

reception log

The following table lists possible causes and resolutions for the PARSING_FAILED
status:

Table 25. Forwarded events display with the PARSING_FAILED status

Problem

Resolution

The IBM Tivoli Enterprise
Console event
synchronization was not
installed or was not
installed correctly.

Reinstall the IBM Tivoli Enterprise Console event synchronization functionality. See the
IBM Tivoli Monitoring Installation and Setup Guide for instructions.

The expected rule base
was not loaded.

Actively load the expected rule base. You can run the following command from the IBM
Tivoli Enterprise Console event server to load a rule base:

wrb -Toadrb rule_base

where:

rule_base

The name of the rule base to load.
This makes rule_base the currently active rule base on the event server. The rule base
must already be defined at the server, and any event class specification files and rule
files in the directory must be valid. The loaded rule base replaces all event class
specifications and rules currently defined at the server. Only one rule base can be active
at a time. Loading another rule base overwrites the currently active rule base.
Note:

Notes:

1. If you do not compile the rule base before attempting to load it, you get an error
message.

2. You must stop and restart the TEC server for changes to the rule base to be active.
Use the following commands:

* wstopesvr [-S server]
* wstartesvr [-S server]
See the IBM Tivoli Enterprise Console documentation for more information about

loading rule bases, including the IBM Tivoli Enterprise Console Command and Task
Reference.
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Table 25. Forwarded events display with the PARSING_FAILED status (continued)

Problem

Resolution

There are missing BAROC
files that must be
imported to support the
IBM Tivoli Monitoring
V6.1 events.

The BAROC files are located in the TECLIB directories on Tivoli Enterprise Monitoring
Server:

¢ Windows:
/IBM/ITM/cms/TECLIB

* UNIX-based systems:
/opt/IBM/ITM/tables /hubname/TECLIB

where:

hubname
Specifies the name of the hub server.

You can run the following command from the IBM Tivoli Enterprise Console event
server to import a BAROC file (a file of event class specifications into a rule base),
appending it to the end of the class specifications unless otherwise specified with
arguments:

wrb -imprbclass class_file [-encoding encoding ]

[-before class_file |
-after class_file] [-force] rule_ base

where:

class_file
Specifies the name of the class file to import. This must be a path to BAROC
file.

rule_base
The name of the rule base to receive the imported class set.

-after class_file
Specifies the name of the class file after which the imported class file is to be
placed.

-before class_file
Specifies the name of the class file before which the imported class file is to be
placed.

-encoding encoding
Specifies the character encoding of the class file. If this option is not specified,
a class file being imported into a rule base is opened in UTF-8 character
encoding.

-force  Imports the class file even if it can cause rule base inconsistency.

An error message is displayed if the class set file contains syntax errors, references to
nonexistent event classes or enumerations, or if duplicate event classes or enumeration
are defined. If the classes in a class file are derived from classes in another file, import
the class files into the rule base in an order that preserves the inheritance structure. For
example, if class file B.baroc contains classes that are derived from class file A.baroc,
you must import class file A.baroc first.

For any changes you make to the rule base to take affect you must complete the
following steps:

* Recompile the rule base
* Load the rule base
e Stop the Tivoli Enterprise Console server

* Restart the Tivoli Enterprise Console server

Continued on the next page.
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Table 25. Forwarded events display with the PARSING_FAILED status (continued)

Problem

Resolution

There are missing BAROC
files that must be
imported to support the
IBM Tivoli Monitoring
V6.1 events. (Continued)

Refer to the IBM Tivoli Monitoring Administrator’s Guide for information about changing
the omegamon.1ls file.

See the IBM Tivoli Enterprise Console Command and Task Reference, V3.9.0 for more
information about importing class files into rule bases.

Parsing errors reported in
Tivoli Enterprise Console
server for
ITM_ManagedSystem
events.

The ITM_ManagedSystem event class is defined in the kib.baroc file. The kib.baroc file
is not included in the active rule base. Copy the kib.baroc file from the Tivoli Enterprise
Monitoring Server from CandleHome/cms/TECLIB and compile it into the current rule
base.

The IBM Tivoli Enterprise Console is disabled

The Tivoli Enterprise Console relies on the Tivoli Management Framework for
common services, including communications. If the console loses contact with
Tivoli Management Framework, no new events are added to the view. Do the
following to enable event reporting:

1.

Reestablish contact between Tivoli Enterprise Console and IBM Tivoli
Monitoring.
Log off the Tivoli Enterprise Portal.

Note: If you use Tivoli Enterprise Portal browser client, you must also close
and restart the Web browser.

Log in to the Tivoli Enterprise Portal again to enable the Tivoli Enterprise
Console view to resume event reporting.
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The IBM Tivoli Enterprise Console does not indicate that a situation
event was acknowledged or closed

Table 26. Situation event was not acknowledged or closed

Problem

Resolution

The omegamon.rls rule set
was not imported in the
currently loaded rule base.

Run the following commands from the IBM Tivoli Enterprise Console event server
to import a rule set into a rule base:

1. wrb -imprbrule rule file [-encoding encoding ] [-force] rule_base

where:

rule_base
The name of the rule base in which the rule pack lives.

rule_file
The file name of the rule set to import to the rule base. This must be a
path to a rule set file (with a file extension of .rls).

-encoding encoding
Specifies the character encoding of the class file. If this option is not
specified, a class file being imported into a rule base is opened in UTF-8
character encoding.

-force Adds the rule set to the rule base even if a rule references a nonexistent
event class

2. wrb -imptgtrule {rule set | rule pack} [{-before | -after} {rule set |
rule_pack}] target rule_base

where:

rule_base
The name of the rule base that contains the rule base target.

rule_pack
The name of the rule pack to import. The rule pack must have been
imported into the rule base first.

rule_set
The name of the rule set to import. The rule set must have been
imported into the rule base first.

target The name of the rule base target to receive the imported rule set or rule
pack. You must have first created the target with the -crttarget
command option.

-after rule_set | rule_pack
Specifies the name of the rule set or rule pack after which the imported
rule set or rule pack should be located.

-before rule_set | rule_pack
Specifies the name of the rule set or rule pack before which the
imported rule set or rule pack should be located.

For any changes you make to the rule base to take affect you must complete the
following steps:

* Recompile the rule base

* Load the rule base

* Stop the Tivoli Enterprise Console server

* Restart the Tivoli Enterprise Console server

Refer to the IBM Tivoli Monitoring Administrator’s Guide for information about
changing the omegamon.rls file.
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Table 26. Situation event was not acknowledged or closed (continued)

Problem

Resolution

The events are not cached in
the expected location.

The location of the cache file is specified during installation. The default locations
are as follows:

¢ On Windows: C:\tmp\TME\TEC\OM_TEC \persistence

* On UNIX-based systems: /var/TME/TEC/OM_TEC/persistence

The value of fileLocation is defined in the active configuration file as indicated by the
situpdate.properties file in the following locations:

¢ On Windows: C:\Program Files\TME\TEC\OM_TEC \etc

¢ On UNIX-based systems :/etc/TME/TEC/OM_TEC

You can edit the location of the cache file by running the sitconfig.sh script. Refer to
the IBM Tivoli Monitoring Administrator’s Guide for sitconfig.sh script usage.

The IBM Tivoli Enterprise
Console Situation Update

Forwarder is not currently
running.

To use event forwarding, you must start the Situation Update Forwarder. This
process is started automatically when the event server starts. To start the process
manually, change to the $BINDIR/TME/TEC/OM_TEC/bin directory and run the
following command:

On Windows:
startSUF.cmd

On UNIX-based systems:
startSUF.sh

To stop the process, run the stopSUF.sh command (stopSUF.cmd on Windows) in the
same directory.

Note: If the Situation Update Forwarder process stops abnormally, run the
stopSUF.sh (stopSUF.cmd on Windows) command before restarting the process.

The correct Tivoli Enterprise
Monitoring Server
information is not defined for
the updated events in the
cms_hostname attribute.

1. Ensure the event cms_hostname attribute includes a fully qualified host name for
the computer where the monitoring server is running. The monitoring server
hostname must match the hostname recorded in events coming from this
monitoring server.

2. Ensure user validation is enabled on Tivoli Enterprise Monitoring Server and the
correct userid and password information is specified for the Tivoli Enterprise
Monitoring Server.

3. Run the sitconfsvruser.sh script to update the configuration for the Tivoli

Enterprise Monitoring Server. Refer to the IBM Tivoli Monitoring Administrator’s
Guide for more information.

There is a communication
problem between IBM Tivoli
Enterprise Console server and
Tivoli Enterprise Monitoring
Server.

Run the test.sh command on UNIX based systems or the test.cmd on Windows to
determine if there is a communication problem between IBM Tivoli Enterprise
Console server and Tivoli Enterprise Monitoring Server.

Refer to [Chapter 4, “Connectivity troubleshooting,” on page 63 for additional
information about solving connectivity problems.

The expected server ports
3661 and 1920 are not
currently open on the Tivoli
Enterprise Monitoring Server.

Ports 3661 and 1920 must be available. Run the test.sh command on UNIX based
systems or the test.cmd on Windows to determine if there is a communication
problem between IBM Tivoli Enterprise Console server and Tivoli Enterprise
Monitoring Server.

Refer to [Chapter 4, “Connectivity troubleshooting,” on page 63| for additional
information about solving connectivity problems.
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Table 26. Situation event was not acknowledged or closed (continued)

Problem

Resolution

There a firewall between
Tivoli Enterprise Monitoring
Server and Tivoli Enterprise
Console that is blocking
communication over certain
ports.

You might need to include the IP addresses of other IBM Tivoli Monitoring
components in the access control for the firewall. Refer to|Chapter 4, “Connectivity|
[froubleshooting,” on page 63|for additional information about solving connectivity
problems.

TEC_ITM_OM_Situation_Sync_Error events occur

TEC_ITM_OM_Situation_Sync_Error events occur if there is a Tivoli Enterprise
Console server communication problem or if you need to increase the rules cache.

Table 27. Reasons for the TEC_ITM_OM_Situation_Sync_Error event

Problem

Resolution

IOException is generated.
There is no connectivity with
SOAP.

Logon Validation Failure is
returned by the SOAP server.

Fatal Error is returned by the
SOAP server.

The connection to the SOAP
server repeatedly times out
because of broken
communication, network
outage or the SOAP server is
down.

Verify that the network connections are up and running, the SOAP server is running
and receiving requests, and the ports 3661 and 1920 on the Tivoli Enterprise
Monitoring Server machine are open. Use the following steps to determine why the
error occurred:

1. Ensure that the userid and password configured for the Tivoli Enterprise
Monitoring Server serverid on the event server during installation is correct. Run
the sitconfsvruser.sh script to update the configuration for the Tivoli Enterprise
Monitoring Server. Refer to the IBM Tivoli Monitoring Administrator’s Guide for
more information.

2. Run the test.sh command on UNIX based systems or the test.cmd on Windows
to determine if there is a communication problem between IBM Tivoli Enterprise
Console server and Tivoli Enterprise Monitoring Server.

3. If the SOAP Server is running and receiving requests, initiate a CT_GET request
for the SOAP server from the Web client.

See the "Tivoli Enterprise Monitoring Web services" section in the IBM Tivoli
Monitoring Administrator’s Guide for more information.

The event message indicates
reset, resurface, or
acknowledge action failed.
The original event was not in
the Tivoli Enterprise Console
rules cache.

Increase the size of the rules cache using the Tivoli desktop or the wsetesvrcfg
command. Refer to the IBM Tivoli Enterprise Console Command and Task Reference for
more information and the "Configuring Tivoli Enterprise Console integration" section
in the IBM Tivoli Monitoring Administrator’s Guide for more information.

Receiving error message when running the Rule Check Utility with the

-cd and -rd options

Ensure the class definitions in the TEC_CLASSES directory that you specified with
the -cd option include the supporting classes for all rule sets defined in the rule
base directory specified by the by -rd option.

Table 28. Rule Base directory and BAROC event class definition directory

Option | Description

-rd Used to specify a directory containing the rulesets (*.rls) to be checked. If not provided, the TEC_RULES
subdirectory for the actively loaded rule base is used by default.
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Table 28. Rule Base directory and BAROC event class definition directory (continued)

Option | Description

-cd Used to specify a directory containing the BAROC event class definitions files (*.baroc) to be used as
input. If not provided the TEC_CLASSES subdirectory for the actively loaded rule base is used by
default.

The following lists the syntax for the Rule Check Utility:

wrules_check {[-h] | [-v] | [-rd rules_directory] [-cd baroc_classes_directory]
{classl,attribute,attribute...] [:classN,attributeN,attributeN] | [-f class_file]} [-of
output_file]}

For more information about the Rules Check Utility, refer to the IBM Tivoli
Monitoring Administrator’s Guide.

Expected impacted rules are not displayed when entering multiple
event classes with class attributes

Ensure you input ran the Rules Check Utility command with the correct options:
wrules_check {[-h] | [-v] | [-rd rules_directory] [-cd baroc_classes_directory]

{class[,attribute,attribute...] [:classN,attributeN,attributeN] | [-f class_file]} [-of
output_filel}

For more information about the Rules Check Utility, refer to the Tivoli Enterprise
Portal Administrator’s Guide.

The wrules check command fails

When you run the wrules_check without specifying the —cd and -rd options, you
must have permission to run the wrb subcommands. Run the wrules_check
command with the —cd and -rd options or refer to the IBM Tivoli Enterprise
ConsolelBM Tivoli Enterprise Console documentation for more information about
running the wrb subcommands.

The following lists the syntax for the Rule Check Utility:

wrules_check {[-h] | [-v] | [-rd rules_directory] [-cd baroc_classes_directory]
{class[,attribute,attribute...][:classN,attributeN,attributeN] | [-f class_file]} [-of
output_file]}

Table 29. Rule Base directory and BAROC event class definition directory

Option | Description

-rd Used to specify a directory containing the rulesets (*.rls) to be checked. If not provided, the TEC_RULES
subdirectory for the actively loaded rule base is used by default.

-cd Used to specify a directory containing the BAROC event class definitions files (*.baroc) to be used as
input. If not provided the TEC_CLASSES subdirectory for the actively loaded rule base is used by
default.

For more information about the Rules Check Utility, refer to the Tivoli Enterprise
Portal Administrator’s Guide.
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The NetView menus are unavailable

Ensure the NetView® console or Web console are installed on the Tivoli Enterprise
Portal machine and that the NVWC_HOME or NV_DRIVE variables are set
correctly.

Errors occur during installation of IBM Tivoli Enterprise Console event
synchronization

When installation is complete, the results are written to the
itm_tec_event_sync_install.log file located in the following directories:

* Windows:

The itm_tec_event_sync_install.log file is created in the directory defined by the
%TEMP% environment variable. To determine where this directory is defined for
the current command line window, run the following command:

echo %TEMP%
* UNIX-based systems:
The itm_tec_event_sync_install.log file is always created in the /tmp directory.

The following error is harmless and there is currently no resolution:

One or more errors occured during the replacement of files (tecSyncAl1Filel)
with files (tecSyncAl1Filel).

Refer to install log for more details.

One or more errors occured during the replacement of files (tecSyncAllFile2)
with files (tecSyncAll1File)l.

Refer to install log for more details.

One or more errors occured during the replacement of files (tecSyncAll1File3)
with files (tecSyncAl1Filel).

Refer to install log for more details.

The IBM Tivoli Enterprise Console does not display in a workspace
after logging off and logging on the Tivoli Enterprise Portal

Recycle the Tivoli Enterprise Portal browser so the Tivoli Enterprise Portal can
display the IBM Tivoli Enterprise Console in a workspace.

The Tivoli Enterprise Portal stops when attempting to launch the IBM
Tivoli Enterprise Console behind a router
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After a two-minute timeout, the following message might display when you try to
add a IBM Tivoli Enterprise Console to a Tivoli Enterprise Portal client that is
behind a router:

The RDBMS cannot be reached.

During the timeout period the Tivoli Enterprise Portal client seems hung. To avoid
this problem, the Tivoli Management Framework Administrator must enable
communications based on the host name rather than the IP address. Use the
following steps to prevent this problem:

1. On the IBM Tivoli Enterprise Console Server on which you are logged in, set
the single_port_bdt and set_iom_by_name Tivoli Management Framework
settings to TRUE by running the following commands on the IBM Tivoli
Enterprise Console Server:
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odadmin single_port_bdt TRUE all
odadmin set_iom_by name TRUE all

2. Run the following command to recycle the object dispatchers:
odadmin reexec all

Refer to the Tivoli Management Framework Reference Manual for more information
about the odadmin command.

The error 'ECO2029E: Failed to connect to http://
servername:port_number/cgi-bin/tec_help.pl.' occurs after clicking the
Information button on the IBM Tivoli Enterprise Console

Error ECO2029E occurs because the spider Web Server provided with the IBM
Tivoli Enterprise Console Server does not automatically start. To start the spider
Web Server, run the wstarthttpd command on the IBM Tivoli Enterprise Console
that you are logged in to. After the wstarthttpd command completes, the
information button works. Refer to the IBM Tivoli Enterprise Console 3.9 Installation
Guide for more information about the wstarthttpd command.

Situations return to acknowledged

The default action of the omegamon.rls rule set is to reject acknowledgement
expirations that are received from the Tivoli Enterprise Monitoring Server, and to
then acknowledge the situation again on the Tivoli Enterprise Monitoring Server.
This action of the omegamon.rls rule set might be changed to accept
acknowledgement expirations from the Tivoli Enterprise Monitoring Server, and
therefore leave the situation open in the Tivoli Enterprise Monitoring Server. Refer
to the IBM Tivoli Monitoring Administrator’s Guide for information on changing
parameters of the omegamon.rls rule set.

tacmd refreshTECinfo -t all shows no results on console

The Tivoli Enterprise Monitoring Server facility used (DS START command) to
trigger the refresh of the EIF info does not give a return code. So, it is not possible
to give feedback as to the success or failure of the operation back to the CLI. For a
result of the refresh, look in the Tivoli Enterprise Monitoring Server log or the
Universal Message Console on the Tivoli Enterprise Portal.

Some situation states are missing

In IBM Tivoli Monitoring v6.2, there are 4 additional states that you can assign a
situation to:

e Unknown
* Harmless
* Minor

» Fatal

Unless your agent is a IBM Tivoli Monitoring v6.2 agent, you will not see these 4
additional states.
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Pre-existing situations do not display in the Tivoli Enterprise Portal
after performing an initial installation of IBM Tivoli Monitoring v6.2

When installing a single server AIX system, the situations were not seeded
properly. After performing an initial install and running the "itmemd support”
command, there were no situations displayed in the Tivoli Enterprise Portal.
Reinstalling the Tivoli Enterprise Monitoring Server and the Tivoli Enterprise
Portal Server Support and re-running the "itmemd support” command, only sees
partial seeding of the situations. When reviewing the log itmaix8_ci_39128.log,
there are many errors similar to the one below:
/*********************************************/

[x*xxxxx%xx% Create Request Was Done Kkkkkkkhkk [
R R e T T e Y
UPDATE 04SRV.TOBJACCL
SET LSTRELEASE = "",
LSTUSRPRF = "IBM"
WHERE NODEL = "+NT_SYSTEM"
AND OBJCLASS = "5140"
AND OBJNAME = "NT_Available Bytes Critical";
[ Fkk ke kkk kR kk ko kk kR kk kR kkkkkk kR kkkkkkhkkkhkkhkk [
[*xxxxkxxkx%x Create Request Was Done ***x%xx%x*/
R T s A s s a2

SQL1_OpenRequest status = 79

If you have situations before you seed, this can cause the installer to run the
upgrade sql rather than the sql for a fresh seeding.
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Appendix A. IBM Tivoli Monitoring processes

The following table lists the processes according to operating system platform and
IBM Tivoli Monitoring component.

Table 30. IBM Tivoli Monitoring processes by operating system

UNIX and Linux-based

Component Windows systems
Tivoli Enterprise Monitoring | cms.exe cms
Server kdsmain.exe kdsmain
Tivoli Enterprise Portal KfwServices.exe KfwServices
Server

UNIX agent N/A kuxagent
Linux agent N/A klzagent
Windows agent kntcma.exe N/A
Universal agent kuma610.exe kuma610
Log Alert agent N/A kulagent
Warehouse proxy agent khdxprto.exe khdxprtj
Summarization and Pruning |ksy610.exe ksy610
Agent

Eclipse help server kkfhelpsvr.exe kkfstart.sh

for the java process, search
for /kf/ in the process
name

© Copyright IBM Corp. 2005, 2007
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Appendix B. Environment variables

This appendix lists IBM Tivoli Monitoring environment variables that you can
customize.

Common environment variables

The following table lists the environment variables that are common to all
components:

Table 31. Common environment variables

Variable Value type Useful for. ..

KDC_DEBUG Yor N Default is N. Diagnosing
communications or
connectivity problems
between the Tivoli Enterprise
Portal Server to the Tivoli
Enterprise Monitoring Server.

KDH_DEBUG Y or N Default is N. Diagnosing
connectivity problem with
integrated web server.

KDH_SERVICEPOINT Determining the service
point.

KBB_RAS1 Trace specification string See each specific
environment variable section
below.

KBB_RAS1LOG Determining the count limit

and the max files settings.

Tivoli Enterprise Portal Server environment variables

The following table lists Tivoli Enterprise Portal Server environment variables.

Table 32. Tivoli Enterprise Portal Server environment variables

Variable Value type Useful for. ..

DSUSER1 Y or N Part of a set of 9 variables DSUSER1...DSUSER9 that you
can set using the tacmd configureportalserver command.
For more information, see the IBM Tivoli Monitoring
Administrator’s Guide.

© Copyright IBM Corp. 2005, 2007 145



Table 32. Tivoli Enterprise Portal Server environment variables (continued)

Variable

Value type

Useful for. ..

KBB_RAS1

Trace specification
string

Default tracing level:

KBB_RAS1=ERROR

Diagnosing client request problems:

KBB_RAS1=ERROR (UNIT:ctsql IN ER)

(UNIT:ctdata IN ER) Diagnosing client or Tivoli
Enterprise Monitoring Server interaction problems:
KBB_RAS1=ERROR (UNIT:ctsql IN ER) (UNIT:ctdata IN
ER) (UNIT:ctcmw IN ER) (UNIT:kv4 IN ER)

Diagnosing SQL generation problems:
KBB_RASI=ERROR (UNIT:ctsql IN ER) (UNIT:ctdata IN
ER) (UNIT:ctreport ALL)

Diagnosing login problems: KBB_RAS1=ERROR
(UNIT:ctsqgl IN ER) (UNIT:ctdata IN ER) (UNIT:ctauth
ALL)

KFW_CMW_SPECIAL_HUB_
ENTERPRISE=N

Y or N

Default is N. When set to Y, associates situations to the
Tivoli Enterprise Portal Server.

KFW_DATABUS_INPUT_
TRACE_IGNORE_HEARTBEAT

Y or N

Default is N. Reduces trace volume by skipping client
heartbeat requests when (UNIT:ctdata IN ER) request
tracing is used.

KFW_DATABUS_QUERY_
VERBOSE

Y or N

Default is N. Tivoli Enterprise Portal Server client side
response time and request life cycle tracing.

KFW_MIGRATE_CMS

Y or N

Default is N. When set to Y, causes initial migration of
managed objects and user IDs from the monitoring server
the first time the Tivoli Enterprise Portal Server starts
after installation.

KFW_MIGRATE_FORCE

Y or N

Default is N. When set to Y, SQL seed files are processed
even if the date, time, or size of the files have not
changed since prior seeding. This occurs when running
the buildpresentation.bat file (Windows) and when
running the InstallPresentation.sh file or reconfiguring the
Tivoli Enterprise Portal Server (UNIX/Linux). To be
effective, this value must be set in kfwalone (Windows)
or in cq.ini or Inxenvnocms (UNIX/Linux).

KFW_MIGRATE_VERBOSE

Y or N

Default is N. When set to Y, provides greater detail about
operations performed in migrate.log when seeding the
Tivoli Enterprise Portal Server database. This occurs
when running the buildpresentation.bat file (Windows)
and when running the InstallPresentation.sh file or
reconfiguring the Tivoli Enterprise Portal Server
(UNIX/Linux). To be effective, this value must be set in
kfwalone (Windows) or in cq.ini or Inxenvnocms
(UNIX/Linux).

KFW_REPORT_TERM_
BREAK_POINT

Y or N

Default is N. When set to Y, specifies the point where a
historical request selects from short-term or long-term
history data.

KFW_SQL_VERBOSE

Y or N

Default is N. When set to Y, provides RASI trace of each
SQL statement issued by the Tivoli Enterprise Portal
Server to the Tivoli Enterprise Monitoring Server or to
the DB2/ODBC data source. The use of this variable is
deprecated because the same capability is available using
the standard RASI trace setting "KBB_RAS1=ERROR
(UNIT:ctsql IN ER)”
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Tivoli Enterprise Monitoring Server environment variables

The following table lists Tivoli Enterprise Monitoring Server environment
variables.

Table 33. Tivoli Enterprise Monitoring Server environment variables

Variable

Purpose

ATTRLIB

Specifies the Tivoli Enterprise Monitoring Server attribute (ATR) files directory.

CANDLE_HOME

The directory where the product was installed.

CMS_BINPATH

Specifies the Tivoli Enterprise Monitoring Server binary files directory.

CMS_EXTERNALBROKERS

Whether there are internal brokers.

CMS_FTO

Whether to use Tivoli Enterprise Monitoring Server Hot Standby:.

CMS_MSGBASE

Specifies the Tivoli Enterprise Monitoring Server message file directory.

CMS_NODEID

The Tivoli Enterprise Monitoring Server IBM Tivoli Monitoring Node ID.

KDC_GLBSITES

Specifies the Tivoli Enterprise Monitoring Server global sites network file with
Tivoli Enterprise Monitoring Server Hub host names.

KDH_SERVICEPOINT

The service point.

KDS_CATLGLIB

Specifies the catalog library.

KDS_HUB Specifies that this Tivoli Enterprise Monitoring Server is a Hub Tivoli Enterprise
Monitoring Server (*LOCAL) or Remote Tivoli Enterprise Monitoring Server
(*REMOTE).

KDS_NCS Whether to use IBM Tivoli Monitoring network lookup services.

KDS_RULELIB Specifies the rule library.

KDS_RUN Specifies Tivoli Enterprise Monitoring Server components or probes to run at
Tivoli Enterprise Monitoring Server startup.

KDS_START Specifies Tivoli Enterprise Monitoring Server KDS component startup.

KDS_VALIDATE

Whether to use Tivoli Enterprise Monitoring Server authentication.

KGLCB_FSYNC_ENABLED

Whether to enable UNIX or Linux fsync calls.

KGL_CBTBUEFCNT

Specifies Tivoli Enterprise Monitoring Server internal table buffer count.

KGL_CBTBUFSZ

Specifies Tivoli Enterprise Monitoring Server internal table buffer size.

KGL_KEYRING_FILE

Specifies LDAP authentication SSL GSKit keyring file.

KGL_KEYRING_LABEL

Specifies LDAP authentication SSL GSKit keyring label.

KGL_KEYRING_PASSWORD

Specifies LDAP authentication SSL GSKit keyring password.

KGL_KEYRING_STASH

Specifies LDAP authentication SSL GSKit keyring password stash file.

KGL_KGLMSGBASE

Specifies the Tivoli Enterprise Monitoring Server KGL message file directory.

KGL_LDAP_BASE

LDAP authentication LDAP search base.

KGL_LDAP_BIND_ID

LDAP authentication LDAP server bind Distinguished Name (DN).

KGL_LDAP_BIND_PASSWORD

LDAP authentication LDAP server bind password.

KGL_LDAP_HOST_NAME

LDAP authentication LDAP server host name.

KGL_LDAP_PORT

LDAP authentication LDAP server port.

KGL_LDAP_SSL_ENABLED

Whether to use LDAP SSL communications.

KGL_LDAP_USER_FILTER

LDAP authentication user filter.

KGL_LDAP_VALIDATE

Whether to use LDAP authentication.

KGL_MSG2_EVENTLOG

Whether to format Event Log.

KGL_MSG2_UNIVERSAL

Whether to enable Universal Messages.
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Table 33. Tivoli Enterprise Monitoring Server environment variables (continued)

Variable

Purpose

KGL_TRC1

Whether to enable the error log.

KHD_HISTRETENTION

Specifies the default retention period in hours for the short term history files
(default is 24 hours). This can be used to reduce the amount of data kept on disk
after a successful upload to the warehouse is performed.

KIB_MAXCOLS

Tivoli Enterprise Monitoring Server internal dictionary column maximum.

KMS_DISABLE_TEC_EMITTER

TEC Emitter to be disabled.

KMS_OMTEC_
GLOBALIZATION_LOC

TEC Integration Globalization locale.

KMS_OMTEC_INTEGRATION

TEC Integration enabled.

KPX_WAREHOUSE_LOCATION

Allows a fixed warehouse route for the agents connected to that Tivoli Enterprise
Monitoring Server when the usage of the Global Location Broker default
algorithm is not supported. It is a list of fully qualified, semicolon delimited
network names such as:

KPX_WAREHOUSE_LOCATION= family protocol:
#network_address[port_number]; ...

KPX_WAREHOUSE_REGCHK

Number of minutes to wait between re-checking the Global Location Broker for
any warehouse proxy agent registration changes. The default value is set to 60
minutes.

KSH_DIRECTORY

Specifies the Tivoli Enterprise Monitoring Server SOAP Server HTML files
directory.

NLS1_LOCALEDIR

The directory of the locale file.

RKDSCATL

Specifies the Tivoli Enterprise Monitoring Server catalogue (CAT) files directory.

SQLLIB

Specifies the Tivoli Enterprise Monitoring Server seeding and query (SQL) files
directory.

Universal Agent environment variables

The following table lists environment variables you can set to customize tracing for
the Universal Agent.

Table 34. Universal Agent environment variables

Variable

Purpose

KBB_RAS1=ERROR (UNIT:kumamain ALL)

Problems involving managed system online/offline
processing.

(UNIT:kumpmd2a Error Detail)

KBB_RAS1=ERROR (UNIT:kumpdpda Error Output)

Incorrect report data.

KBB_RAS1=ERROR (UNIT:kumpfile Error State Detail
Flow Metrics) (UNIT:kumpdcemf ALL)

Detailed File Data Provider tracing.

KBB_RAS1=ERROR (UNIT:kumpsosr ALL)
(UNIT:kumpspst ALL) (UNIT:kumpscku ALL)
(UNIT:kumpstcp ALL) (UNIT:kumplpba ALL)

Detailed API or Socket Data Provider tracing.

KBB_RAS1=ERROR METRICS

Problems involving Universal Agent memory usage.

KUMA_DCH_TRAPEMIT

SNMP Emitter tracing. Use to display emitted traps in
the UAGENT Action report.
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Table 34. Universal Agent environment variables (continued)

Variable Purpose

KUMA_VERBOSE Tracing a Universal Agent API client program. This
variable must be set on the machine where the API client
program is executing, not where Universal Agent is
running)

Example: KUMP_API_VERBOSE=Y dpapi.log.

The KUMP_API_VERBOSE option is valuable when
debugging an API program that communicates with the
Universal Agent API data provider.

KUMP_HTTP_DEBUG HTTP Data Provider tracing.

KUMP_ODBC_DEBUG ODBC Data Provider tracing.

KUMP_SCRIPT_DEBUG Script Data Provider tracing.
KUMP_SNMP_DEBUG_TRAP SNMP Data Provider tracing. All of the debug
KUMP_SNMP_DEBUG_DISCOVERY_ROUTE environment variables listed default to No. As an
KUMP_SNMP_DEBUG_DISCOVERY_NETWORK example, if you use the SNMP Data Provider and have
KUMP_SNMP_DEBUG_MIB_MANAGER problems collecting MIB data, you set these two
KUMP_SNMP_DEBUG_MIB_IO environment variables:

KUMP_SNMP_DEBUG_MIB_MANAGER=Y
KUMP_SNMP_DEBUG_MIB_IO=Y

For a complete list of the Universal Agent environment variables, see the IBM
Tivoli Universal Agent User’s Guide.

Tivoli Data Warehouse environment variables

The following Tivoli Data Warehouse parameters can be changed in the
KHDENV_MIG file to customize tracing for the warehouse upgrade tool.

Table 35. Tivoli Data Warehouse environment variables

Variable Purpose
KHD_MAX_ROWS_SKIPPED_PER_TABLE Specifies the maximum number of rows per table that can be
skipped during an upgrade. Rows with incorrect data are skipped
until the maximum specified number is reached. When this number
of rows are skipped, the migration of the table is aborted.
KHD_MAX_ROWS_PER_TRANSACTIONS Specifies how many rows are committed at each insert of data.
KHD_CNP_SERVER_HOST Specifies the name of the CNP server.
KHD_CNP_SERVER_PORT Specifies the port used by the CNP server.
KHD_SOURCE_DATABASE_SCHEMA Specifies the owner or schema of the Candle tables in the source
database.
KHD_SOURCE_JDBC_DRIVER Specifies the JDBC driver used to connect to the source database.
KHD_SOURCE_URL Specifies the URL to connect to the source database
KHD_SOURCE_DATABASE_USER Specifies the user to connect to the source database.
KHD_SOURCE_DATABASE_PASSWORD Specifies the password to connect to the source database.
KHD_TARGET_JDBC_DRIVER Specifies the JDBC driver used to connect to the target database
KHD_TARGET _URL Specifies the URL to connect to the target database
KHD_TARGET _DATABASE_SCHEMA Specifies the owner or schema of the tables in the target database
KHD_TARGET _DATABASE_USER Specifies the user to connect to the target database
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Table 35. Tivoli Data Warehouse environment variables (continued)

Variable Purpose

KHD_TARGET _DATABASE_PASSWORD Specifies the password to connect to the target database

The following Warehouse Proxy agent parameters can be changed in the KHDENV
file on Windows systems and the HD.ini file in non-Windows systems to customize
tracing for the Warehouse Proxy agent.

Table 36. Warehouse proxy environment variables

Variable Purpose
CTIRA_NCSLISTEN The number of RPC threads.
KHD_BATCH_USE Reduces network flow when the Tivoli Data Warehouse database is not installed

on the same machine where the warehouse proxy agent resides, this variable
must be set to Y. This is done automatically when the Use Batch check box on
the UNIX warehouse proxy configuration panel is checked. This check box does
not exist for the warehouse proxy configuration panel on Windows and it needs
to be set explicitly in the KHDENYV file.

KHD_CNX_POOL_SIZE The total number of preinitialized ODBC connection objects available to the
work queue export threads. The default value is 3.

KHD_CNX_WAIT The time in minutes to wait before trying to reconnect. Default is 10 minutes.

KHD_CNX_WAIT_ENABLE A time to wait before a retry. Default is Y. Changing this variable to N does not
wait before retries. Setting this variable to N can generate a large log file if the
tests to the database fail at each retry.

KHD_EXPORT_THREADS The number of worker threads exporting data to the database. The default value
is 10.
KHD_QUEUE_LENGTH The length of the KHD work queue. This is an integer that identifies the

maximum number of export work requests that can be placed on the work
queue before the queue starts rejecting requests. The default value of
KHD_QUEUE_LENGTH is 1000. Setting this value to 0 means the queue length
has no limit.

KHD_SRV_STATUSTIMEOUT The time in seconds set by default to 600s = 10 minutes. Set
KHD_SRV_STATUSTIMEOUT less than KHD_STATUSTIMEOUT by at least 60
seconds.

KHD_STATUSTIMEOUT The time in seconds set by default to 900s = 15 minutes. An export request on
the application agent is resent if a status is not received from the Warehouse
Proxy agent before the timeout expires.

KHD_WAREHOUSE_TEMS_LIST | A space or coma delimited separated list of monitoring server. A warehouse
proxy agent serves all the agents reporting to those monitoring servers listed.
The same monitoring server name must not appear more than once in all the
warehouse proxy Tivoli Enterprise Monitoring Server lists in the entire
enterprise environment.

[Table 37 on page 151|lists the Summarization and Pruning agent parameters that
you can edit in the KSYENV file on Windows systems and the SY.ini file on
non-Windows systems to customize tracing for the Summarization and Pruning
agent.
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Table 37. Summarization and Pruning agent environment variables

Variable

Purpose

KSY_BLACKOUT

Specifies a comma separated list of exception times where the
Summarization and Pruning agent should not start when using the
flexible scheduling. The values in the list should be in the format
HH:MM-HH:MM where HH must be between 00 and 23 and MM
must be between 00 and 59. The starting time must be smaller than the
end time of the exception period. For example, to block the
Summarization and Pruning agent from starting between 1 and 2 AM
and 5 and 6 PM, use the following: 01:00-01:59,17:00-17:59.

KSY_CNP_SERVER_HOST

Tivoli Enterprise Portal Server connection default host.

KSY_CNP_SERVER_PORT

Tivoli Enterprise Portal Server connection default port.

KSY_DAY_AGE_UNITS

The minimum age of data for daily data in days before aggregation is
done.

KSY_EVERY_N_DAYS

How often to run the schedule in days (number).

KSY_EVERY_N_MINS

Indicates the frequency between Summarization and Pruning agent
runs when using the flexible scheduling. Must be a multiple of 15
minutes, with a minimum of 15 and a maximum of 1440 (one day).

KSY_FIXED_SCHEDULE

Indicates whether the Summarization and Pruning agent is configured
for fixed schedule if set to Y or flexible schedule when set to N.

KSY_HOUR_AGE_UNITS

The minimum age of data for hourly data in hours before aggregation
is done.

KSY_HOUR_AM_PM

Whether to run in the AM or PM (AM/PM).

KSY_HOUR_TO_RUN

The hour of the day to run (number).

KSY_MAX_ROWS_PER_ TRANSACTION

Maximum rows per database transaction.

KSY_MAX_WORKER_THREADS

Maximum number of simultaneous worker threads. Default is 1.
Recommended value is the number of processors on your server minus
1.

KSY_MINUTE_TO_RUN

The minute of the day to run (number).

KSY_SHIFT1_HOURS

A comma-separated list of hour numbers for the shift.

KSY_SHIFT2_HOURS

A comma-separated list of hour numbers for the shift.

KSY_SHIFTS_ENABLED

Shift periods. Only two shifts are allowed. If shifts are enabled, each
hour (0-23) must be specified once.

KSY_START_OF_WEEK_DAY

Start of the week day, for example: 0 = Sunday 1 = Monday.

KSY_TIMEZONE_IND

Time zone indicator. AGENT specifies use the time zone offset of the
agent. WAREHOUSE specifies use the time zone offset of the
warehouse .

KSY_VACATION_DAYS

Vacation days in a comma-separated list of days in YYYYMMDD
format.

KSY_VACATIONS_ENABLED

Whether or not vacation are enabled with Y or N.

KSY_WAREHOUSEAGGREGLOG_PRUNE

Use to specify the pruning for the WAREHOUSEAGGREGLOG table.
The format of the value should be number.unit, where number is the
number of units to retain and unit specifies the retention unit, which
can be one of day, month or year.

KSY_WAREHOUSELOG_PRUNE

Use to specify the pruning for the WAREHOUSELOG table. The format
of the value should be number.unit, where number is the number of
units to retain and unit specifies the retention unit, which can be one of
day, month or year.

KSY_WAREHOUSE_DRIVER

The Warehouse Database Connection JDBC Driver.
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Table 37. Summarization and Pruning agent environment variables (continued)

Variable

Purpose

KSY_WAREHOUSE_PASSWORD

The Warehouse Database Connection Password (encrypted).

KSY_WAREHOUSE_SCHEMA

The Warehouse Database Connection Schema.

KSY_WAREHOUSE_URL

The Warehouse Database Connection JDBC URL.

KSY_WAREHOUSE_USER

The Warehouse Database Connection User (encrypted).

KSY_WEEKENDS_AS_VACATIONS

Whether or not weekends are vacation with Y or N.

KSZ_JAVA_ARGS

Java arguments.

Tivoli Enterprise Monitoring Agent deploy environment variables

The following Tivoli Enterprise Monitoring Agent parameters can be changed in
the KBBENV file:

Table 38. Tivoli Enterprise Monitoring Agent deploy environment variables

Variable

Purpose

AGENTDEPOT

An OS agent parameter. Determines the location on the agent host where agent
bundles will be transferred.

CMS_MSGBASE

Applies to is/5 platform Tivoli Enterprise Monitoring Agent only. Specify the
MSG2 message file for Tivoli Enterprise Monitoring Agent framework messages.

CT_CMSDIRECT

OBSOLETE - Has been replaced by IBM Tivoli Monitoring v6.X firewall
communications services. Specify the full NAT firewall address of the Tivoli
Enterprise Monitoring Server to be connected to, including
protocol:address[port#].

CT_CMSLIST

Required variable specifying the primary and/or secondary Tivoli Enterprise
Monitoring Server for the agent to connect with. Takes a semicolon delimited list
of Tivoli Enterprise Monitoring Server by network protocol:hostname or
protocol:address.

CTIRA_CELL_NAME

OBSOLETE - Agents only. Replaced by agent configuration variable
CT_CMSLIST.

CTIRA_HEARTBEAT

The interval, in minutes, of the agent to Tivoli Enterprise Monitoring Server
heartbeat data sample. Default is 10 minutes. Using shorter heartbeat intervals
will increase network traffic between the agent and Tivoli Enterprise Monitoring
Server.

CTIRA_HIST DIR

Required variable specifying the directory where Tivoli Enterprise Monitoring
Agent based short-term history data files will be stored. Does not apply to Tivoli
Enterprise Monitoring Server short-term history data files.

CTIRA_HOSTNAME

Used by many, but not all, agents to provide an alternate hostname qualifier
(subsystem:hostname:nodetype) for the published agent managed system name.
Used to remove a long network domain name, i.e. acme.us.com, from the
default Tivoli Enterprise Monitoring Agent hostname. Not honored by all agents.
For some agents, might cause unpredictable Tivoli Enterprise Portal navigation
tree results.

CTIRA_IP_PORT

Applies to z/OS agents only. DO NOT MODIFY. Is set to 0 so the OS can
provide the agent rpc listen port. Avoids a port conflict for some z/OS
configurations.

CTIRA_LOG_PATH

Required variable specifying the directory where the Tivoli Enterprise
Monitoring Agent Operations Log file is stored. The file names use suffix of
".LG0" and ".LG1". Does not apply to z/OS based agents.
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Table 38. Tivoli Enterprise Monitoring Agent deploy environment variables (continued)

Variable Purpose

CTIRA_MAX_RECONNECT Number of consecutive times without success the agent will attempt to connect

_TRIES to a Tivoli Enterprise Monitoring Server before giving up and exiting. Default is
720.

CTIRA_NCSLISTEN Number of RPC listen server threads to create for the agent. Default is 10.

CTIRA_NODETYPE Supply the agent node type qualifier (subsystem:hostname:nodetype) of the

agent managed system name (MSN). Provide the agent product indicator in the
MSN. Value can also be set by the Tivoli Enterprise Monitoring Agent API.

CTIRA_OS_INFO Override default value for agent entries in the Tivoli Enterprise Monitoring
Server "ManagedSystem.Host_Info" column. Used to build Tivoli Enterprise
Portal Server navigation tree. Value must match existing entry in the
CNPS/osnames file. Not applicable to subnode type records in the
ManagedSystem table.

CTIRA_PRODUCT_SEP Supply alternate qualifier for the agent managed system name (MSN). Default is
a colon character ',

CTIRA_RECONNECT_WAIT Time interval, in seconds, for the agent to wait between attempts to register with
a Tivoli Enterprise Monitoring Server. Default is 600 seconds.

CTIRA_REFLEX_ATOMIC Default is "Y". For subnode targets only. Evaluate situation state by any existing
specified display item column name when deciding which reflex situation
automation command the Tivoli Enterprise Monitoring Agent should execute.
Not applicable to reflex situation commands executed or evaluated by the Tivoli
Enterprise Monitoring Server. Disable by setting to "N".

CTIRA_REFLEX_TARGET Default is "Y". For subnode targets only. Evaluate situation state by subnode
name value in the ORIGINNODE column when deciding which reflex situation
automation command the Tivoli Enterprise Monitoring Agent should execute.
Not applicable to reflex situation commands executed or evaluated by the Tivoli
Enterprise Monitoring Server. Disable by setting to "N".

CTIRA_SIT_CLEAN Number of seconds between garbage clean up of stale entries in the agent
persistent situation file. Default is 900 seconds.

CTIRA_SIT_FILE Specify an alternate name for the default Tivoli Enterprise Monitoring Agent
based persistent situation file. This should only be done in exceptional
conditions since the file name reflects the agent’s managed system name.
Unsupported for z/OS based agents.

CTIRA_SIT_MGR Specify whether or not to use the Tivoli Enterprise Monitoring Agent persistent
situation file when registering with the Tivoli Enterprise Monitoring Server.
Using this file improves Tivoli Enterprise Monitoring Server performance. Set to
"N" to disable usage. For z/OS Tivoli Enterprise Monitoring Agent the value
must be "N" since this feature not implemented for z/OS. For all other
platforms, default is "Y".

CTIRA_SIT_PATH Required variable specifying directory where the Tivoli Enterprise Monitoring
Agent based agent persistent situation file is stored. This is the Tivoli Enterprise
Monitoring Agent's only file, and it contains a copy of the Tivoli Enterprise
Monitoring Server monitoring situations for Tivoli Enterprise Monitoring Agent
use during Tivoli Enterprise Monitoring Server registration. The file is named
psit_msn.str, where msn is the Managed System Name of the agent process.
Unsupported for z/OS based agents.

CTIRA_STANDALONE OBSOLETE - Should never be set. If it is specified, it MUST only be set to "N"
or "n". Using any other value, including an empty string ", will cause the agent
to fail to connect to a Tivoli Enterprise Monitoring Server.

CTIRA_SUBSYSTEM_ID Optional variable to override the subsystem ID qualifier
(subsystem:hostname:nodetype) of the agent managed system name (MSN).
Describes a monitored resource instance to help make the MSN unique. Value
can also be set by the Tivoli Enterprise Monitoring Agent API.
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Table 38. Tivoli Enterprise Monitoring Agent deploy environment variables (continued)

Variable

Purpose

CTIRA_SYSTEM_NAME

Set alternate system name value for the agent entries in the Tivoli Enterprise
Monitoring Server "ManagedSystem.Host Address" column within the
"<NM>mysystem</NM>" tags. Used to build the Tivoli Enterprise Portal Server
navigation tree. Not applicable to subnode type records in the Tivoli Enterprise
Monitoring Server ManagedSystem table.

CTIRA_USE_HBTIMER

This variable should never be used! It will degrade agent heartbeat performance
by NOT creating a separate heartbeat data thread.

DATACHUNKSIZE Specifies the size of the data chunk that will be passed to RPC for transfer.

DEPLOYQUEUESIZE Specifies the maximum number of requests that the request queue on the agent
deployment controller.

DEPLOYTHREADPOOLSIZE Specifies the number of threads that are available to the deployment controller.

DEPOTHOME Specifies the root directory of the agent depot on the file system.

IRA_DUMP_DATA

Used by Tivoli Enterprise Monitoring Agent and Tivoli Enterprise Monitoring
Server for debugging. Set to "Y" to do a hex dump of certain detailed data row
contents into the RAS1 log. Default is "N". Can produce voluminous RAS1
message output if enabled.

ITM_BINARCH

Set by Tivoli Enterprise Monitoring Agent installer to supply the platform
architecture code. Used by Tivoli Enterprise Monitoring Agent to read the agent
installation version files and retrieve the agent version information.

KBB_RAS1

* View state of main Tivoli Enterprise Monitoring Agent functions like situation
and report processing:

ERR (UNIT:KRA ST)

* Detailed debug messages for Tivoli Enterprise Monitoring Agent functions:
ERR (UNIT:KRA ALL)

* View state of short-term history data uploads to Tivoli Data Warehouse:
ERR (UNIT:KHDX ST)

* Detailed debug messages of short-term history data uploads to Tivoli Data
Warehouse:

ERR (UNIT:KHD ALL)

KHD_HISTRETENTION

Specifies the default retention period in hours for the short term history files
(default is 24 hours). This can be used to reduce the amount of data kept on
disk after a successful upload to the warehouse is performed.

TIMEOUT

Specifies the time in seconds that Agent Deployment tool has to complete a task.
If the tool does not complete in the task in the time specified by the TIMEOUT
value, the task is terminated. The default value is 600 seconds.
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Appendix C. Support for problem solving

If you have a problem with your IBM software, you want to resolve it quickly. This
section describes the following options for obtaining support for IBM software
products:

» [“Using IBM Support Assistant”|

* [“Obtaining fixes”

» [“Contacting IBM Software Support” on page 156

Using IBM Support Assistant

The IBM Support Assistant is a free, stand-alone application that you can install on
any workstation. You can then enhance the application by installing
product-specific plug-in modules for the IBM products you use.

The IBM Support Assistant saves you the time it takes to search the product,
support, and educational resources. The IBM Support Assistant helps you gather
support information when you need to open a problem management record
(PMR), which you can then use to track the problem.

The product-specific plug-in modules provide you with the following resources:
¢ Support links

* Education links

* Ability to submit problem management reports

For more information, and to download the IBM Support Assistant Version 3, see
lhttp:/ /www.ibm.com /software /support/isa} After you download and install the

IBM Support Assistant, follow these steps to install the plug-in for IBM Tivoli
Monitoring:

1. Start the IBM Support Assistant application.
2. Select Updater on the Welcome page.

3. Select New Properties and Tools.
4

. Under Tivoli, select IBM Tivoli Monitoring 6.2, and then click Install. Be sure
to read the license and description.

5. Restart the IBM Support Assistant.

Obtaining fixes

A product fix might be available to resolve your problem. To determine which
fixes are available for your IBM software product, follow these steps:

1. Go to the IBM Software Support Web site at jttp://www.ibm.com /software/|

Click Downloads and drivers in the Support topics section.
Select the Software category.
Select a product in the Sub-category list.

o koD

In the Find downloads an drivers by product section, select one software
category from the Category list.

6. Select one product from the Sub-category list.
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7. Type more search terms in the Search within results if you want to refine your
search.

8. Click Search.

9. From the list of downloads returned by your search, click the name of a fix to
read the description of the fix and to optionally download the fix.

For more information about the types of fixes that are available, see the IBM

Software Support Handbook at |ttp:/ /techsupport.services.ibm.com/guides /|
handbook.html

Contacting IBM Software Support

156

IBM Software Support provides assistance with product defects. The easiest way to
obtain that assistance is to open a PMR or ETR directly from the IBM Support
Assistant (see [“Using IBM Support Assistant” on page 155).

Before contacting IBM Software Support, your company must have an active IBM
software maintenance contract, and you must be authorized to submit problems to
IBM. The type of software maintenance contract that you need depends on the
type of product you have:

* For IBM distributed software products (including, but not limited to, Tivoli,
Lotus®, and Rational® products, as well as DB2 and WebSphere products that
run on Windows or UNIX operating systems), enroll in Passport Advantage® in
one of the following ways:

Online
Go to the Passport Advantage Web site at fhttp://www-306.ibm.com /|
[software /howtobuy/passportadvantage /pao_customers.htm|

By phone
For the phone number to call in your country, go to the IBM Software

Support Web site at |http://techsupport.services.ibm.com/guides/|
and click the name of your geographic region.
* For customers with Subscription and Support (S & S) contracts, go to the
Software Service Request Web site at https:/ /techsupport.services.ibm.com/ssr/|

+ For customers with IBMLink™, CATIA, Linux, OS/390, iSeries®, pSeries®,
zSeries®, and other support agreements, go to the IBM Support Line Web site at
[http:/ /www.ibm.com /services/us/index.wss/so/its/a1000030/ dt006}

+ For IBM eServer " software products (including, but not limited to, DB2 and
WebSphere products that run in zSeries, pSeries, and iSeries environments), you
can purchase a software maintenance agreement by working directly with an
IBM sales representative or an IBM Business Partner. For more information
about support for eServer software products, go to the IBM Technical Support
Advantage Web site at fhttp://www.ibm.com/servers/eserver/techsupport.html

™

If you are not sure what type of software maintenance contract you need, call
1-800-IBMSERV (1-800-426-7378) in the United States. From other countries, go to
the contacts page of the IBM Software Support Handbook on the Web at

lhttp:/ / techsupport.services.ibm.com / guides/contacts.html{and click the name of
your geographic region for phone numbers of people who provide support for
your location.

To contact IBM Software support, follow these steps:

1. |“Determining the business impact” on page 157
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2. |“Describing problems and gathering information”|

3. [“Submitting problems”]

Determining the business impact

When you report a problem to IBM, you are asked to supply a severity level. Use
the following criteria TO understand and assess the business impact of the
problem that you are reporting;:

Severity 1
The problem has a critical business impact. You are unable to use the
program, resulting in a critical impact on operations. This condition
requires an immediate solution.

Severity 2
The problem has a significant business impact. The program is usable, but
it is severely limited.

Severity 3
The problem has some business impact. The program is usable, but less
significant features (not critical to operations) are unavailable.

Severity 4
The problem has minimal business impact. The problem causes little impact
on operations, or a reasonable circumvention to the problem was
implemented.

Describing problems and gathering information

When describing a problem to IBM, be as specific as possible. Include all relevant

background information so that IBM Software Support specialists can help you

solve the problem efficiently. To save time, know the answers to these questions:

* Which software versions were you running when the problem occurred?

* Do you have logs, traces, and messages that are related to the problem
symptoms? IBM Software Support is likely to ask for this information.

* Can you re-create the problem? If so, what steps were performed to re-create the
problem?

* Did you make any changes to the system? For example, did you make changes
to the hardware, operating system, networking software, and so on.

* Are you currently using a workaround for the problem? If so, be prepared to
explain the workaround when you report the problem.

Submitting problems
You can submit your problem to IBM Software Support in one of two ways:

Online
Click Submit and track problems on the IBM Software Support site at
http:/ /www.ibm.com /software/support/probsub.htmll Type your
information into the appropriate problem submission form.

By phone
For the phone number to call in your country, go to the contacts page of
the IBM Software Support Handbook at http:/ /techsupport.services.ibm.com /|
lzuides/ contacts.htmll and click the name of your geographic region.

If the problem you submit is for a software defect or for missing or inaccurate
documentation, IBM Software Support creates an Authorized Program Analysis
Report (APAR). The APAR describes the problem in detail. Whenever possible,
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IBM Software Support provides a workaround that you can implement until the
APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the
Software Support Web site daily, so that other users who experience the same
problem can benefit from the same resolution.
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Appendix D. Documentation library

This appendix contains information about the publications related to IBM Tivoli
Monitoring and to the commonly shared components of Tivoli Management
Services. These publications are listed in the following categories:

 IBM Tivoli Monitoring library

* Related publications

See IBM Tivoli Monitoring and OMEGAMON XE Products: Documentation Guide,
5C23-8816, for information about accessing and using the publications. You can
find the Documentation Guide in the IBM Tivoli Monitoring and OMEGAMON XE
Information Center at fhttp:/ /publib.boulder.ibm.com /infocenter/tivihelp /v15r1 /|

To find a list of new and changed publications, click What's new on the Welcome
page of the IBM Tivoli Monitoring and OMEGAMON XE Information Center. To
find publications from the previous version of a product, click Previous
information centers on the Welcome page for the product.

IBM Tivoli Monitoring library

The following publications provide information about IBM Tivoli Monitoring V6.2
and about the commonly shared components of Tivoli Management Services:

* Quick Start Guide, GI11-8058
Introduces the components of IBM Tivoli Monitoring.

* Exploring IBM Tivoli Monitoring, SC32-1803
Provides a series of exercises to help you explore IBM Tivoli Monitoring. By
completing the activities in this workbook, you will install and configure your
monitoring environment, explore both the graphical and command-line
interfaces of the product, use some of the new features, and work with several
monitoring agents.

* Installation and Setup Guide, GC32-9407

Provides instructions for installing and configuring IBM Tivoli Monitoring
components on Windows, Linux, and UNIX systems.

* IBM Tivoli Management Services on z/OS Program Directory, GI11-4105

Gives instructions for the SMP/E installation of the Tivoli Management Services
components on z/OS.

¢ Configuring IBM Tivoli Enterprise Monitoring Server on z/OS, SC32-9463
Gives detailed instructions for using the Configuration Tool to configure Tivoli
Enterprise Monitoring Server on z/OS systems. Includes scenarios for using
batch mode to replicate monitoring environments across the z/OS enterprise.
Also provides instructions for setting up security and for adding application
support to a Tivoli Enterprise Monitoring Server on z/OS.

e Administrator’s Guide, SC32-9408

Describes the support tasks and functions required for the Tivoli Enterprise
Portal Server and clients, including Tivoli Enterprise Portal user administration.

* Tivoli Enterprise Portal online help

Provides context-sensitive reference information about all features and
customization options of the Tivoli Enterprise Portal. Also gives instructions for
using and administering the Tivoli Enterprise Portal.
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User’s Guide, SC32-9409

Complements the Tivoli Enterprise Portal online help. The guide provides
hands-on lessons and detailed instructions for all Tivoli Enterprise Portal
features.

Command Reference, SC32-6045

Provides detailed syntax and parameter information, as well as examples, for the
commands you can use in IBM Tivoli Monitoring.

Problem Determination Guide, GC32-9458

Provides information to help you troubleshoot problems with the software.
Messages, SC23-7969

Lists and explains messages generated by all IBM Tivoli Monitoring components
and by z/0OS-based Tivoli Management Services components (such as Tivoli
Enterprise Monitoring Server on z/0OS and TMS:Engine).

Upgrading from V5.1.2, GC32-1976

Gives instructions for upgrading custom resource models from IBM Tivoli
Monitoring V5.1.2 to IBM Tivoli Monitoring V6.2.

IBM Tivoli Universal Agent User’s Guide, SC32-9459

Introduces you to the IBM Tivoli Universal Agent, an agent of IBM Tivoli
Monitoring. The IBM Tivoli Universal Agent enables you to use the monitoring
and automation capabilities of IBM Tivoli Monitoring to monitor any type of
data you collect.

IBM Tivoli Universal Agent API and Command Programming Reference Guide,
SC32-9461

Explains the procedures for implementing the IBM Tivoli Universal Agent APIs
and provides descriptions, syntax, and return status codes for the API calls and
command-line interface commands.

Agent Builder User’s Guide, SC32-1921

Explains how to use the Agent Builder for creating monitoring agents and their
installation packages, and for adding functions to existing agents.

Fix Pack Readme and Documentation Addendum

Describes the installation process for a fix pack and provides updated

information on problems and workarounds associated with the fix pack. A new
version of this document is created for each fix pack.

Documentation for the base agents

If you purchased IBM Tivoli Monitoring as a product, you received a set of
operating system monitoring agents (also called OS agents or base agents) as part of
the product. If you purchased a monitoring agent product (for example, an
OMEGAMON XE product) that includes the commonly shared components of
Tivoli Management Services, you did not receive the base agents.

The following publications provide information about using the base agents.

Windows OS Agent User’s Guide, SC32-9445

UNIX OS Agent User’s Guide, SC32-9446

Linux OS Agent User’s Guide, SC32-9447

i5/0S Agent User’s Guide, SC32-9448

UNIX Log Agent User’s Guide, SC32-9471

Monitoring Agent for IBM Tivoli Monitoring 5.x Endpoint User’s Guide, SC32-9490
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Related publications

You can find useful information about the OMEGAMON XE monitoring agent
products in the IBM Tivoli Monitoring and OMEGAMON XE Information Center
at |http:/ /publib.boulder.ibm.com /infocenter /tivihelp /v15r1 /|

Other sources of documentation
You can also obtain technical documentation about IBM Tivoli Monitoring and
OMEGAMON XE products from the following sources:
 IBM Tivoli Open Process Automation Library (OPAL)
|http: / /www.ibm.com/software/tivoli/ 0pa1|

OPAL is an online catalog that contains integration documentation as well as
other downloadable product extensions. This library is updated daily.

* Redbooks
[http: / /www.redbooks.ibm.com/|

IBM Redbooks®, Redpapers, and Redbooks Technotes provide information about
products from platform and solution perspectives.

* Technotes
You can find Technotes through the IBM Software Support Web site at
[http: / /www.ibm.com /software /support/probsub.html, or more directly through

your product Web site, which contains a link to Technotes (under Solve a
problem).

Technotes provide the latest information about known product limitations and
workarounds.
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

274A /101

11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating systems. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
system for which the sample programs are written. These examples have not been
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thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply
reliability, serviceability, or function of these programs. You may copy, modify, and
distribute these sample programs in any form without payment to IBM for the
purposes of developing, using, marketing, or distributing application programs
conforming to IBM’s application programming interfaces.

If you are viewing this information in softcopy form, the photographs and color
illustrations might not appear.

Trademarks

IBM, the IBM logo, IBMLink, AIX, Candle, CandleNet Portal®, DB2, DB2 Universal
Database™, developerWorks®, eServer, i5/0S, iSeries, Lotus, MVS, NetView,
OMEGAMON, 0S/390, Passport Advantage, pSeries, RACF, Rational, Redbooks,
Tivoli, the Tivoli logo, Tivoli Enterprise, Tivoli Enterprise Console, Tivoli
Management Environment, VTAM, WebSphere, z/OS, and zSeries are trademarks
or registered trademarks of International Business Machines Corporation in the
United States, other countries, or both.

Microsoft, Windows, and Windows NT® are registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

((’ Java and all Java-based trademarks and logos are trademarks or
= registered trademarks of Sun Microsystems, Inc. in the United States,
';_;_a other countries, or both.

COMPATIBLE

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.
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Special characters

Tivoli Management Framework Reference Manual 141

Numerics

32 bit 91
64 bit 91

A

abends (core files), capturing 32
addBundles command 99
addSystem command 89
agent
displays offline 79
Agent deploy
Timeout 97
agent not uninstalling 61
agents
display offline 87
not available 106
not displaying in the navigator 106
not starting on a Solaris system 106
AMXUT7502E 36
AMXUT7512E error 61
Application Support Installer 39
attributes
missing 97

B

Backspace Check utility 29
browser mode
clear JAR cache 71
help not displaying in 71
uninstall procedure 24
browser problems 32
Build TEPS Database 29
BuildPresentation.bat 29

C

can bind a LONG value only for insert 107
CandleManage 105
clear JAR cache 71
client
logon error messages 63
set trace options 12
cmwrasl.log 12
command
wrules_check 139
command prompt
display tasks in the 24
connectivity 64
Connectivity
Tivoli Enterprise Portal on XP 67
Tivoli Enterprise Portal Server lost contact with the Tivoli
Enterprise Monitoring Server 67
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Tivoli Enterprise Portal Server 24
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CTIRA_HOSTNAME 106
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D
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a
prevent losing 119
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DB2 UDB

user ID 119
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dia,

not accepted 78
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DPLOG 25

Log and Trace Analyzer tool 28

pdcollect tool 25
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UAGENT application
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DPLOG 25

DirectDraw thread loops 75
DNS registry key 40
documentation

Dr.

E

See publications
Watson 2

Eclipse Help Server 83

ECO2029E 141

education 155

enable Tivoli Monitoring Services 75
encryption key setting error 43
error

Err
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or

0x80040707 41

Could not open DNS registry key 40

error message
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Reconnect Authorization Failed 68
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Tivoli Enterprise Portal Server is not reconnecting 68
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errors
Rule Check Utility 138
event
Omegamon_Generic 132
event forwarder 16
Event IBM Tivoli Monitoring Event Forwarding tool error 39
events 79
PARSING_FAILED status 133
TEC_ITM_OM_Situation_Sync_Error 138

F

Failed to attach to the DB2 instance db2instl 42
FAQ
see Frequently asked questions 31
firewall 112, 117
fixes, obtaining 155
Fixpack
CNP196 31
Frequently asked questions 31
UNIX-based systems installation 32
Windows installation 32

G

GSKit 35

H

HEAPDUMPs 72
help not displaying 71
historical data
incorrect 123
not warehoused 123
too much 123
Hot Standby 88

IBM Redbooks 155
IBM support assistant 155
IBM Tivoli Enterprise Console
events not acknowledged 136
is disabled 135
IBM Tivoli Enterprise Console event forwarder 16
IBM Tivoli Monitoring Installation and Setup Guide 31
IBM Tivoli Monitoring Service Console 22
blocking access to the 23
IBM Tivoli Monitoring Technology Service Console 22
IBM Tivoli Universal Agent 14
IBM V1.4.2 JRE errors 73
installation
problems 42
removing a failed Windows 57
Installation
problems 31
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InstallShield error 41
instance, removing remotely 78
Integrated Cryptographic Service Facility 92
interface unknown 103
Interface unknown message 107
IP:PIPE 32, 33
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Java VM heap dump 43
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K
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KFWENV 75
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KLVSQO000 93
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L

language packs 79
lcfd.log 36
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legal notices 163
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IBM Tivoli Monitoring 159
Linux installation error 44
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log
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Log agent
UNIX-based system 102
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installation 8
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Tivoli Enterprise Monitoring Server 5, 6, 8
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Windows 5

M

Managed system 112
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memory use, Tivoli Enterprise Monitoring Server 91
message 65
Tivoli Enterprise Portal Server has lost contact... 67
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Unable to process log on... 63
User authorization has failed 63
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built-in features 1
MIB data collection 116
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MVS
Tivoli Enterprise Monitoring Server 92

N

NETSUMMARY workspace 118
NetView menus

unavailable 140
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NETWORK workspace 117
nls_replace script 41
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non-root 83, 102

o)

odadmin command 141
OPAL documentation 161

P
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performance problems 73, 74

popup blocker 71
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OPAL 161
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related 161
Technotes 161
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Q
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R

rasllog tool 28
Redbooks 161
Redbooks, IBM 155
refreshTECinfo 141
release notes 3
Rule Check Utility error 138
rules
not display 139
Rules Check Utility 139

S

security
Windows local 120
service console 22
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Silent install error 43
SITINFO 128
Situation Update Forwarder 18
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non-hub 83
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UADVISOR 76
SNMP metafiles 116
SNMP-MANAGER Trap workspace 115
software support 155
Software Support
contacting 156
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sysxlogins report 110

Index

169



T
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TCP/IP timeout setting 127
TEC_ITM_OM_Situation_Sync_Error 138
Technotes 3, 161
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problems 85
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Tivoli Enterprise Portal Server
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slow performance of the 81
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TRAP workspace 115
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